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Preface

About this book

This book is the Installation and Customization Guide for WebSphere Studio
Application Monitor (Application Monitor). It contains instructions on installing
user’s exits and customizing the Application Monitor.

Who should read this book

Administrators or advanced users wanting to install or modify the configuration of
the Data Collector. For the z/OS system, anyone wanting to install or modify the
0S/390® or z/OS® Data Collector or the Managing Server. For the Data Collectors,
knowledge of the operating system (AIX, Solaris, Windows, Linux, or HPUX) and
WebSphere is expected. For the z/OS Data Collector, knowledge of WebSphere®,
MVS™ Systems programming and RACF® is expected. For the Managing Server, a
working knowledge on deploying WebSphere applications in a UNIX®
environment with DB2® and/or Oracle experience is expected.

Where to find more information

The following list shows the books in the Application Monitor library:

WebSphere Studio Application Monitor User’s Guide contains instructions and user
information for the Application Monitor.

WebSphere Studio Application Monitor Operator’s Guide contains information about
the operation of Application Monitor and the common services address space.

WebSphere Studio Application Monitor Installation and Customization Guide contains
instructions on installing user’s exits and customizing the Application Monitor.
In addition, contains troubleshooting and configuration information.

WebSphere Studio Application MonitorCICS® Data Collector Product Guide contains
information about the installation, configuration and use of the Application
Monitor CICS Data Collector.

WebSphere Studio Application Monitor Messages and Codes contains information
about messages and codes generated by the Application Monitor.

WebSphere Studio Application Monitor Program Directory contains complete
installation instructions for the Application Monitor Engine.

The WebSphere Studio Application Monitor Controller has an online help system that
describes all of the commands and dialogs available from its graphical user
interface.

Publications

This section describes how to access Tivoli publications online and how to order
Tivoli publications.

Accessing publications online

The documentation CD contains the publications that are in the product library.
The format of the publications is PDF, HTML, or both. Refer to the readme file on
the CD for instructions on how to access the documentation.

© Copyright IBM Corp. 2003, 2004 ix



The product CD contains the publications that are in the product library. The
format of the publications is PDF, HTML, or both. To access the publications using
a Web browser, open the infocenter.html file. The file is in the appropriate
publications directory on the product CD.

IBM posts publications for this and all other Tivoli products, as they become
available and whenever they are updated, to the Tivoli software information center
Web site. Access the Tivoli software information center by first going to the Tivoli
software library at the following Web address:

lhttp: / /www.ibm.com /software/ tivoli/library /|

Scroll down and click the Product manuals link. In the Tivoli Technical Product
Documents Alphabetical Listing window, click the WebSphere Studio Application
Monitor link to access the product library at the Tivoli software information center.

Note: If you print PDF documents on other than letter-sized paper, set the option
in the File » Print window that allows Adobe Reader to print letter-sized pages on
your local paper.

Ordering publications

You can order many Tivoli publications online at the following Web site:

http:/ / www.elink.ibmlink.ibm.com /public/applications /|
publications/cgibin /pbi.cgil

You can also order by telephone by calling one of these numbers:
* In the United States: 800-879-2755
* In Canada: 800-426-4968

In other countries, see the following Web site for a list of telephone numbers:

In other countries, contact your software account representative to order Tivoli
publications.

Accessibility

Accessibility features help users with a physical disability, such as restricted
mobility or limited vision, to use software products successfully. With this product,
you can use assistive technologies to hear and navigate the interface. You can also
use the keyboard instead of the mouse to operate all features of the graphical user
interface.

For additional information, see the Accessibility Appendix at the end of this book.

Tivoli technical training

For Tivoli technical training information, refer to the following IBM Tivoli
Education Web site:

lhttp: / /www.ibm.com /software/ tivoli/education|
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http://www.ibm.com/software/tivoli/education

Support information

If you have a problem with your IBM software, you want to resolve it quickly. IBM
provides the following ways for you to obtain the support you need:

* Searching knowledge bases: You can search across a large collection of known
problems and workarounds, Technotes, and other information.

* Obtaining fixes: You can locate the latest fixes that are already available for your
product.

* Contacting IBM Software Support: If you still cannot solve your problem, and
you need to work with someone from IBM, you can use a variety of ways to
contact IBM Software Support.

For more information about these three ways of resolving problems, see

[“Contacting IBM Software Support” on page 215|

Conventions used in this guide

This guide uses several conventions for special terms and actions, operating
system-dependent commands and paths, and margin graphics.

Typeface conventions
This guide uses the following typeface conventions:

Bold

Italic

Monospace

Lowercase commands and mixed case commands that are otherwise
difficult to distinguish from surrounding text

Interface controls (check boxes, push buttons, radio buttons, spin
buttons, fields, folders, icons, list boxes, items inside list boxes,
multicolumn lists, containers, menu choices, menu names, tabs, property
sheets), labels (such as Tip:, and Operating system considerations:)

Keywords and parameters in text

Words defined in text
Emphasis of words (words as words)
New terms in text (except in a definition list)

Variables and values you must provide

Examples and code examples

File names, programming keywords, and other elements that are difficult
to distinguish from surrounding text

Message text and prompts addressed to the user
Text that the user must type
Values for arguments or command options

Operating system-dependent variables and paths

This guide uses the UNIX convention for specifying environment variables and for
directory notation.

When using the Windows command line, replace $variable with % variable% for
environment variables and replace each forward slash (/) with a backslash (\) in

Preface X1



directory paths. The names of environment variables are not always the same in
Windows and UNIX. For example, %TEMP% in Windows is equivalent to $tmp in
UNIX.

Note: If you are using the bash shell on a Windows system, you can use the UNIX
conventions.
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Chapter 1. Product Overview

The Application Monitor provides immediate problem determination, availability
monitoring and performance management for enterprise J2EE, CICS and IMS
applications running on Windows 2000 Server, Solaris, HP-UX, AIX, z/OS and OS
390 environments. The Application Monitor monitors heterogeneous environments
consisting of both mainframes and distributed systems. From development and
testing to staging and productions, the Application Monitor helps to identify
problems and resolve them in real-time, as well as understand application
performance, and assess resource consumption patterns for planning future
growth.

In today’s e-business applications, J2EE transactions often link up with Legacy
back-end systems. The Application Monitor, along with the optional Data Collector
for CICS, provides visibility into transactions that span across Application Server
and CICS platforms. Composite transactions between J2EE servers and CICS can
be traced and correlated, giving developers and analysts insight into the health
and performance of both mid-tier business logic and Legacy back-end components.

Architecture

The Application Monitor is composed of two main parts: the Data Collector and
the Managing Server. A Data Collector agent runs on each monitored J2EE
Application Server or CICS transaction server, and communicates essential
operational data to the Application Monitor Managing Server. Unique sampling
algorithms maintain low CPU and network overhead while providing application
specific performance information. The Application Monitor Managing Server is
composed of a Kernel, which controls the environment, a Publish Server to publish
and collect data, a Relational Database to store and retrieve that data, and a
Visualization Engine which users interact within a browser-based graphical
environment.

© Copyright IBM Corp. 2003, 2004 3
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Figure 1. Application Monitor Architecture

The Managing Server

The Managing Server consists of several Java components, and also relies on an
Application Server and a database, which must be installed prior to installing the
Managing Server itself.

Requirements

You can choose among several supported operating system platforms on which to
install the Managing Server. Likewise, you can choose among two Application
Servers and versions, and two databases and versions. These requirements are
described in detail in [’Software Requirements” on page 9

Supported Installations

The Managing Server is designed for scalability and load-balancing, and there are
many ways to architect an installation across one or more servers. Likewise, the
database used by the Managing Server can be located on a different server than
the Managing Server itself. It is recommended that you consult with IBM Software
Services for Tivoli when making these decisions, and that you do so before
attempting to install the Managing Server.

The instructions in this document describe installing a Managing Server on a single
server, with support for using a remote database. The procedure for doing so uses
a graphical installer. This document does not describe how to install the Managing
Server manually, or how to install the Managing Server with a more complicated
architecture.

Complete installation and configuration instructions are included in [Part 2, “The)
Managing Server Installation,” on page 7.|
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Data Collectors

Once you have installed the Managing Server (or once you have determined its
configuration properties,) you can install Data Collectors.

In order for the Application Monitor to monitor a managed host, you must first
install a Data Collector on that server.

Many Data Collectors can work with a single Managing Server. The
communication between Data Collectors and the Managing Server is independent
of platform.

Requirements

Data Collectors are specific to operating system platform, Application Server type
and version. For non-z/OS and non-OS/390 servers, the supported combinations
are listed on [“Requirements for Installing the Data Collector” on page 101} For
z/0S go to|“Platform prerequisites” on page 53

Supported Installations

The installation procedures you need to follow conform to one of two formats,
based on whether or not the operating system of the monitored server is z/OS or
0S5/390.

* Installation of Data Collectors on the z/OS and OS/390 platforms are covered in
[Part 3, “The Data Collector for z/OS,” on page 51

» Installation of Data Collectors on all other platforms are covered in[Part 4, “The
[Data Collector for Multiplatforms,” on page 99|

In addition, for non-z/OS and non-OS/390 Data Collectors, you can run a
graphical installer, or install the Data Collector manually. These installation options
are described in [Chapter 13, “Installation and Configuration,” on page 105.|
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Part 2. The Managing Server Installation
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Chapter 2. Preparing to Install

This section describes how to install the Managing Server.

Planning Your Installation

The following information will help you plan your installation of the Managing
Server.

Software Requirements
The Managing Server is a standalone server (or in some cases, a collection of
servers.) It consists of the following elements:
* Database — to store performance data and configuration information.
* J2EE Application Server — to run the monitoring console.

* Java Components — The Managing Server consists of several components, each
of which runs as a Java process, including the following: Kernel, Publish Server,
Archive Agent, Message Dispatcher, Polling Agent, Global Publish Server and
the Port Consolidator.

You must have a supported combination of operating system platform, database
and Application Server in order to use the Managing Server. [Table 1 on page 9|
describes the supported combinations.

Table 1. Managing Server Requirements

Application
Operating System |Database Server JDK
AIX 5.1 DB2 8.1ESE w/FP3+, DB2 8.2 | WebSphere 5.1.1 Supplied by
Application
Server
AIX 5.2 DB2 8.1ESE w/FP3+, DB2 8.2 | WebSphere 5.1.1 Supplied by
Application
Server
AIX 5.3 DB2 8.1ESE w/FP3+, DB2 8.2 | WebSphere 5.1.1 Supplied by
Application
Server
x/Linux: DB2 8.1ESE w/FP3+, DB2 8.2, | WebSphere 5.1.1 Supplied by
Oracle 8i S/E R3 8.1.7+, Oracle Application
RHEL 2.1AS 9i S/E R2 9.2+, Oracle 10g Server
x/Linux: DB2 8.1ESE w/FP3+, DB2 8.2, | WebSphere 5.1.1 Supplied by
Oracle 8i S/E R3 8.1.7+, Oracle Application
RHEL 3.0AS 9i S/E R2 9.2+, Oracle 10g Server
Solaris 8 DB2 8.1ESE w/FP3+, DB2 8.2, | WebSphere 5.1.1 Supplied by
Oracle 8i S/E R3 8.1.7+, Oracle Application
9i S/E R2 9.2+, Oracle 10g Server
Solaris 9 DB2 8.1ESE w/FP3+, DB2 8.2, | WebSphere 5.1.1 Supplied by
Oracle 8i S/E R3 8.1.7+, Oracle Application
9i S/E R2 9.2+, Oracle 10g Server
Solaris 8 Oracle 8i S/E R3 8.1.7+, Oracle | WebLogic 8.1 sp3 | Supplied by
9i S/E R2 9.2+, Oracle 10g Application
Server
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Table 1. Managing Server Requirements (continued)

Application
Operating System | Database Server JDK
Solaris 9 Oracle 8i S/E R3 8.1.7+, Oracle | WebLogic 8.1 sp3 | Supplied by
9i S/E R2 9.2+, Oracle 10g Application
Server
z/Linux : DB2 8.1ESE w/FP3+, DB2 8.2 | WebSphere 5.1.1 Supplied by
Application
SuSe Linux 8.1 Server

Windows 2000

DB2 8.1ESE w/FP3+, DB2 8.2,

WebSphere 5.1.1

Supplied by

Server

Server with sp4, Oracle 8i S/E R3 8.1.7+, Oracle Application
Windows 2000 9i S/E R2 9.2+, Oracle 10g Server
Advanced Server

with sp4

Windows 2003 DB2 8.1ESE w/FP3+, DB2 8.2, | WebSphere 5.1.1 Supplied by
Server, Windows Oracle 81 S/E R3 8.1.7+, Oracle Application
2003 Enterprise 9i S/E R2 9.2+, Oracle 10g Server

WebLogic in use.

not be supported.

WebLogic.

Note: All OS levels will also satisfy the patch levels required by the WebSphere or

Note: Managing server runs as a 32-bit app on 64-bit versions of platforms except for
Windows, zLinux. 64-bit versions of Windows 2003 and 64-bit versions of Intel Linux will

Note: Managing Server does not support SSL connection with both WebSphere and

Services for UNIX (Windows-only)

To support Managing Server scripts on Windows platforms, a UNIX shell

environment is necessary. Microsoft Windows Services for UNIX (SFU) 3.5 should

be installed. For further information about SFU, please visit
http:/ /www.microsoft.com/windows/sfu/default.asp.

Hardware Requirements

The memory requirements for the server running the Managing Server are a
function of your workload. However, 4GB of memory is recommended for most
installations. The disk space requirements are a function of the amount of
performance data you choose to store in the database.

Table 2. Recommended Hardware Configuration

Server with sp4,
Windows 2000
Advanced Server
with sp4, Windows
2003 Server,
Windows 2003
Enterprise Server

CPU DISK MEMORY
AIX 5L 4 Way 2 x 36 GB 4GB
Intel/Linux: 4 Way 2 x 36 GB 4 GB
RHEL 2.1AS, 3.0AS
Solaris 8 4 Way 2 x 36 GB 4GB
Windows 2000 2 Way 2 x 36 GB 4GB
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Note: Embedded installer does not allow you to install WebSphere Application
Server 5.1.1 and IBM DB2 8.1 if it already exists on the system.

Table 3. Requirements for Custom Installations

required for an installation of IBM
DB2 8.1 fixpack 3.

DISK SPACE
Custom installation: Disk space 540 MB
required for an installation of IBM
WebSphere Application Server 5.1.1
Custom installation: Disk space 600 MB

Note:

1. The minimum memory is 1 GB.

1440 MB, respectively.

shmsys:shminfo_shmseg = 240

shmsys:shminfo_shmseg = 240

2. On AIX and Solaris, the temporary space required if installing IBM DB2 is 1460 MB and

3. To install IBM DB2 v8.x on Solaris, you need to add the following kernel settings in
/etc/system file and reboot your system.

For systems with 2GB - 4GB of physical memory:

set msgsys:msginfo_msgmax = 65535 set msgsys:msginfo_msgmnb = 65535 set
msgsys:msginfo_msgssz = 32 set msgsys:msginfo_msgseg = 32767 set
msgsys:msginfo_msgmap = 2562 set msgsys:msginfo_msgmni = 2560 set
msgsys:msginfo_msgtql = 2560 set semsys:seminfo_semmap = 3074 set
semsys:seminfo_semmni = 3072 set semsys:seminfo_semmns = 6452 set
semsys:seminfo_semmnu = 3072 set semsys:seminfo_semume = 240 set
shmsys:shminfo_shmmax = 1932735283 set shmsys:shminfo_shmmni = 3072 set

For systems with 4GB - 16GB of physical memory:

set msgsys:msginfo_msgmax = 65535 set msgsys:msginfo_msgmnb = 65535 set
msgsys:msginfo_msgssz = 32 set msgsys:msginfo_msgseg = 32767 set
msgsys:msginfo_msgmap = 3586 set msgsys:msginfo_msgmni = 3584 set
msgsys:msginfo_msgtql = 3584 set semsys:seminfo_semmap = 4098 set
semsys:seminfo_semmni = 4096 set semsys:seminfo_semmns = 8602 set
semsys:seminfo_semmnu = 4096 set semsys:seminfo_semume = 240

set shmsys:shminfo_shmmax = 3865470566 set shmsys:shminfo_shmmni = 4096 set

Database Considerations

For more information on database considerations, see [Chapter 3, “Installation and|

[Configuration,” on page 15| specifically the [“Database Installation” on page 16.]

Networking Considerations

The server(s) on which the Managing Server is installed must have a hostname
and IP address (rather than just using localhost or 127.0.0.1.)

Data Collectors use eight ports to communicate with the Managing Server: six

ports for TCP/IP sockets, and two ports for RMI. In addition, the two unique ports
are needed for each Data Collector, in order for the Managing Server to contact the
Data Collectors via RMI. See the Installation and Customization Guide, Appendix

C. Port Consolidator.
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If a firewall sits between your Managing Server and your Data Collectors, you
must configure your firewall to allow these connections. See[“Configuring Your|
[Firewall” on page 37| for details.

Installation Overview

Here is a summary of the instructions in this chapter which describe how to install
or upgrade the Managing Server.

Required authorization role

In UNIX environment, the user who installs the product must be the root user. In
Windows environments, the user who installs the product must be the
Administrator user.

Note:

1. The following requirements apply to the user that you define for WebSphere
Application Server.

* Windows: must have membership in the Administrators group.
* UNIX: must have root privileges.

(Windows-only) The user that runs the Managing Server needs the privileges
"Act as part of the Operating System” and "Logon as Service.” To verify these
permissions, go to Control Panel > Administrative Tools > Local Security
Policies.

2. The following requirements apply to the admin, fence (UNIX-only), and
instance users that you define for DB2:

¢ Window: create a new user.

* UNIX: create a new user or use a preexisting user. You must define a group
name and home directory for new accounts.

The accounts you create have full administrative rights to the DB2 database.

Preparing to Install
You must perform several tasks before you can install the Managing Server.

Note: The installer will allow you to install IBM DB2 v8.1 fixpack 3 and IBM
WebSphere Application Server 5.1 fixpack 1 during the installation if you choose,
otherwise you may install and configure them manually.

If you choose not to install WAS/DB2, perform the following tasks based on your
needs:

¢ Install and configure DB2 or Oracle.
* Install WebSphere or WebLogic.
* Install Virtual Frame Buffer, see |”Install Virtual Frame Buffer” on page 13]

Installing and Configuring

* Create users and set up environment.
* Gather configuration.

* Run installer.

e Start server.

Performing Post-Installation Tasks
See [Chapter 4, “Customization,” on page 35| for more information about what to do
once you have finished installing the Managing Server.
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Upgrading Considerations

Follow the normal installation steps and then see [‘Upgrading Considerations” on|

Preparing your Environment for Installation

Install J2EE Application Server

In order to install the Managing Server, you must first install a supported
combination of a database and an Application Server. The supported combinations
are described in [Table 1 on page 9|

To install WebSphere:

1. Install the Application Server according to manufacturer’s instructions (See
WebSphere Installation Guide).

To install WebLogic:

1. Install the Application Server according to manufacturer’s instructions (See
WebLogic Installation Guide).

Optional: Install Web Server

If you want to have the WSAM Web console run on port 80, you will need to
install and configure an HTTP server to serve those requests. You can find the
instructions at Appendix E.

Install Virtual Frame Buffer

To ensure the graphics environment for the Application Monitor is properly setup,
an X11 environment is necessary. On the Managing Server, X is not required.
Instead, a virtual X11 environment is used. Virtual frame buffer is required for
displaying graphs.

For Red Hat Linux: Install the XFree86-Xvfb package. You can find this on your
Red Hat Linux CD or via redhat.com.

For AIX: Install the Virtual Frame Buffer (xvfb). This package can be found on the
AIX® installation CD X11.vfb package ("Virtual Frame Buffer Software for AIX
Windows®") from the AIX CD.

For Solaris: Install from the x11 distribution.

For z/Linux: Install from the x11 distribution.

For Windows:Virtual Frame Buffer is not required to be installed on Windows
platform.
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Chapter 3. Installation and Configuration

The following provide instructions for how to install and configure the Managing
Server. Please review Chapter 2, Preparing to Install for information on Software
Requirements, Hardware Requirements, Database Considerations and Network
Considerations.

Create Users and Set up User Environment

The Application Monitor uses UNIX or Windows user names and passwords for
authentication. The Application Monitor associates its users with UNIX or
Windows accounts on the server that hosts the Managing Server.

You must create two user accounts used exclusively by and for the Application
Monitor:

* Create the user named "amuser”, who owns the Managing Server file system.

Note: If you are using a remote database, the same user must be created on the
local machine.

* Create the user named "admin”, who is the Application Monitor administrator.

Create Users (UNIX-only)

The following instructions show you how to create users and the directory
structures.

To create users and directory structures :
1. Log in as root.

2. Create the username “amuser” and assign a password using the following
commands:

Note: If you are using a remote database, the same user must be created on the
remote machine.

Note: The command, useradd, is typically located at /usr/sbin.
useradd amuser

passwd amuser (example ampassword)
mkdir /home/amuser

3. Create the username “admin” if it does not exist and assign a password using
the following commands:

useradd admin
passwd admin
mkdir /home/admin

4. Change ownership rights of the newly created home directories to the users
they belong to. For example:

chown amuser:amuser /home/amuser

5. [optional] Create the group "amuser” using the following commands:

Note: You can create a group called “amuser” to organize your system;
however, Application Monitor does not need this group to operate properly.
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For AIX:
mkgroup amuser
For Solaris and Linux:
groupadd amuser

6. Login to the server using the “amuser” and “admin” usernames and
passwords.

The security set up on many systems requires the user to physically login for
the first time. On some UNIX systems, you receive a prompt the first time you
login, this prompt will cause the Application Monitor scripts to fail.

Create Users (Windows-only)

The following instructions show you how to create users and the directory
structures.

To create users and directory structures :
1. Log in as Administrator.

2. Create the username “amuser” and assign a password. Add this user into
group Administrators.

Note: If you are using a remote database, the same user must be created on the
local machine.

3. Grant the privilege “Act as part of the operating system” to user “amuser”
using the following operations: Start > Programs > Administrative Tools >
Local Security Policy > Local Policies > User Rights Assignment > Act as part
of the operating system > Add the user “amuser.”

Note: To make this privilege effective, user “amuser” needs to log out the
system and re-log in, or, a system reboot is recommended.

4. Create the username “admin” if it does not exist and assign a password.

5. Login to the server using the “amuser” and “admin” usernames and
passwords.

The security set up on many systems requires the user to physically login for
the first time.

Database Installation

The following instructions include all the information you need to set up your
database for WSAM. You will probably need a DBA to perform these steps.

Install Database

In order to install the Managing Server, you must first install a supported
combination of a database and an Application Server, if you chose not to use the
embedded installer which installs IBM DB2 v8.1 fixpack 3. The supported
combinations are described in[Table 1 on page 9|

Note: This task may require a DBA skill set.

Note: The installer will create a UTF-8 database instance. If you are manually
creating a database instance, you must create a UTF-8 database instance.

To install and configure DB2:
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1. Install DB2 according to manufacturers instructions or use the embedded
installer to install it.

2. Install the necessary fixpacks to bring DB2 up to fixpack 3.

3. Create a DB2 server instance according to the DB2 installation documentation,
(unless you are using the default user and instance.)

To install and configure Oracle:

1. Install the supported Oracle according to manufacturers instructions.

Setting up the Database

The following are instructions for preparing your database for installation.
To prepare a DB2 database for installation:

If the Managing Server is AIX-based and it uses a local database, proceed as
follows:

Note: If the platform is AIX or Linux/z/Linux then make sure that the DB2
instance can be accessed remotely. You need to specify the TCP/IP port while
creating the DB2 instance.

Note: You do not need to perform steps 1-3 if a remote database is used or if a
loopback node has been created for using TCP/IP communication instead of
shared memory communication.

1. Edit the file <db2_instance_home>/sqllib/db2profile to include the following
lines:

EXTSHM=ON
export EXTSHM

The default location for the file is /home/db2instl/sqllib/db2profile.
2. Log in as the instance owner (e.g. db2inst1):

su - db2instl
3. As the instance owner, issue the commands:

db2stop force
db2set DB2ENVLIST=EXTSHM
db2start

To prepare an Oracle database for installation:

Create an Oracle database with a SID name octigate, using utility:
dbassist (Oracle 8i)
dbca (Oracle 9i & 10g)

Note: If you are using Oracle 8i, edit the init.ora available in the directory <oracle
home>/dbs/init<oracle sid>.ora and modify the compatible parameters to 8.1.x.

Note: For the Solaris operating system, make sure that the UNIX sqlplus user
(oracle’s) environment variables are defined in a <users home dir>/.profile file (if
using ksh or sh) and .bash_profile (if using bash). For example:

/export/home/oracle/.profile

For Oracle 10g instance, follow the tuning instructions described in the file:
<AM_HOME>/etc/oracle1l0g-readme.txt.
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For DB2 instance, follow the tuning instructions described in the file:
<AM_HOME> /etc/DB2-readme.txt.

Using a Remote Database

The following instructions describe how to prepare the database used by the
Managing Server, in cases where your database is installed on a different server
than the Archive Agent (a component of the Managing Server.)

Within this section, refer to the servers as follows:

* The server on which the Visualization Engine and Archive Agent are installed is
the local server.

¢ The server on which the database is installed is the remote server.

Note: In this scenario, you must install the database client (DB2) or JDBC libraries
(Oracle) on the local machine.

Using Remote DB2

Create a consistent user on the local and remote database. The database server
needs to have the same username and password as the Managing Server.

To install the DB2 client on the the local server:
1. Install the DB2 client on the local machine.

After you prepare DB2 on the remote machine, and install the DB2 client on the
local machine, you can proceed with the installation of the Managing Server, as
described in [“Run Installer” on page 27

To prepare remote DB2 for use with the Managing Server:
1. Install DB2 on the remote machine.

Note: On the remote machine, a user account for example, "amuser” should be
created (the same as on the Managing Server.)

The following steps should be performed on a local machine.

2. Log in as a user with dba privileges, for example: db2inst1.

Note: For convenience purposes, you may want to log in as root. In the
following steps, you will be executing a script that prompts for the password
multiple times. This can be avoided if you run it as root.

3. Catalog TCP/IP node pointing to remote node. For example:

db2 catalog tcpip node <db2node> remote <Remote Server>
server <db2 listening port>

4. Catalog database on the node just created. For example:
db2 catalog db octigate at node <dbZ2node>

5. Create a temporary directory on remote machine in which to place the database
installation scripts. In this example use /tmp (UNIX) or c:\temp (Windows).

6. ftp the file db2-remote-scripts.tar to the temporary directory. (Located in the
Installer-MS/scripts directory.)

Note: The db2-remote-scripts.tar file is provided with the Managing Server
distribution (in /Installer-MS/scripts/).

7. Untar the db2-remote-scripts.tar file.
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8.

9.

UNIX only: Run the db2install.sh script, specifying the database user name and
installation directory. For example:

cd /tmp/db2/bin

sh db2install.sh <db username (db2instl)> <db_user (amuser)>
<absolute path installation dir>

Note: The db username must have dba privileges, e.g. db2inst1.

Note: When you get prompted for password, enter the password for the
db2inst1 user.

Note: The absolute path installation dir is a db2 directory in the temporary
directory containing the installation scripts, e.g. /tmp/db2.

Note: The db2install.sh script invokes the scripts db2configuration.sh and
db2createschema.sh. The db2configuration.sh script invokes the script
dbsettings.sql, and the db2createschema.sh script invokes the am-db2.sql script.

Windows only: Run the db2install.bat script, specifying the database user name
and the password. For example: cd

c:\temp\db2\bin
db2install.bat <db username (db2instl)> <db_password>

<tablespace> <schema user> <schema password>

Note: The db username must have dba privileges, e.g. db2inst1.

Note: When you get prompted for password, enter the password for the
db2inst1 user.

Note: The absolute path installation dir is a db2 directory in the temporary
directory containing the installation scripts, e.g. c:\temp\db2.

Using Remote Oracle

To use a remote Oracle database with the Managing Server, you must prepare the
Oracle database on the remote machine, and install JDBC drivers on the local
machine.

To prepare to use remote Oracle with the Managing Server:

1.
2.
3.

Install Oracle on the remote machine.
Create the SID for use by the Managing Server. For example: octigate.

Create a temporary directory on the remote machine. In this example use /tmp
(UNIX) or c:\temp (Windows).

ftp the file oracle-remote-scripts.tar to the temporary directory.

Note: The oracle-remote-scripts.tar file is provided with the Managing Server
distribution (in /Installer-MS/scripts/).

Log in as a user with dba privileges. For example: oracle.

Untar the oracle-remote-scripts.tar file. (Located in the Installer-MS/scripts
directory.)

Export the ORACLE_SID used by the Managing Server. For example:
export ORACLE_SID=octigate

UNIX only: Run the oracleinstall.sh script, which has the following format:
cd /tmp/oracle
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sh bin/oracleinstall.sh <dba user> <dba password> <tablespace>
<schema user> <schema password>

Note: The <dba user> must be the owner of the Oracle database hierarchy. For
example: system.

Note: The <tablespace> is the name of the tablespace that will be created when
you run the oracleinstall.sh script. This is the tablespace the Managing Server
will use. This <tablespace> will be removed if it exists.

Note: The <schema user> (amuser) and <schema password> are the login and
password of the user that the Managing Server uses to connect with the
database, using JDBC. This same login and password must be used during the
Managing Server installation. This schema user must exist in the local operating
system.

9. Windows only: Run the oracleinstall.bat script, which has the following format:
cd c:\temp\oracle

bin\oracleinstall.bat <dba user> <dba password> <tablespace>
<schema user> <schema password>

Note: The <dba user> must be the owner of the Oracle database hierarchy. For
example: system.

Note: The <tablespace> is the name of the tablespace that will be created when
you run the oracleinstall.bat script. This is the tablespace the Managing Server
will use. This <tablespace> will be removed if it exists.

Note: The <schema user> (amuser) and <schema password> are the login and
password of the user that the Managing Server uses to connect with the
database, using JDBC. This same login and password must be used during the
Managing Server installation. This schema user must exist in the local operating
system.

To install JDBC libraries on the the local server:
Install the thin JDBC drivers on the local machine.
After you prepare Oracle on the remote machine, and install the JDBC drivers on

the local machine, you can proceed with the installation of the Managing Server, as
described in [‘Run Installer” on page 27

Setting the Environment

In order to set up the proper environment for the Managing Server, it may be
helpful to set up a profile for the “amuser” user that is appropriate for your
Application Server and database. In addition, if your security policies allow, it may
be helpful for these environment variables to be added to the "root” user as well.

The examples in this section assume that the "amuser” user uses the bash or
bourne shell, which means you can add the appropriate lines to the .bash_profile
or .profile in the home directory of the “amuser” user. If you are using another
shell, you must use the appropriate syntax in the appropriate startup script for
your environment.
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Font Resolution Recommendations

For the English version of the Managing Server, the default resolution is
recommended maximized to 1024x768 with default toolbars. For the Japanese
version of the Managing Server, the resolution is recommended at 1280 by 1024
pixels.

WebLogic
Include in the profile of the “amuser” user (likely found under

/home/amuser/ .profile) the following:

* Point WL_HOME to the location of the local WebLogic Application Server
installation directory, which is typically one of the following:

For example:
export WL_HOME=/opt/bea/weblogic/
* Point JAVA_HOME to the location of the JDK
For example:
export JAVA HOME=/opt/bea/jdk141/
* Modify PATH to include
export PATH=${JAVA HOME}/bin:${PATH}

DB2
Based upon your decision to use either an existing remote/local or the new
embedded installer version of the database, perform these instructions on that
machine. Include in the profile of the “amuser” (likely found under
/home/amuser/ .profile, or it may be at a different location for your environment)
user the following;:
* Source the files db2profile, which is located in the sqllib subdirectory of the DB2
home directory respectively.
The following lines are an example of the code to insert into the profile, if it
already exists you don’t have to do this;
if [ -f /home/db2inst1/sq11ib/db2profile ]; then
/home/db2inst1/sql1ib/db2profile
i
Note: All references to db2instl should be replaced with the appropriate DB2
instance name.
Oracle

No updates required.

Example Configurations
The following is an example of a profile for WebSphere and DB2 on Linux:

EXAMPLE profile for user "amuser” for DB2 on Linux

if [ -f /home/db2inst1/sq11ib/db2profile ]; then
/home/db2inst1/sql1ib/db2profile

fi
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Setting up the Graphical Environments (UNIX-only)

In order to display graphs, the Managing Server needs a connection to an X
Window display. To accomplish this, start a virtual frame buffer X server, and set
your environment appropriately.

To set up the graphical environment for the Managing Server installer:

1. Log in as root or whatever user you will be using to install the Application
Server.

2. Start the Virtual X environment:
Linux
Xvfb :1 &

(Typically located in /usr/X11R6/bin.)
AIX
X —vfb —force :1 &

(Typically located in /usr/bin/X11/X.)
Solaris 8 and 10
Xvfb :1 &

(Typically located in /usr/X/bin.)
Solaris 9
Xvfb :0 &

(Typically located in /usr/openwin/bin.)
z/Linux
Xvfb :1 &

(Typically located in /usr/bin/X11.)

You may verify this by using the following command:

ps -ef | grep Xvfb

This command may vary according to the shell you are using.

Setting up the Services for UNIX

In order to support Managing Server scripts on Windows platforms, a UNIX shell
environment is necessary. To accomplish this, install the SFU 3.5, and set your
environment appropriately. To set up the SFU for the Managing Server installer:

1. Log on as Administrator.
2. Extend the System Environment Variable Path with:
%SFUDIR%bin;%SFUDIR%usr\sbin

Gather Configuration Information

The graphical installer will prompt you to enter configuration information about
your Application Server, database, logins and filesystem. Gather this information
before you run the graphical installer, since you will need it to complete the
installation.
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In all cases, you need the information about the Managing Server. However, the
specific information you need to gather about the Application Server and database
depends on which ones you use.

Note: If you are using a remote database, make sure the settings you use for the
database match those of the remote database.

Managing Server

Determine the values you will use for the following names, directories, files and
ports (defaults listed in parentheses):

* "amuser” user UNIX password (ampassword)

* Managing Server installation directory (/MS_AM_HOME)

* Primary Kernel server name (<Hostname for Managing Server>)
* Primary Kernel Codebase server port (9122)

¢ Primary Kernel RFS server port (9130)

* Primary Kernel RMI server port (9118)

* Secondary Kernel server name (<Hostname for Managing Server>)
¢ Secondary Kernel Codebase server port (9123)

* Secondary Kernel RFS server port (9121)

* Secondary Kernel RMI server port (9119)

* Archive Agent 1 Port (9129)

* Archive Agent 2 Port (9130)

 Publishing Server 1 Port (9103)

 DPublishing Server 2 Port (9104)

* Message Dispatcher Port (9106)

* Polling Agent Port (9111)

* Global Publish Server 1 Port (9126)

* Global Publish Server 2 Port (9127)

Install WebSphere

Gather the following information in order to install IBM WebSphere Application
Server 5.1 fixpack 1.

User - Type a user name for a valid user account on the host computer. This user
must have membership in the Administrators group. There are no case or
character restrictions for this user name.

(Windows-only) The user that runs the management server needs the privileges
"Act as part of the Operating System” and "Logon as Service.” To verify these
permissions, go to Control Panel > Administrative Tools > Local Security
Policies.

Password - Type the user password that corresponds to the user name in User.
Admin Console Port - Accept the default port setting of 9090, unless the port is in
use. If the default port is in use, try an alternate port number such as 9091 or 9092.

You can specify any valid TCP/IP port numbers from 1 to 65535.

Note: AIX 5.1 and 5.2 use port 9090 for WebSM by default. Change this port
number if you are running on an AIX 5.1 or 5.2 system with WebSM. Alternatively,

Chapter 3. Installation and Configuration 23



an AIX administrator can disable WebSM using the following command in the
/usr/websm/bin directory of the WebSM installation:

wmserver -disable
WAS Base Directory - Gather a location where you want to install WAS.

Image Location - Gather the installation image location information for IBM WAS
5.1 and IBM WAS 5.1 fixpack 1. For example:

* For WAS 5.1, select a directory which has the license.txt file.
* For WAS 5.1 fixpack, select a directory which has the version.properties file.

Note: Copy images from the CD-ROM to your local drive. The installation
program does not support the CD-ROM installation. These image locations should
have write permissions

Use existing WebSphere

If you are using WebSphere as your Application Server, gather the following
information before you run the graphical installer:

* WebSphere instance host name and SOAP port (8880)

— If using ND, provide the hostname and SOAP port of the Deployment
Manager instead.

— This connector port is used by the WebSphere Application Server to send
commands using the Simple Object Access Protocol (SOAP). You obtain this
information in the following file:

WAS_base_dir/config/cells/cel1/nodes/node/serverindex.xml
* WebSphere Application Server name (wsam_server)

— Name of the server you want to use as the Managing Server. If a server with
this name already exists then it will be deleted and recreated.

If Global Security is turned on, provide the WebSphere Username and Password of
a WebSphere user with administrative rights.:

* WebSphere Username
* WebSphere Password

WebLogic
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If you are using WebLogic as your Application Server, gather the following
information before you run the graphical installer:

* WebLogic Host Name - The name of the host where the WebLogic Admin Server
is running.

* WebLogic Admin Server Port (7001) - The listen port of the admin server, you
obtain this information in the following file: <weblogic base
directory>/user_projects/domains/<domain name>/config.xml

* WebLogic Admin user (weblogic)
* WebLogic Admin password (password)

* WebLogic Application Server name (wsam_server) - Name of the server you
want to use as the Managing Server. If a server with this name already exists
then it will be deleted and recreated.

* WebLogic Application Server port (7001) - Gather any valid TCP/IP port from 1
to 65535. Make sure this port is not in use.
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Install DB2

Gather the following user account information for DB2:

Note: The following requirements apply to the admin, fenced (UNIX-only), and
instance users that you define for DB2:

Windows: create a new user.

UNIX: create a new user or use a preexisting user. You must define a group
name and home directory when you create a new user.

Gather the admin user account information for DB2:

User Name - Type the user name for the DB2 Admin user account.This string
can have one to eight characters, without spaces. The installation creates the
user account. This account has full DB2 privileges.

Password - Type the password to correspond with the DB2 Admin user
account. This string can have one to eight characters, without spaces. The
string must not begin with a number or an ampersand. The only valid
symbols are: @, #, $, &.

Group Name - (UNIX-only) Type the group name. This string can have one to
eight characters, without spaces.

Home Directory - (UNIX-only) Type the home directory for the user type
admin. This string can have one to 64 characters, without spaces.

(UNIX-only) Gather the fence user account information for DB2:

User Name - Type the user name for the DB2 fenced user account. This string
can have one to eight characters, without spaces. The installation creates the
user account, if it does not already exist. This account has privileges to
administer the database.

Password - Type the password to correspond with the DB2 fenced user
account. This string can have one to eight characters, without spaces. The
string must not begin with a number or an ampersand. The only valid
symbols are: @, #, $, &.

Group Name - (UNIX-only) Type the group name. This string can have one to
eight characters, without spaces.

Home Directory - (UNIX-only) Type the home directory for the fenced user.
This string can have one to 64 characters, without spaces.

Gather the instance user account information for DB2:

Instance Name - Type the name of the DB2 Instance. This string can have one
to eight characters, without spaces.

User Name - The user name will be the same as the instance name.

Note: If you elect to create an instance user, then the instance name will be
used to create this user. And the same user will own the Managing Server file
system. You need to log in as this user to start the Managing Server. For
example, db2inst will be the instance name and the JDBC user. Db2inst is
am_user in this case.

Password - Type the password to correspond with the DB2 Instance user
account. This string can have one to eight characters, without spaces. The
string must not begin with a number or an ampersand. The only valid
symbols are: @, #, $, &.

Group Name - (UNIX-only) Type the group name. This string can have one to
eight characters, without spaces.

Home Directory - (UNIX-only) Type the home directory for the instance. This
string can have one to 64 characters, without spaces.

Chapter 3. Installation and Configuration 25



* Gather the installation image location information for IBM DB2 v8.1 fixpack 3.

Note: Copy and untar images from the CD-ROM to your local drive. Installer
does not support the CD-ROM installation. For example, select a directory that
starts with "ese” and which has the license.txt file. Installer supports only DB2
v8.1 fixpack 3 images. Make sure that images you copy to your local drive have
the correct read /write/execute permissions. At times when copying images from
a CD, all the images becomes read-only.

Use existing DB2

If you are using a database installed on the same machine as the Managing Server,
and it is DB2, gather the following information before you run the graphical
installer:

* DB2 User name (amuser)
* DB2 Password (amuser password)
* DB2 instance (db2inst1 - for UNIX)(DB2 - for Windows)

* Fully qualified JDBC Driver jar file (/home/db2inst1/sqllib/javal2/db2java.zip -
for UNIX) (C:\Program Files \IBM\SQLLIB\java\db2java.zip - for Windows)

Use existing Oracle

If you use Oracle, gather the following information before you run the graphical
installer:

* Oracle host name
Gather the fully qualified host name.
Do not include a protocol in the host name. For example, use
myserver.ibm.com, not https://myserver.ibm.com
* Oracle port (1521)
Gather a port number that you specified during Oracle installation.
* Oracle SID (octigate)

Gather the Oracle system identifier number for the database, refer to
[Remote Oracle” on page 19|if you are using remote Oracle database.

* JDBC User (amuser)

Gather the name of an existing user of the Oracle database.

* JDBC User password (ampassword)

Gather the name of an existing password for the Oracle database.
¢ Fully qualified JDBC Driver classes zip file (/opt/oracle/jdbc/lib/classes12.zip)
* Fully qualified JDBC Driver charset file (/opt/oracle/jdbc/lib/nls_charset12.zip)

In addition, if you are using an Oracle database installed on the same machine as
the Managing Server, then you must gather the following information before you
run the graphical installer. (If you are using Oracle remotely, you will need this
information for setting up the remote database:)

* UNIX username that can run sqlplus (oracle)

* Tablespace name (for use with the Managing Server) (wsam_ts)
* DBA User name (system)

* DBA User password (manager)
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Run Installer

Before you install the Managing Server, make sure you follow the procedures for
upgrading, if appropriate (“Upgrading Considerations” on page 31)) and for
preparing to install (“Preparing to Install” on page 12) and follow the instructions
found earlier in this chapter.

Note: When upgrading Managing Server if you want to migrate data , make
certain your input is ‘'No’ when entering the value for re-initializing the
database by the installer.

Note: If you are using a remote database, make sure that you have followed the
instructions on [“Using a Remote Database” on page 18|before you install the
Managing Server.

Note: It is recommended that you delete WebSphere managed variable
DB2_JDBC_DRIVER_PATH (If you are planning to use DB2) or
ORACLE_JDBC_DRIVER_PATH (If you are planning to use Oracle).

Note: Make sure the Application Server type and version, and the operating
system type and version you are using are supported. (If the installation
environment does not meet the prerequisites, the installer prerequisite check will
fail and you will be unable to continue the installation. If you wish to proceed
with the installation, you can bypass the prerequisite check by passing the
parameter "-force” to install-MS.sh.

Note: The installer will create log files in (/tmp/ibm_am_installer_ms/ - for
UNIX) (%TEMP%\ibm_am_installer_ms\ - for Windows) during the installation.
After installation is complete, you can find a copy of the logs in the
<am_home>/logs directory.

Note: Embedded DB2 installation logs can be found in /tmp/db2setup.log (UNIX)
or <My Documents directory of a user>\DB2LOG\db2.log (Windows). Embedded
DB2 and WAS trace logs can be found in
/var/ibm/tivoli/common/BWM/logs/trace-install.log (UNIX-ONLY) or <Program
Files>\IBM\tivoli\common\BWM\logs\trace-install.log.

Note: If embedded DB2 or WebSphere fails during the installation, then you need
to manually uninstall both of them, and then rerun the installer. Instructions are
defined in the [“How to uninstall DB2 (UNIX-only)” on page 45|or ["How to|
funinstall DB2 (Windows only)” on page 45,

Note: If the pre-installation steps for users "amuser” and "admin” were not
correctly performed, the installer will not open, and will display errors in the
console.

Note: For UNIX - If running the installation from a remote machine, enter: xhost +
<hostname> on the machine on which you are installing the Managing Server.

To install the Managing Server (UNIX-only):
1. Log in as the root user.
2. Start your J2EE server.

Note: If you are in an ND environment then you must start the following.
* Deployment Manager
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* Node Agent
* WebSphere instances to be monitored

3. Source the profile for the "amuser” user described in [‘Setting the Environment”]
Or if you wish, set the environment variables appropriate to your

environment manually.

source ~amuser/.profile

This command may vary according to the shell you are using.

4. Refer to[“Setting the Environment” on page 20| to verify this has completed
correctly, by issuing the following commands:

For WebSphere:
echo $JAVA_HOME
echo $PATH
For WebLogic:
echo $WL_HOME
echo $JAVA_HOME
echo $PATH
Make sure that the output from the echo command matches your inputs.

5. Locate the file MSInstall.tar in the installation media. Go to the directory where
you downloaded MSInstall.tar and extract the contents to a temporary
directory:

mkdir /tmp/wsaminst

cp MSInstall.tar /tmp/wsaminst
cd /tmp/wsaminst

tar xf MSInstall.tar

6. If you want to perform an Interactive (GUI) install go to Step 6a. If you want to
perform a non-Interactive (silent) install go to step 6b.

a. If running the installation on a remote server, export the display to your
local workstation using the following command:

DISPLAY=<workstation>:0; export DISPLAY

Run installer (You must be in this directory of the installer to work
properly):

cd /tmp/wsaminst/Installer-MS/bin/

For WebSphere:

sh install-MS.sh

For WebLogic:

sh install-MS.sh -wls

Note: Make sure that noclobber option is turned off in your shell profile.
Use the following command to turn it off:

set +o noclobber
b. Create a copy of the sample response file.
cd /tmp/wsaminst/Installer-MS/etc

Note: For WebSphere, select one of the sample response files according to
your needs.

¢ mslnputs_Sample.txt (to use existing WAS and DB2)
* mslnputs_Install. WAS.txt (install WAS and Managing Server)
¢ mslnputs_Install DB2.txt (install DB2 and Managing Server)
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¢ mslnputs_Install WAS_And_DB2.txt (install WAS, DB2 and Managing
Server)

Note: For WebLogic, select the response file msInputs_Sample.txt.
cp msInputs_Sample.txt msInputs.txt

Edit the response file msInputs.txt. The parameters required are
documented within the text file.

Run the installer in silent mode.

cd /tmp/wsaminst/Installer-MS/bin/

For WebSphere: sh install-MS.sh -silent ../etc/msInputs.txt
For WebLogic: sh install-MS.sh -wls -silent ../etc/msInputs.txt

Note: Make sure that noclobber option is turned off in your shell profile.

Use the following command to turn it off:
set +o noclobber

To install the Managing Server (Windows-only):

1.
2.

Log in as the Administrator user.
Start your J2EE server.

Note: If you are in an ND environment then you must start the following.
* Deployment Manager

* Node Agent

* WebSphere instances to be monitored

Refer to[“Setting the Environment” on page 20| to verify this has completed
correctly, by issuing the following commands:

For WebSphere:
echo %JAVA_HOME%
echo %PATH%

Make sure that the output from the echo command matches your inputs.

Locate the file MSInstall.tar in the installation media. Go to the directory where

you downloaded MSInstall.tar and extract the contents to a temporary
directory, for example, C:\temp\wsaminst.

If you want to perform an Interactive (GUI) install go to Step 5a. If you want to

perform a non-Interactive (silent) install go to step 5b.
a. Open the command-line console:

Note: For Windows 2003, change the user to install using the following
command:

change user /install

Run installer (You must be in this directory of the installer to work
properly):

cd C:\temp\wsaminst\Installer-MS\bin\

For WebSphere:

Note: If you have multiple IP’s then edit the file IPAddress_List.txt and add

all the IP addresses including local host IP separated line by line.
install-MS.bat
b. Create a copy of the sample response file.
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cd C:\temp\wsaminst\Installer-MS\etc

Note: For WebSphere, select one of the sample response files according to
your needs.

¢ mslnputs_Sample.txt (to use existing WAS and DB2)
* mslnputs_Install_ WAS.txt (install WAS and Managing Server)
* mslnputs_Install_DB2.txt (install DB2 and Managing Server)

¢ mslnputs_Install WAS_And_DB2.txt (install WAS, DB2 and Managing
Server)

copy msInputs _Sample.txt msInputs.txt

Edit the response file msInputs.txt. The parameters required are
documented within the text file.

Note: For all the paths, the separator should be a double back-slash (\\)
instead of single backslash; and all paths should be converted into
non-space format, e.g. C:\Program Files\ should be converted into
C:\\PROGRA~I\\.

Run the installer in silent mode.

cd C:\temp\wsaminst\Installer-MS\bin\

For WebSphere: install-MS.bat -silent ..\etc\msInputs.txt

Post-installation steps (for WebSphere and UNIX only)

Based upon your decision to use either an existing remote/local or the new

embedded installer version of the database, perform these instructions on that

machine. Include in the profile of the “amuser” (likely found under

/home/amuser/ .profile, may be at different location for your environment) use the

following:

* Source the files db2profile, which is located in the sqllib subdirectory of the DB2
home directory respectively.

* Export WAS_HOME

* Export JAVA_HOME

* Modify your PATH to include JAVA_HOME

The following lines are an example of the code to insert into the profile. If it
already exists you don’t have to do this:

WAS_HOME=<WAS Installation Directory>; export WAS_HOME
(the one you specified during the installation)

JAVA_HOME=${WAS_HOME}/java; export JAVA HOME
PATH=${JAVA_HOME}/bin:${PATH}; export PATH

if [ -f /home/db2inst1/sq11ib/db2profile ]; then
/home/db2inst1/sql1ib/db2profile

fi

Note: All references to db2instl should be replaced with the appropriate DB2
instance name.

Oracle

No updates required.
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Example Configurations
The following is an example of a profile for WebSphere and DB2 on Linux:

EXAMPLE profile for user "amuser” for DB2 on Linux

WAS_HOME=<WAS Installation Directory>; export WAS_HOME
(the one you specified during the installation)

JAVA_HOME=${WAS_HOME}/java; export JAVA_HOME
PATH=${JAVA_HOME}/bin:${PATH}; export PATH

if [ -f /home/db2inst1/sq11ib/db2profile ]; then
/home/db2inst1/sql1ib/db2profile

fi

Upgrading Considerations

Migrating Data

To complete an upgrade of the Managing Server to v3.2 from any earlier version,

you must migrate the data in the database.

Performing a Migration
These instructions describe how to migrate your data from v3.1 so that they are
compatible with the Application Monitor v3.2.

Note: First BACKUP the existing octigate database so you preserve all your data

under the previous schema.

To migrate the data of the Application Monitor database to v3.2 from v.3.1:
1. Make sure your Managing Server components are not running.
2. Connect to WSAM database, for example:
db2 connect to octigate
3. Execute data migration scripts: You should be logged in as user “amuser”.
* Excute SQL script:
— For DB2 database, do db2 connect to octigate:

db2 —tf $AM_HOME/etc/migratetables-db2.sql >
$AM_HOME/1ogs/migratedb.1og

— For Oracle database, go to Oracle database server, do sqlplus:

<am database user name>/<am database user password>@<am
ORACLE_SID> @$AM HOME/etc/migratetables-oracle.sql > $AM_HOME
/Togs/migratedb.log

Note: All SAM_HOME should be replaced with real directory name.
4. Execute migration.sh found in MS_AM_HOME//bin.
5. Bring up all servers.

Note: Log files during migration are located in $AM_HOME/logs.
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Starting the Application Monitor (UNIX-only)

Note: Verify that your Application Server, database, virtual frame buffer (UNIX
only) and optionally HTTP server are running.

For most UNIX platforms you can verify it as follows:

1. To verify the Application Server, go to admin console to make sure your server
is up.

2. To verify database is up, establish a database connection.

3. To verify Virtual Frame Buffer:
ps -ef | grep Xvfb

4. To verify HTTP server:
ps -ef | grep httpd

To start the Application Monitor, follow these steps:
1. Switch to user “amuser”.
su - amuser

Note: If you elected to install IBM DB2 during the installation, then amuser is
the same as the Instance Name. You need to login as DB2 Instance Name.

2. Go to the bin directory where the Application Monitor is installed and run the
am-start.sh script.

cd <AM_HOME>/bin
sh am-start.sh

Note: User amuser should have the permissions to write to a temp directory
(/tmp).

3. Using the terminal window, start the Application Server by typing the
commands appropriate for your Application Server:

WebSphere

Note: Login as the user who is authorized to start WebSphere. If you are using
a user other than "amuser”, make sure you have a db2 profile set. If not, run
/home/db2inst1/sqllib/db2profile.

Note: If the browser language being used to view WSAM is Simplified
Chinese, make the following change. In

$WAS_HOME /properties/encoding.properties, edit the property for zh by
changing 'zh=GB2312" to be 'zh=UTF-§'".

Export the display to wherever your virtual frame buffer is running.
For example: export DISPLAY=<hostname>:1 (if you started Xvfb: 1)

cd <WebSphere Install directory>/bin
sh startServer.sh server_wsam &

Note: Substitute the name of the Application Server you are using for the
Visualization Engine in place of server_wsam.

WebLogic
Go to your WebLogic domain directory, for example:

Export the display to wherever your virtual frame buffer is running.
For example: export DISPLAY=<hostname>:1 (if you started Xvfb: 1)

cd /opt/bea/user_projects/domain/<domain>
./startWSAM_WebLogic.sh &
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Note: Do not run startManagedWebLogic.sh, use start WSAM_WebLogic.sh
instead.

Note: Starting a Managing Server through Node Manager is not supported.
You need to use a script to start the Managing Server.

4. If your Web environment requires an HTTP server, and the HTTP server is not
running, change directory to your HTTP Server and start it as root as follows:

Linux:
cd /opt/IBMHTTPServer/bin
./apachectl start
AIX:
cd /usr/ HTTPServer/bin/
./apachectl start
The exact path depends on the convention used at your site.
5. To log into the monitoring console, open a browser and type in:
http://<hostname>/am/home

You can use the user name “admin” and UNIX password for UNIX user
“admin” to log in.

Note: If your J2EE Application Server is not configured to be served on port
80, and you have not set up an HTTP server to do so, you have to include the
port number in the URL. For example, the default port that WebSphere 5.1.1
listens on port 9080.

http://<hostname>:<port>/am/home
Note: This port can be found in
<WAS_BASE_DIRECTORY>/config/cells/<cell_name>/<nodes>

/<node_name>/servers/<server_wsam>/server.xml.

Note: Make sure your pop-up blocker is turned off.

Starting the Application Monitor (Windows-only)

Note: Verify that your Application Server, database, virtual frame buffer and
optionally HTTP server are running.

1. To verify the Application Server, go to admin console to make sure your server
is up.
2. To verify database is up, establish a database connection.

To start the Application Monitor, follow these steps:
1. Login as user “amuser”.

2. Launch a KShell window.
Start > Programs > Windows Services for UNIX > Korn Shell.

Note: Do not use already existing korn shell. Instead open a new korn shell
window.

cd SWSAMBIN

./am-start.sh.

Note: Through either way, the KShell window should be remained open;
otherwise the WSAM server will go down.
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Note: If the browser language being used to view WSAM is Simplified
Chinese, make the following change. In
$WAS_HOME /properties/encoding.properties, edit the property for zh by
changing 'zh=GB2312" to be 'zh=UTF-§'".

3. Start a command-line console:
Start > Run >cmd
cd <WAS_HOME>\bin

setupcmdline
startserver server_wsam (The server name you gave during the installation.)

4. To log into the monitoring console, open a browser and type in:
http://<hostname>/am/home
You can use the user name “admin” and the password for user "admin.”

Note: If your J2EE Application Server is not configured to be served on port
80, and you have not configured an HTTP server to do so, you have to include
the port number in the URL. For example, the default port that WebSphere
5.1.1 listens on is port 9080.

http://<hostname>:<port>/am/home

Note: Make sure your pop-up blocker is turned off.
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Chapter 4. Customization

Follow the instructions below to complete the customization of your environment.
For information on setting up cron jobs for maintenance, see the Operator’s Guide.

Set up Email Host

The Application Monitor includes a “traps” feature that allows the user to have
email messages sent when certain thresholds are reached. To have this feature
work correctly, the SMTP host needs to be specified.

Note: The Performance Analysis & Reporting (PAR) section and the Traps section
will not email reports without this step.

To do this, edit the file:
<MS_AM_HOME> /etc/md.properties

and specify the correct IP address of the SMTP host or hostname (A valid email
server is required; contact your Email Administrator for this information) for
property as:

smtp.host=aa.bb.cc.dd

where aa.bb.cc.dd should be substituted with the IP address of the SMTP host.

Set up Email Sender Address

The user needs to specify a valid email address to enable the Email Report
Link/PDF feature of the Application Monitor. Set "ve.framework.email.sender”
property in <AM_HOME?>/etc/ve.properties with a valid email address on your
own SMTP domain, for example:

ve.framework.email.sender=support@usca.ibm.com

Set up Email Port

If your Managing Server is not running on default port 80 then you need to edit
two properties files AM_HOME/etc/psl.properties and
AM_HOME/etc/ps2.properties. Edit the variable ve.port=<port of the managing
server>.

Set up init.d

You may skip this section if you do not want the Application Monitor to start
automatically upon reboot.

Activate appropriate scripts that can start the following components automatically
upon reboot in the following sequence:

1. Virtual Frame Buffer
2. DB2 or Oracle (DB2 installation may have already created this.)

3. HTTP Server
4. WebSphere
5. am
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To set up the Application Monitor scripts to restart automatically, do the following:

The installation program will install a script for starting the Managing Server back
end components automatically at boot time. To enable the startup script, please
follow the instructions below for each platform. You must login as root or
Administrator to run any of the commands.

Linux: The installation program will install /etc/rc.d/init.d/am. To enable
automated startup at boot time, add am service with chkconfig command as
follows:

/sbin/chkconfig —add am

AIX: The installation program will install /etc/rc.am. To enable startup by process
init, add the following line to the /etc/inittab file:

msbackend:234:once:/etc/rc.am start

Solaris: The installation program will install /etc/init.d/am. To enable automated
startup at boot time, you must create the links below. You may want to modify the
sequence numbers (591, K36) according to local conventions.

In -s /etc/init.d/am /etc/rc2.d/S91am
In -s /etc/init.d/am /etc/rcl.d/K36am
In -s /etc/init.d/am /etc/rc0.d/K36am
In -s /etc/init.d/am /etc/rcS.d/K36am

If you are upgrading, be sure to remove the old startup entry
cyna:234:once:/etc/rc.am start

from /etc/inittab in Solaris.

Windows: To enable automated startup at boot time, run following commands in
KShell:

In -s /etc/init.d/am-start /etc/rc2.d/S40WSAM
Tn -s /etc/init.d/am-stop /etc/rc2.d/KAOWSAM

Set up SNMP

If you want to set up SNMP, see the following instructions:

* |Appendix A, “IBM Tivoli Enterprise Console Integration,” on page 127

* |Appendix B, “BMC Patrol Integration,” on page 153

Set up Regular Database Tuning

To keep the Application Monitor performing well you may wish to tune the
database periodically via a regularly scheduled cron job. For details, refer to the
Operator’s Guide.

Increase Linux Kernel Setting

Red Hat Intel/Linux Managing Server: If you are using a Linux Managing Server,
you should change the MSGMNI kernel variable. This is an IBM recommendation
for DB2 performance tuning.

You can issue (as root), the following command to set it to 1024.
sysctl —w kernel.msgmni =1024
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To check the current setting, use:

ipcs -1

Configuring Your Firewall

Follow the instructions below to configure the firewall between the Managing
Server and the Data Collector.

Note: If you do not have a firewall between your Managing Server and your Data
Collector, please ignore these instructions.

To configure your firewall:

1.

Open the following ports on the firewall from both directions: 9103-9104 9111
9118-9123 9126 9129 8300 8200. (Assuming you used the default settings.)

If you want to monitor Web Server proxies, you need to open port 80 and port
443.

Note: You can use the optional component, Port Consolidator, to minimize the
number of ports required.

For further information, see [‘Configuring Your Firewall” on page 115

Configuring Managing Server for Multiple Network Cards and NAT

If Managing Server should always expose a specific IP to all Data Collectors:

1.

On the Managing Server side, in setenv.sh (in <MS_AM_HOME>/bin/), set the
KERNEL_HOST01 and KERNEL_HOSTO02 to the IP address of the Managing
Server.

On the Managing Server side, in wdctl.sh, kictl.sh and psctl.sh (in
<MS_AM_HOME->/bin/), add a java system property
"java.rmi.server.hostname” to the java command line in the "start” section of the
script and set it to IP address of the Managing Server.

You need to edit the <MS_AM_HOME>/etc/ve.properties file’s kernel.codebase
value to point to the right IP address. This also impacts DHCP where you need
to hardcode the dynamic DNS hostname rather than an IP address in the
<MS_AM_HOME->/etc/ve.properties file.

In addition, if Managing Server was installed on multiple boxes, make the
above changes on all the boxes where Managing Server is installed.

On the Data Collector side, in the datacollector.properties file, make sure that
the kernel.codebase and kernel.rfs.address properties have the right IP address
of Managing Server.

On the Data Collector side, in the datacollector.policy file, make sure that the
socket permissions (java.net.SocketPermission) are granted to the right IP
address of Managing Server.

If Managing Server needs to expose different IP address to different Data
Collectors:

1.

On the Managing Server side, in setenv.sh (in <MS_AM_HOME>/bin/), set the
KERNEL_HOSTO01 and KERNEL_HOSTO02 to the fully qualified domain name
of the Managing Server (for example qaapp-Inx-s01.usca.ibm.com).
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2. On the Managing Server side, in wdctl.sh, klctl.sh and psctl.sh ((in
<MS_AM_HOME->/bin/), add a java system property to the java command
line in the "start” section of the script and set it to the fully qualified domain
name of the Managing Server.

3. In addition, if Managing Server was installed on multiple boxes, make the
above changes on all the boxes where Managing Server is installed.

4. On the Data Collector side, in the datacollector.properties file, make sure that
the kernel.codebase and kernel.rfs.address properties have the right IP address
(of fully qualified hostname) of Managing Server.

5. On the Data Collector side, in the datacollector.policy file, make sure that the
socket permissions (java.net.SocketPermission) are granted to the right IP
address (of fully qualified hostname) of Managing Server.

6. Make sure that on the Data Collector side, the fully qualified host name of
Managing Srever can be resolved to the correct IP address (can use ping to
verify this).

Configuring Data Collector for Multiple Network Cards and NAT

If Data Collector needs to expose a specific IP to the Managing Server.
1. If Data Collector is not using Port Consolidator:
a. Specify a system property "java.rmi.server.hostname” to the AppServer and
set it to IP address of the Data Collector.
b. Make sure that Managing server can access the IP address of the Data
Collector (can verify by doing a ping).
2. If Data Collector is using Port Consolidator:
a. Specify a system property "java.rmi.serverhostname” to the AppServer and
set it to IP address of the Data Collector.

b. Specify a system property "java.rmi.server.hostname” in the "start” section
of the script used to start Port Consolidator and set its value to IP address
of the Data Collector.

C. Make sure that Managing server can access the IP address of the Data
Collector (can verify by doing a ping).

Configuring Managing Server for Large Number of Data Collectors

If the Managing Server is run with a large number of Data Collectors, the out of
the box configuration settings for the Managing Server won't be sufficient to
handle all the Data Collectors, and the Managing Server may throw OutOfMemory
exceptions for different components. To handle this, the Managing Server needs to
be configured as below. On the Managing Server side, in setenv.sh(in
<MS_AM_HOME->, change the following properties):

HEAP_MAX_SIZE PS to 1024
HEAP_MAX_SIZE_ARCHIVE_AGENT to 1024
HEAP_MAX_SIZE_KERNEL to 512

Before changing these configurations make sure that the Managing Server machine

has sufficient memory to handle the increased heap requirements of the
components.
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Configuring Simplified Chinese as the Browser Language

If the browser language being used to view WSAM is Simplified Chinese, make
the following change. In $WAS_HOME/ properties/encoding.properties, edit the
propertyfor zh by changing 'zh=GB2312’ to be 'zh=UTF-8'. In order for this change
to take effect, the server must be restarted.
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Chapter 5. Troubleshooting

The following information will help you in troubleshooting problems with your
installation.

Test Database Connection

If the installation appears to succeed, you should test the database connection.

WebSphere (DB2 or Oracle)

The installation program creates a data source. The following procedure tests if the
installation was successful.

Note: In the case of an Oracle database, you have to perform the following steps:

1. In the WebSphere administrative console, expand the tree Security > JAAS
Configuration > J2C Authentication Data.

2. Click on WSAM ]J2C Authentication data entry.
3. Click Apply.

To test the database connection:

1. In the WebSphere administrative console, expand the tree Resources > JDBC
Providers.

2. Select the name of the JDBC provider.
3. At the bottom of the page, select Data Sources.

4. Place a checkmark in the box next to the correct data source.

JDBC Providers » DB2 Legacy CLI-based Tvpe 2 JOBC Driver »
Data Sources

Data Source iz used by the application to access the data from the databasze. A data source is created under a JOBC provider
which provides the specific JOBC driver implementation class [

Tatal: 1
Fitter

Preferences
1+ Hreterences

Mew | Delete Test Connection
¥ |Hame & JNDI Hame & Description % Category &
[ |Cvanea Data Source jdbciCyaneaDataSource Cyanes/One DB2 JOBC Data

Source

Figure 2. Data Sources

5. Click Test Connection to verify that WAS can connect successfully to the
octigate database. If connected successfully, a message will display at the top of
the screen.

If the test fails, try verifying the following:

¢ Try to connect to the octigate database manually using the DB2/Oracle
command-line processor.

* Verify the user name, password, and database name. If using Oracle, check to
make sure the URL has the following format:
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jdbc:oracle:thin:@<db host>:<port>:<SID>
For example:
jdbc:oracle:thin:@perfdb-sun-sol.ibm.com:1521:0ctigate

* Verify that the user which is used to start the WebSphere console has a DB2
profile as part of its profile.

Authentication

If your passwords have expired or you have changed the passwords, you need to
modify your password in <am_home>/bin/setenv.sh and in the WebSphere data
source.

WebLogic (Oracle)
Test connection utilities by BEA for WebLogic are available for testing JDBC
connections from the command line:
http://e-docs.bea.com/wls/docs61/jdbc/troubleshooting.html
http://e-docs.bea.com/wls/docs81/jdbc/troubleshooting.html

Database Problems

If the Managing Server uses an Oracle database and you see SQL syntax errors,
check ve.properties file and make sure com.cyanea.octigate.database. ORACLE_S8I is
set to Y. If not, set the property to Y, and restart the VE. For example:

com.cyanea.octigate.database.ORACLE_8I=Y

If you are using WebLogic as the Application Server for the Managing Server and
you see URL errors, check ve.properties file and make sure
com.cyanea.ve.framework. CONTEXT_PATH_REDIRECT is set to Y. If not, set the
property to Y, and restart the VE. For example:

com.cyanea.ve.framework.CONTEXT_PATH_REDIRECT=Y

Global Security=0On

The Application Monitor does not support Global Security=on. If you have Global
Security=on in your environment, you will experience pop-up Security Alerts while
browsing pages from the Managing Server. To proceed, click Yes and continue
browsing.

Viewing the Error Logs

The following is a list of additional error logs created by the Application Monitor.

Visualization Engine (VE) -am_system.log (Log messages from the VE),
<WAS_BASE_DIRECTORY>/logs/ <server_wsam>/SystemOut.log.

Kernel Log - am_kl1.log (1st instance) and am_kl2.log (2nd instance)

Publish Server Log - am_psl.log (1st instance), am_ps2.log (2nd instance),
alert.log, and am_ps_audit.log (This file logs the trap- related messages from the
Publish Server.)

Global Publish Server Log - am_sam.log

Archive Agent Log - am_aal.log (1st instance) and am_aa2.log (2nd instance)
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Polling Agent Log - am_pa.log
Audit Messages - am_audit.log

Message Dispatcher Log - am_md.log

To Change Username/Password for WSAM

To change username/password for admin user:

1. Create a local UNIX account associated with the new user, <newusername>.

Note: To change the password for the admin user without changing the
username, change the password of the user on the local OS.

2. Update USERS table in WSAM database by doing:
For DB2:
db2 connect to <wsam database>

db2 "update users set username = '<newusername>', ext_user = '<newusername>'
where username = 'admin' and ext_user = 'admin'"

For Oracle:
export ORACLE_SID=<wsam sid>
sqlplus <wsam username>/<wsam password>

update users set username = '<newusername>', ext user = '<newusername>'
where username = 'admin' and ext_user = 'admin'

Note: You will not be able to change the amuser name of an oracle or db2
database as all of the database information will only be stored in their schema,
and changing the username would make them appear to lose all of their data.
We recommend you change the password of the amuser periodically.

3. You must also modify the <am home>/bin/setenv.sh and edit the parameters
below.

JDBC_USER=<newusername>
JDBC_PASSWORD=<newpasword>
4. You also need to change the ownership of the <am_home> direcotry using
below command if you want to start your processes as the new user.
chown -R <newusername>:<newgroupname> <am home>

To change "amuser” user to a new username in WebSphere:
1. Login to the WebSphere admin console where VE is installed.

2. Expand Resources > JDBC Providers > Choose the JDBC Provider for WSAM >
Data Sources > Choose WSAM DataSource (WSAMDataSource) > J2C
Authentication Data Entries > Choose WSAM ]J2C Authentication Data Entries
> In User ID field, type in the new user, in password field, type in the
password corresponding to the new user. > Click on OK > Save the change >
restart the Application Server.

Note: J2C authentication entry can be found in a intapp-aix-s01/server_wsam
format. Where intapp-aix-s01 is your node name, and server_wsam is your

configured VE server name.

To change the "amuser” user to a new username in WebLogic:
1. Login to the WebLogic admin console where VE is installed.
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2. Expand Services > expand JDBC > Connection Pools > select the JDBC
connection pool for WSAM and click it. > In the properties box, modify the
value of the old user to the new username; in the password field, type in the
corresponding password, in the confirm password field, type in the same
password again. > click on "Apply” > restart WebLogic.

Scripts execution authentication on Windows

By default, the Installer grants the right of executing Managing Server control
scripts to all the members of the group Administrators on Windows platforms. It
allows any of them to start and stop Managing Server by double-clicking the
shortcuts on Desktop or by running the scripts in a KShell console. However, if
two or more users run the scripts in an improper order, the lock file may fail.
Before starting the server, it’s required to make sure that there are no pid files
under /tmp directory that created by other users during previous operations. As
another option, the right of executing these scripts can be restricted to one user by
changing the ownership and mode of these files with chown and chmod
commands. For the Visualization Engine (VE) component running on WebSphere, it
is recommended that the same Windows account is used to operate the Managing
Server.

Port 9090 Conflicts error on AIX

There is a port number conflict between the WebSphere Application Server
Administrative Console and WebSM service on AIX. Both use port 9090. WebSM is
a tool that is useful to administrators who manage many AIX computers.
WebSphere Application Server Administrative Console is used to administer
WebSphere Application Server. The port 9090 conflict on AIX is a known
WebSphere Application Server issue. Ensure that no other applications are using
this port. If you see the following error when you start your Managing Server then
please follow the steps to fix it. Error: Failed to Start Transport on host , port 9090.
The most likely cause is that the port is already in use. Please ensure that no other
applications are using this port and restart the server.
com.ibm.ws.webcontainer.exception. TransportException: Failed to start transport
http: java.net.BindException: Address already in use.

To modify the port number that is used by WebSphere Application Server
Administrative Console, perform the following steps:

1. Disable WebSM Service by issuing the following command:
# /usr/websm/bin/wsmserver -disable

Note: Failure to complete this step before installing WebSphere Portal results in
an incomplete deployment of portlets.

2. Install WebSphere Application Server and WebSphere Portal (including fix
packs and interim fixes).

3. Modify the WebSphere Application Server Administrative Console port number
9090 in the following files to the desired port for the administrative console.
Refer to WebSphere Application Server documentation for more information.

¢ was_root/config/cells/cell_name/nodes
/node_name/servers/serverl/server.xml

* was_root/config/cells/cell_name/virtualhosts.xml
4. Restart the WebSphere Application Server and WebSphere Portal servers.
5. Enable WebSM Service by issuing the following command:

# /usr/websm/bin/wsmserver -enable
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How to uninstall DB2 (UNIX-only)

To uninstall DB2 follow the instructions (as Root):
1. Source <instance-user-homedir>/sqllib/db2profile # sets $DB2DIR etc
2. $DB2DIR/instance/dasdrop
$DB2DIR/bin/db2ilist # list all DB2 instances
For each instance above: $DB2DIR/instance/db2idrop <instance>
From DB2 install directory: db2_deinstall #remove actual installed bits

ook w

Remove DB2 admin, instance, fence users, and delete home directories. On
Solaris, run: userdel -r <login name> # -r removes home directory. This should
remove entries from /etc/passwd and etc/shadow

7. rm /var/db2 if no other version of DB2 is installed.
8. Delete DB2-related lines from /etc/services (text file).
9. On Solaris, at least: check size of textfile /var/adm/messages; DB2 can
sometimes make it expand to 100s of MBs.
10. Remove any old db2-related files in /tmp (logs etc)

11. Make sure that your $DB2DIR is empty. If its not then that means db2
uninstall is not successful.

How to uninstall DB2 (Windows only)

1. Go to Start->Settings->Control Panel->Add Remove Program->DB2 Enterprise
Server Edition.
Click on the remove button to uninstall DB2.
Remove the users created by the DB2. For example: db2Admin and/or amuser.
Stop all the DB2 processes from the Task Manager tab.

ok wn

It is recommended that you reboot the system.

How to uninstall WebSphere

Click on <websphere installation directory>/_uninst/Uninstall.exe and follow the
steps:

1. Delete <websphere installation directory>.

2. If you are using windows then its recommended to reboot the system.
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Chapter 6. Uninstalling the Managing Server

The following instructions describe how to uninstall the Managing Server.

Note: Prior to uninstalling the Managing Server, make sure you do the following:

+ Disable all Data Collectors. See|Chapter 11, “Uninstalling the z/OS Data|
[Collector,” on page 93| for instructions on disabling Data Collectors.

* Stop the Managing Server.

Remove the Application Monitor Database

DB2
1. Login as the DB2 admin user.
2. Check the databases on the box using,
db2 Tist db directory
3. Drop the database by issuing the command:
db2 drop db octigate
Oracle

To remove the database, use the command line tool:
dbassist

Uninstall the J2EE Application Server

WebSphere
1. Launch WebSphere Admin Console.
2. Expand Applications.
3. Click Enterprise Applications.
4. To stop the Enterprise Application, select the octigate application.
5. Click Stop.
6. To uninstall the Enterprise Application, select the octigate application.
7. Click Uninstall.
8. To uninstall the Data Source, expand Resources.
9. Select JDBC Providers.
10. Select DB2 Legacy CLI-Based Type 2 JDBC Driver.
11. Select Data Sources.
12. Select WSAM Data Source.
13. Click Delete.
14. Go to the <Websphere_home>/bin directory.
15. Issue the command:
stopServer.sh <wsam_server>
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WebLogic

. Uninstall the octigate.ear file.

Uninstall the Data Source.

Remove the WSAM CLASSPATH and WSAM Java security policy.

Change the Java memory option back to the original setting from the WebLogic
start up script.

Ao bd -~

Shutting Down the Managing Server
WebSphere

In order to shut down the Managing Server you need to shut down the am
components, including the Application Monitor, WebSphere, HTTP server, and
DB2.

To shut down the Application Monitor:
1. Login as the am user:

Su - amuser

Note: If you elected to install IBM DB2 during the installation, then amuser is
the same as the Instance Name. You need to login as DB2 Instance Name.

2. Go to the <am home> directory:
cd <am_home>/bin

3. Stop the Application Monitor:
./am-stop.sh

To stop WebSphere:
1. To stop WebSphere, go to the <Websphere_home>/bin directory.
2. Issue the command:

stopServer.sh <wsam_server>

or issue the command:
kiTlall java

Note: You may want to record the wsam_server PID and issue kill commands
for that PID; as there may be other Java processes running such as another
WebSphere Application Server.

3. To check for Java processes, issue the command:
ps -ef | grep java

To stop the HTTP server:
1. Go to the HTTP server home directory:
cd <http server home>/bin
2. Issue the command:
./apachectl stop
3. To check if the server is down, issue the command:
ps -ef | grep http

To stop DB2:

1. Login as the DB2 instance owner.
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2. Issue the command:
db2stop

3. To check if DB2 is down, issue the command:
ps -ef |grep db2

Note: You must take the DB2 server down last. When restarting, you must
bring the DB2 server up first in the process.

WebLogic
1. Go to <am_home>/bin directory where am_home is the directory where the
Application Monitor is installed.
2. Issue the command:
am-stop.sh

Uninstall the Application Monitor Files

The following instructions describe how to uninstall the Application Monitor files.

To uninstall the Application Monitor files:

1. Login as root, and remove <managing server installation directory>.

2. If you added the line kernel. msgmni=1024 in /etc/sysctl.conf, remove it.

3. For Linux: If you copied the "am” script to /etc/rc.d/init.d, remove it.
For AIX: If you copied the "am” script to /etc, remove it.
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Part 3. The Data Collector for z/0S
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Chapter 7. Preparing to Install

Planning Your Installation

The following information will help you plan the installation of the z/OS Data
Collector.

Platform prerequisites

Table 4. z/OS Data Collector Prerequisites

Operating

System Application Server |JDK Optional Software

z/0OS 1.2 - | WebSphere 5.0.2.014, | JDK 1.3 MQ5.3.1, DB2 7.1( 0311),DB2 7.0
1.6 5.1.0.004 (cm131s-20041015) for | Universal Driver

WebSphere 5.0.2

JDK 1.4
(cm142-20040917) for
WebSphere 5.1

Warning: Installing the Data Collector into the Admin Console server (non-ND
environment), Node Agent, or Deployment Manager (ND environment) is not
recommended. Failure to be compliant with this requirement may require
deinstalling and reinstalling of z/OS WebSphere to recover the original stage of the
WebSphere. In addition, all UNIX command references here are based on the bash
shell.

Component Considerations
* For ]J2EE support, install the Java and native libraries.
* For MVS dataset, install CYN1PROC address space.

Space Management

The installation process and documentation use the /usr/lpp/wsam/<server>/ as

the installation directory reference of the USS components of the Data Collector.

When the Data Collector starts for the first time, it generates four files in

the/usr/lpp/wsam/<server>/etc directory.

* <sysplex>.<machine name>.<LPAR name>.<server instance name>.
datacollector.properties

* <sysplex>.<machine name>.<LPAR name>.<server instance name>.id

* <sysplex>.<machine name>.<LPAR name>.<server instance
name>.gpsCounter.txt

* cyanea.mod

See ["General” on page 63| for the usage, customization, and maintenance of these
generated files. Each time the Data Collector starts, it will generate a new log file
in the /usr/lpp/wsam/<server>/logs directory. The generated log files should be
cleaned up (deleted) as available space dictates.

As files initially are generated to the /usr/lpp/wsam/<server>/etc directory and
ongoing to the /usr/lpp/wsam/<server>/logs directory, these directories must be
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READ-WRITE. This may be accomplished by mounting a unique HFS file over the
/usr/lpp/wsam/<server>/ directory or by creating a symbolic link that will
redirect access from the /usr/lpp/wsam/<server>/logs and

/usr/lpp/wsam/<server>/etc directories to another set of directories that are
READ-WRITE.

Network Considerations

If your LPAR has more than one IP address, make sure your system and/or
network (DNS) are configured such that the primary IP is used for all connections
between the Data Collector and Managing Server. You can use the netstat-
command to check the IP address being used. Alternatively you may specify the IP
to be used by Application Monitor in the WebSphere configuration via the
java.rmi.server.hostname parameter in JVM Servant property in z/OS WebSphere
5. See [Chapter 10, “Troubleshooting,” on page 91| for more detailed information.

Installation Overview

Prerequisites

* The Managing Server must be installed and configured. See [Part 2, “The|
[Managing Server Installation,” on page 7] for more detail reference.

+ Review section |Chapter 7, “Preparing to Install,” on page 53|to ensure all
necessary software and resources are in place prior to installing the Data
Collector.

Overview
1. Download the software (SMP/E or non-SMP/E format).

2. Un-package/Un-tar the distributed software to the proper mainframe
environment.

Install MVS components.

Install USS component.

Verify the files from the distributed package are indeed all there.
Configure Data Collector on USS side.

Update/Configure WebSphere variables.

Quick start/test of the Application Monitor.

Configure distinct Application Server instances.

©C ©®® NGO MO
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Customize the Application Monitor with optional support, e.g., PMI, SMF,
JDBC, and MQI.

System Access and Levels of Authority

In some environments a systems support staff person may have responsibility and
access to many areas of the system such as WebSphere, MVS and Security (RACEF).
In other Installations the areas of responsibility will be spread across groups; in
fact, these areas of responsibility may reside in distinctly different reporting
structures of the business. To facilitate installation of the Application Monitor z/OS
Data Collector it is important to understand there will be an update of the
WebSphere Administration Console, the MVS Parmlib, Linklib and Proclib and
possibly the security system (RACF) to permit definition of an authorized library.
Thus, the appropriate support staff should be included in the planning and
implementation process for the Application Monitor.
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Chapter 8. Installation and Configuration

Unpackaging Data Collector Software

WSAM 3.2 is installed using SMP/E. Please refer to "Program Directory for IBM
WebSphere Studio Application Monitor V3.2 for z/OS (GI10-3349-00)" provided
with the product tape, for instructions on installing using SMP/E.

Installing the Data Collector

Defining Subsystem CYN1

DYNAMIC SUBSYSTEM DEFINITION

The above Parmlib Update will take effect with the next IPL of the system and is
permanent. An IPL of the system is not required to dynamically add a subsystem.
The following command will define the CYN1 subsystem without an IPL and will
remain in place until the next IPL:

Note: For MVS Dataset update, perform a whole new replacement of both libraries
scynauth and the linklist.

SETSSI ADD,SUBNAME=CYN1

PARMLIB UPDATE
Update the SYS1.PARMLIB(IEFSSNxx) used in your installation to include the
statement:

SUBSYS SUBNAME (CYN1)

RACF UPDATE

Installations have a significant number of options they can choose to enable started
tasks and authorize them with RACF. Usually a started task must have an RACF
association with either a user or a group as well as an entry in the Started Class
Table. This must be done in accordance with your installations specifications to
permit functioning of the CYN1 subsystem and SNTP started task. A possible
solution to this would be to issue the RACF commands:

RDEF STARTED (CYN1*) OWNER(STCRACF) STDATA(USER(STCRACF) TRACE(YES))
SETROPTS REFRESH RACLIST(STARTED)

The Userid associated with the started tasks must have RACF access to the MVS
libraries installed in the subsequent steps.

PROCLIB UPDATE

Locate the file: CYN.SCYNPROC. Either concatenate this file to the JES2 procedure
PROCO00 statement or copy the members from CYN.SCYNPROC into a dataset that
is already part of the JES2/PROC00 DD statement.

Update
Customizing SMF

Authorizing Data Sets and Updating the Linklist: Update
SYS1.PARMLIB(LNKLSTxx) to include CYN.SCYNAUTH in the LNKLST
concatenation or via the LNKLST statement in the appropriate PROGxx member of
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SYS1.PARMLIB. Update SYS1.PARMLIB to define CYN.SCYNAUTH as an
authorized library either via the IEAAPFxx or PROGxx members.

Note: If you use the IEAAPFxx option, simply add a line that contains
CYN.SCYNAUTH volser

where volser is the volume name the library was installed on.

If you use PROGxx, simply add lines that contain

APF ADD DSNAME(CYN.SCYNAUTH) VOLUME(volser)
LNKLST ADD NAME (LNKLST@0) DSN(CYN.SCYNAUTH) VOLUME(volser)

where volser is the volume name the library was installed on.

Installing the IEFU83 Exit: Update SYS1.PARMLIB(SMFPRMxx) to enable the
SMF exit IEFU83 and recording of SMF type 120 records. An example of an entry
to enable an IEFU83 exit and recording of SMF type 120s is:

SYS(NOTYPE(14:19,62:69) ,EXITS(IEFU83,IEFU84,IEFACTRT,IEFUSI,IEFUJI,IEFU29),
NOINTERVAL,NODETAIL)

SUBSYS(STC,EXITS(IEFU29,IEFU83,IEFU84,IEFUJP,IEFUSO, IEFACTRT))

If you currently do not have a SYS and/or SUBSYS statement you must include at
a minimum:

SYS(TYPE(120) ,EXITS (IEFU83))
SUBSYS(STC,EXITS (IEFU83))

If your installation already has an IEFUS83 exit, the MVS command SETPPROG
may be used to create a “cascade effect” of calls to multiple yet distinct modules
that will receive control, sequentially, to view /process the SMF records.

If your installation uses dynamic Exits, update SYS1.PARMLIB(PROGxx) with the
following commands:

EXIT ADD EXITNAME(SYS.IEFU83) MODNAME(CYN1FU83) DSNAME(CYN.SCYNAUTH) FIRST
EXIT ADD EXITNAME(SYSSTC.IEFU83) MODNAME(CYN1FU83) DSNAME (CYN.SCYNAUTH) FIRST

If your installation does not use dynamic Exits, update
SYS1.PARMLIB(COMMNDxx) with the following commands:

SETPROG EXIT,ADD,EX=SYS.IEFU83,MOD=CYN1FU83,DSN=CYN.SCYNAUTH,FIRST
SETPROG EXIT,ADD,EX=SYSSTC.IEFU83,M0D=CYN1FU83,DSN=CYN.SCYNAUTH,FIRST

Initializing MVS: Depending upon the options you selected when installing the
CYNI subsystem, installing the IEFUS83 exit, authorizing the cyn.scynauth library
and adding cyn.scynauth to the active Linklist, an IPL may be required.

Customizing the CYN1 Subsystem for SMF Collection (Optional): In order to
collect SMF information for all the zZWAS server instances on an LPAR, it may be
necessary to customize parameters that control the building of in-core repository
tables in CYN1PROC's address space. These parameters indicate the maximum
number of zZWAS server instances, the sizes of the bean section, the bean method
section, the web application section, and the servlet section pools. So, for example,
if you're running more zZWAS server instances than the maximum allowed, then
CYNIPROC’s maximum zWAS server instances allowed parameter must be
changed, and the other CYN1PROC parameters may require tuning too.

The CYN1 subsystem uses address space storage to store SMF information

collected from the various WebSphere for z/OS Application Server instances
running in the same LPAR. SMF statistics comprise server and container data, bean
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data, bean method data, web application data, and servlet data. These data are
collected from SMF records 120 and reside in the CYN1 address space according to
a hierarchical structure with the server instance as the top level. Memory for such
a structure is pre-allocated by the CYN1 address space when it comes up according
to a pre-defined parameter template, which specifies the maximum number of
server instances, the sizes of the bean section, bean method section, web
application section, and servlet section pools.

The parameter template is assembled and linked in the SCYNAUTH library and its
name is of the form CYNPxxxx. By default, CYN1 will load the CYNPTEST
parameter template which is provided with the SCYNAUTH library. CYNPTEST is
specified as a default parameter in the CYN1 cataloged procedure (PARMS=), as
follows:

//CYN1 PROC SMFWRITE="ON’,PARMS="TEST" //STEP1 EXEC
PGM=CYN1DRVR,REGION=0K, TIME=NOLIMIT, //
PARM="&PARMS,&SMFWRITE’
//***>(->(->(->F**>(->(-*****>(->E***>(-****>(-*****>(->(->(->F>(~*******************************/ //* */ //>(-
PROPRIETARY-STATEMENT: */ //* LICENSED MATERIAL - PROPERTY OF IBM
*/ //**/ //* 5655-L42 (C) COPYRIGHT IBM CORP. 2002-2004 */ //* ALL
RIGHTS RESERVED. */ //**/ //**/ //* WebSphere Studio Application Monitor
*/ //* VERSION 3.2 */ //**/ //*
*/ //STEPLIB DD DISP=SHR,DSN=CYN.SCYNAUTH //SYSLOG DD
SYSOUT=* FREE=CLOSE,SPIN=UNALLOC //*SYSUDUMP DD
SYSOUT=* FREE=CLOSE,SPIN=UNALLOC //*SYSABEND DD
SYSOUT=* FREE=CLOSE,SPIN=UNALLOC //*SYSMDUMP DD
SYSOUT=* FREE=CLOSE,SPIN=UNALLOC //*

Configuring the parameters statically: The source code for a generic CYNPxxxx
parameter template can be found in the CYNPXXXX member of the distribution
library CYN.SCYNPROC, encapsulated by sample JCL to assemble and link it into
the CYN.SCYNAUTH library. You can customize the values in that member and
rename it with any arbitrary suffix of at most 4 characters. Then you can either
edit the CYN1 catalog procedure to reference that member as the default parameter
template, or override the default when you start the CYN1 address space. For
example the JES command:

“START CYN1PROC,PARMS=ABCD" specifies that the CYN1 address space will
load the member CYNPABCD from the library CYN.SCYNAUTH when coming up
and it will use the values specified in that member to allocate its in memory SMF
structures.

You can only modify the following lines in that member:

... PEQUSENN EQU 10 # OF SERVER ENTRIES ... PEQUBSNN EQU
PEQUSENN*2*10 NUMBER OF BEAN SECTION ENTRIES ... PEQUBMNN EQU
PEQUBSNN*10 # OF BEAN METHOD ENTRIES ... PEQUWSNN EQU
PEQUSENN*2*10 # OF WEBAPP SECTION ENTRIES ... PEQUSVNN EQU
PEQUWSNN*10 # OF SERVLET SECTION ENTRIES ...

Furthermore, only the number "10” can be changed; in the above example, the 10.
Do not change the 2. For each server entry there are two sets of pools, a current
pool containing the currently accumulated SMF statistics and an in-progress pool
containing the latest SMF statistics. The SMF statistics in the two pools are then
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aggregated into the currently accumulated SMF statistics. Hence the factor of 2
which is specified in the PEQUBSNN and PEQUWSNN constants, and which
should not be changed.

The constant PEQUSENN specifies the maximum number of server instances
running in the LPAR for which CYN1 will keep SMF statistics for. Once a server
entry is allocated, it remains so until the CYNI region is brought down. Specify a
number big enough to accommodate your needs, but keep in mind that the size of
the bean section, bean method, web application, and servlet section pools will be
multiplied by that number.

The constant PEQUBSNN specifies the average number of bean section entries per
pool and per server instance. Some server instances may have more, some other
less. That number is the size of the common pool. Specify the appropriate number
here.

The constant PEQUBMNN specifies the average number of bean method entries
per bean section. Some beans may have more, some other less. That number is the
size of the common pool. Again specify the appropriate number.

The constant PEQUWSNN specifies the average number of web application section
entries per pool and per server instance. Some server instances may have more,
some other less. That number is the size of the common pool. Specify the
appropriate number here.

The constant PEQUSVNN specifies the average number of servlet entries per web
application section. Some web applications may have more, some other less. That
number is the size of the common pool. Again specify the appropriate number.

Keep in mind that because of the multiplication factors, the number that you
specify at the higher levels (server, bean sections, web application sections) are
propagated at the lower levels. Be aware of that rather than specifying the biggest
numbers just to be safe. The parameter template may not assemble correctly if the
size of the SMF structure is too big.

Configuring the parameters dynamically: Another way to specify the size of the
parameter values above is to override the PARMS parameter in the start command
with those values explicitly. The values are included between two slashes (“/”),
separated with spaces or commas, and they must all be present. For example,
specifying:

START CYN1PROC,PARMS="/ 10,20,5,7,8/" will cause CYN1PROC to dynamically
compute its memory requirements with: Number of server instances: 10
(PEQUSENN) Average number of bean sections per server instance: 20
(PEQUBSNN) Average number of bean methods per bean section: 5 (PEQUBMNN)
Average number of web applications per server instance: 7 (PEQUWSNN) Average
number of servlets per web application: 8§ (PEQUSVNN) All 5 values must be
specified. CYN1PROC will not create a parameter member.

For example:
START CYN1PROC

will start CYN1IPROC using the default specification in the PARMS value of the
cataloged procedure (either explicit values, or a parameter member,
e.g., CYNPTEST).

START CYN1PROC,PARMS="'PROD'
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will start CYN1PROC using the values defined in the parameter member
CYNPPROD.

START CYN1PROC,PARMS='/ 10, 30, 30, 10, 10/'

will start CYN1PROC using the specified values instead of the values specified in a

parameter member.

Verifying the MVS Components: The following MVS commands may be used to

help ensure the installation was successful.

To verify the definition of the CYN1FUS83 exit, use the command:
D PROG,EXIT,MODNAME=CYN1FU83

This should produce messages similar to the following:

CSV4621 16.46.00 PROG,EXIT DISPLAY 978
MODULE CYN1FU83
EXIT(S) SYS.IEFU83 SYSSTC.IEFU83

To verify the installation of the SYSSTC.IEFUS83 exit, use the command:
D PROG,EXIT,EX=SYSSTC.IEFU83,DIAG

This should produce messages similar to the following:

CSV4641 10.09.39 PROG,EXIT DISPLAY 136

EXIT SYSSTC.IEFU83

MODULE STATE EPADDR LOADPT LENGTH JOBNAME

CYN1FU83 A 8A0241A0 0A0241A0 000001EQ *
(verify the Loadpoint and Length are not zero)

To verify the installation of the SYS.IEFUS83 exit, use the command:
D PROG,EXIT,EX=SYS.IEFU83,DIAG

This should produce messages similar to the following:

CSV4641 10.12.26 PROG,EXIT DISPLAY 291

EXIT SYS.IEFU83

MODULE STATE EPADDR LOADPT LENGTH JOBNAME

CYNIFU83 A 932FB5C8 132FB5C8 000001EQ  =*
(verify the Loadpoint and Length are not zero)

To verify that CYN.SCYNAUTH is APF authorized, use the command:
D PROG,APF,DSNAME=CYN.SCYNAUTH

This should produce a message similar to the following:

CSv4501 17.04.49 PROG,APF DISPLAY 386
FORMAT=DYNAMIC

ENTRY VOLUME DSNAME

1 STCEO3 CYN.SCYNAUTH

To verify that CYN.SCYNAUTH is in the active Linklist, use the command:
D PROG,LNKLST

This should produce a message similar to the following:

RESPONSE=STLABCE
CSv4701 14.28.30 LNKLST DISPLAY 539
LNKLST SET LINKO®  LNKAUTH=LNKLST
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ENTRY APF VOLUME DSNAME

1 A IPL12B SYS1.LINKLIB
2 A RES20F CYN.SCYNAUTH
T

To verity that CYN1 Subsystem is defined, use the command:
D SSI,SUB=CYN1

This should produce a message similar to the following:

IEFJ100I 10.32.59 SSI DISPLAY 349
SUBSYS=CYN1
DYNAMIC=YES STATUS=INACTIVE COMMANDS=REJECT

Verify the system is recording SMF type 120 records and the CYN1 subsystem is
capturing data in conjunction with the IEFUS83 exits. This test must be done after
all previous tests and when the WebSphere changes (see the following section)
have been implemented, the conversation activated and WebSphere is up and
running. At that point, use the following commands:

S CYN1PROC

Wait for x minutes to execute the next command where x=SMF interval length. See
[Chapter 9, “Customization,” on page 79|

F CYN1PROC,DUMP,AS,$CYNSETB,192

This should produce output similar to the following;:

CYNSO004I: DUMP,AS,$CYNSETB,192

CYNS00131: 13803000 00000000 00000000 00000000 00000000

CYNSOO13I: 13803010 00000000 00000000 00000000 00000000

CYNS00131: 13803020 00000000 00000000 00000000 00000000

CYNS00131: 13803030 00000000 00000000 00000000 00000000 }
CYNSO013TI: 13803040 00000000 00000000 00000000 00000000

CYNS00131: 13803050 00000000 00000000 00000000 00000000 |
CYNSOO13I: 13803060 13803514 00000037 C1C4C3C4 D7D30000 | ADCDPL
CYNS00131: 13803070 00000000 00000000 00000000 00000000 |

CYNS00131: 13803080 00000000 00000000 00000000 00000000 |
CYNSO013I: 13803090 00000000 00000000 00000000 00000000

CYNS00131: 138030A0 00000000 00000000 C2C2D6C1 E2D9F200 | BBOASR2
CYNSO013I: 138030B0 C2C2D6C1 E2D9F2C3 13803444 13803478 | BBOASR2C

where:
ADCDPL

is your Sysplex
BBOASR2

is your J2EE Server

BBOASR2C
is your J2EE Server Instance

To look for version of the CYN1IPROC, use the following command:
F CYN1PROC,VER

CYNSO004I: VER

CYNSOO45I: CYN1 ID: CYNIDRVR 03.01.00 09/14/04 18.09

Copy Data Collector Files for Servers
The following convention is suggested for choosing the usr/lpp for the Data
Collector:
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¢ Choose a high level qualifier. For example, mkdir /usr/lpp if it does not exist
already.

* The subdirectory "wsam” is fixed, e.g., mkdir /usr/lpp/wsam if it does not exist
already.

* It is recommended that the last subdirectory be the server/instance name that is
created via the WebSphere Admin console for the Application Monitor. For
example, mkdir /usr/lpp/wsam/serverA if it does not exist already.

Note: For Data Collector upgrade, we recommend you archive or remove the
old Data Collector files:

To archive the old Data Collector files, for example:

mkdir <high level qualifier>/wsam/
<server>/backup

mv <high Tevel qualifier>/wsam/<server>/1ib /<high level qualifier>/wsam/
<server>/backup

mv <high level qualifier>/wsam/<server>/etc /<high level qualifier>/wsam/
<server>/backup

mv <high Tevel qualifier>/wsam/<server>/Togs /<high level qualifier>/wsam/
<server>/backup

To remove the old Data Collector files, for example:
rm -rf <high level qualifier>/wsam/<server>/1ib
rm -rf <high level qualifier>/wsam/<server>/etc
rm -rf <high level qualifier>/wsam/<server>/logs
* For Data Collector upgrade, remove the old files, for example:
rm -rf <high level qualifier>/wsam/<server>/1ib
rm -rf <high Tevel qualifier>/wsam/<server>/etc
rm -rf <high level qualifier>/wsam/<server>/logs
* Copy from/usr/lpp/tmp to installation directory.

cp -R /usr/1pp/tmp/wsam/was_server/* /<high level qualifier>/wsam/
<server>/

Note: In this example, <high level qualifier>/wsam/<server> refers to
/usr/lpp/wsam/serverA

Verifying Installation of the Data Collector

After installing the Data Collector on z/OS or OS/390, you should verify that the
installed directories and files match those listed in this chapter. usr/lpp and
<server> represent whatever directory name that you use.

Verifying WebSphere 5

The following table describes the location and permissions of directories and files
included in the installation of Application Monitor Data Collector for WebSphere 5.

Table 5. Installed Directories and Files for WebSphere 5

System |File Permissions
Uss /usr/lpp/wsam IWXT-XT-X
uUss /usr/lpp/wsam/<server> IWXT-XT-X
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Table 5. Installed Directories and Files for WebSphere 5 (continued)

System |File Permissions

uss /usr/lpp/wsam/<server>/etc IFWXT-XT-X
/usr/lpp/wsam/<server>/etc/LogMessages
/usr/lpp/wsam/<server>/etc/jndi.properties
/usr/lpp/wsam/<server>/etc/datacollector.properties
/usr/lpp/wsam/<server>/etc/datacollector.env
/usr/lpp/wsam/<server>/etc/datacollectorservice.xml
/usr/lpp/wsam/<server>/etc/request_jdbc.xml
/usr/lpp/wsam/<server>/etc/request_ctg.xml
/usr/lpp/wsam/<server>/etc/request_imsconnect.xml
/usr/lpp/wsam/<server>/etc/request_jmsqueue.xml
/usr/lpp/wsam/<server>/etc/request_jmstopic.xml
/usr/lpp/wsam/<server>/etc/request_mgqi.xml
/usr/lpp/wsam/<server>/etc/bcm.properties
/usr/lpp/wsam/<server>/etc/version.properties

uss For z/OS WebSphere 5.0.2 /usr/lpp/wsam/<server>/lib ITWXT-XT-X
/usr/lpp/wsam/<server>/lib/libam.so
/usr/lpp/wsam/<server>/lib/common.jar
/usr/lpp/wsam/<server>/lib/cdn jar
/usr/lpp/wsam/<server>/lib/cyaneaaux.jar
/usr/lpp/wsam/<server>/lib/kernel.common.jar
/usr/lpp/wsam/<server>/lib/model.jar
/usr/lpp/wsam/<server>/lib/ppe.probe-intf jar
/usr/lpp/wsam/<server>/lib/ppe.zprobe.jar
/usr/lpp/wsam/<server>/lib/ppe.zws502 jar
/usr/lpp/wsam/<server>/lib/ppe.zcdn_impljar /
usr/lpp/wsam/<server>/lib/ext/

Uss For z/OS WebSphere 5.1 /usr/lpp/wsam/<server>/lib IWXT-XT-X
/usr/lpp/wsam/<server>/lib/libam.so
/usr/lpp/wsam/<server>/lib/libamDLL.so
/usr/lpp/wsam/<server>/lib/common.jar
/usr/lpp/wsam/<server>/lib/cdn.jar
/usr/lpp/wsam/<server>/lib/cyaneaaux.jar
/usr/lpp/wsam/<server>/lib/kernel.common.jar
/usr/lpp/wsam/<server>/lib/model.jar
/usr/lpp/wsam/<server>/lib/ppe.probe-intf jar
/usr/lpp/wsam/<server>/lib/ppe.zprobe jar
/usr/lpp/wsam/<server>/lib/ppe.zws510.jar
/usr/lpp/wsam/<server>/lib/ppe.zcdn_impljar /
usr/lpp/wsam/<server>/lib/ext/

uss /usr/lpp/wsam/<server>/logs IWXT-XT-X
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Table 5. Installed Directories and Files for WebSphere 5 (continued)

System

File

Permissions

MVS

CYN.SCYNAUTH(CYN1$WTO) CYN.SCYNAUTH(CYN1CALL)
CYN.SCYNAUTH(CYN1DRVR)
CYN.SCYNAUTH(CYN1DUMP) CYN.SCYNAUTH(CYN1FUS3)
CYN.SCYNAUTH(CYN1KCRR) CYN.SCYNAUTH(CYN1KCRS)
CYN.SCYNAUTH(CYN1KFOP) CYN.SCYNAUTH(CYN1KGBM)
CYN.SCYNAUTH(CYN1KGBS) CYN.SCYNAUTH(CYN1KGHS)
CYN.SCYNAUTH(CYNIKGSS) CYN.SCYNAUTH(CYN1KGSV)
CYN.SCYNAUTH(CYN1KGWS) CYN.SCYNAUTH(CYN1KRSS)
CYN.SCYNAUTH(CYN1KWEN)
CYN.SCYNAUTH(CYN1KWSC)
CYN.SCYNAUTH(CYN1KWSP) CYN.SCYNAUTH(CYNIMSGS)
CYN.SCYNAUTH(CYN1OPER) CYN.SCYNAUTH(CYN1SLOG)
CYN.SCYNAUTH(CYNITIME) CYN.SCYNAUTH(CYN1UTIL)
CYN.SCYNAUTH(CYNIWLM) CYN.SCYNAUTH(CYN1XCOM)
CYN.SCYNAUTH(CYNIXINT) CYN.SCYNAUTH(CYN1XMPC)
CYN.SCYNAUTH(CYN1XOP) CYN.SCYNAUTH(CYN1XTRM)
CYN.SCYNAUTH(CYN1XZAP)
CYN.SCYNAUTH(CYNMENGL)
CYN.SCYNAUTH(CYNMFRCH) CYN.SCYNAUTH(CYNPTEST)
CYN.SCYNAUTH(CYNPBIG) CYN.SCYNAUTH(CYNPRATIF)

AC=00 AC=00
AC=01 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=01 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00 AC=00
AC=00

MVS

CYN.SCYNPROC(CYNIELOG) CYN.SCYNPROC(CYN1PROC)

AC=00 AC=00

Configuring the Data Collector

The Data Collector must point to the Managing Server and the WebSphere Control
Region. This is done by setting parameters that identify the IP address of the
Managing Server and the WebSphere Control Region. These changes must be
implemented prior to starting the Data Collector.

From here on, we refer to the usr/lpp as the high level qualifier of your Data
Collector directory path.<server> as the last subdirectory of your Data Collector
directory path (i.e., this may be your server/instance name). <WebSphere
directory> as your z/OS WebSphere directory path.

General

The following are general instructions for configuring the Data Collector.

To configure the Data Collector:

Once you have installed a Data Collector, you must configure it so that it
communicates with the Managing Server. This is accomplished by setting the
properties in the following two files:

* /usr/1pp/wsam/<server>/etc/datacollector.properties

* /usr/1pp/wsam/<server>/etc/datacollector.env

1. Edit the file /usr/lpp/wsam/<server>/etc/datacollector.properties. For
property references, see [‘Data Collector Property References” on page 72|

¢ Change all occurrences in this file (global change) of the default IP Address
in kernel.codebase and kernel.rfs.address properties for example, 9.30.134.134
to the IP Address of your Managing Server.

* Save your changes and close the file.
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2. Edit the file: /usr/lpp/etc/datacollector.env. For property references, see
[Collector Property References” on page 72

¢ Change the default directory path in am_modfile property:

From To

/usr/lpp/wsam/was_server /usr/lpp/wsam/<server>/

* Save your changes and close the file.

Once you have installed, configured, and brought up the Data Collector, the
following system-generated files are created and used for subsequent startups in
/usr/lpp/wsam/<server>/etc:

* <sysplex>.<machine name>.<LPAR name>.<server instance name>.
datacollector.properties

* <sysplex>.<machine name>.<LPAR name>.<server instance name>.id

¢ <sysplex>.<machine name>.<LPAR name>.<server instance
name>.gpsCounter.txt

* am.mod

Therefore, if you need to change a value defined in datacollector.properties (such
as Managing Server IP address), you must delete these system-generated
datacollector.properties files, as described in the following instructions:

To update the datacollector.properties file:

1. Update the datacollector.properties file with your changes.

2. Remove the following system-generated files which are located in the
usr/lpp/wsam/<server>/etc directory:

<sysplex>.<machine name>.<LPAR name>.<server instance name>
.datacollector.properties

<sysplex>.<machine name>.<LPAR name>.<server
instance name>.gpsCounter.txt

3. Restart the server.

Configuring the Application Servers

The following instructions describe how to install the Application Servers on
WebSphere 5 on z/OS.

Configuring WebSphere 5 on z/OS
Configuring WebSphere 5 on z/OS involves the following tasks:

“Configuring Probe Services” on page 65,

+ |[“Configuring the z/OS Data Collector Home Runtime” on page 66|

+ [“Configuring Protocol Timeout Properties” on page 67]

» |“Configuring Administrative Services” on page 68|

» [“Configuring the Servant Region Libpath” on page 68|

» |“Supporting Global and Java Security” on page 69

Updating WebSphere Proclib

The WebSphere Servant Region proclib must be updated to accommodate the
Application Monitor Heap Analysis function. Else, the Heap Analysis function may
cause WebSphere to abend. Update the Servant Region procedure to include
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HEAP(,, ,FREE). For Data Collector upgrade, simply comply with the following
configuration. The updated version of the proclib looks like the following:

//BBO5ASR PROC ENV = ADCDPL.P390.SERVER1,Z=BBO5ASRZ
//  SET R0OOT='/WebSphere/V5ROM1"
//BBOSR EXEC PGM=BBOSR,REGION=0M,TIME=NOLIMIT,
//PARM="TRAP (ON,NOSPIE) ,HEAP(, ,,FREE) ,ENVAR("_EDC_UMASK_DFLT=007")/"
//BBOENV DD PATH='&ROOT/&ENV/  was.env'
// INCLUDE MEMBER=8Z

Configuring Probe Services
You must configure probe services in WebSphere in order to use the Application
Monitor. This defines the Data Collector custom services to run within the server.

1. Login to the WebSphere Administration Console.
2. Navigate as follows:

a. Select the Servers > Application Servers option and select the
<ServerName>.

b. Navigate to the Additional Properties: Custom Services.
3. Select <New> for new creation or select ’-" of the probe service for update.

4. In the configuration window enter or update the following (For Data Collector
upgrade, delete the contents of the classpath and re-enter the new
configuration.):

Startup: checked
External Configuration URL: <blank>
Classname: com.cyanea.websphere.ProbeService
Display Name: Probe Service
Description: <blank>
Classpath:
/usr/1pp/wsam/<server>/1ib/ppe.zprobe.jar:
/usr/Tpp/wsam/<server>/1ib/ppe.zws502.jar:1
/usr/1pp/wsam/<server>/1ib/ppe.probe-intf.jar:
/usr/1pp/wsam/<server>/1ib/model.jar:
/usr/Tpp/wsam/<server>/1ib/kernel.common.jar:
/usr/Tpp/wsam/<server>/1ib/common. jar:
/usr/Tpp/wsam/<server>/1ib/cyaneaaux.jar:
/usr/1pp/wsam/<server>/1ib/ppe.zcdn_impl.jar:
/usr/1pp/wsam/<server>/1ib/cdn.jar
1 For z/OS WebSphere 5.1, use ppe.zws510.jar instead of ppe.zws502 jar.
5. Select <Apply>.
6. In the Messages dialog box, select ‘Save’.
7. In the Save to Master Configuration dialog box,

 If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.

8. You may re-verify your configuration data in <WebSphere
directory>/<server>/server.xml by searching the keyword "Probe Service’.

Note: This file is ASCII encoded. To view it, you need to either use an editor

which support ASCII encoding (e.g. viascii) or export it to a computer (UNIX
or Windows) which supports the ASCII character set by default.
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Configuring the z/OS Data Collector Home Runtime
You must configure Home Runtime in WebSphere in order to use the Application
Monitor. This defines the Application Monitor start command.

1. Login to the WebSphere Administration Console.

2. Select the Server > Application Servers option and select the <ServerName>.

3. Navigate to the Additional Properties: Process Definition > Servant >
Additional Properties: Java Virtual Machine.

4. Add <installation_directory>/wsam/<server>/lib/boot/bcm-bootstrap.jar to
the Boot Classpath property.

5. In the Generic JVM arguments field:
a. Add the command: -Xrunam.

b. Add the command:

-Xbootclasspath/p:/<installation_directory>/lib/boot/bcm-bootstrap jar.

c. (Optional) Append the following parameters to support the Garbage

Collector Interval.

-Dsun.rmi.dgc.client.gcInterval=3600000 -Dsun.rmi.dgc.server.gcInterval

=3600000

Note: The Data Collector communicates with the Managing Server using
TCPIP sockets and RMI. One effect of using RMI is that garbage collection
occurs every minute. If you don’t want this to happen, you can specify the
garbage collection interval explicitly to a preferred interval by specifying
the parameters in the Generic JVM arguments field. These parameters
must be implemented as a pair.

6. Change Initial Heap Size to 256 and Maximum Heap Size to 256 or above.

7. Select "Apply’.

8. Navigate as follows:

a. In the Java Virtual Machine Panel, navigate to the Additional Properties:

Custom Properties.

b. For new Data Collector installation:

1) Select <New>.

2) In the configuration panel, enter the following name/value pair. Select
<OK> after each add operation:

Name Value

am.home /usr/lpp/wsam/<server>
appserver.platform3 ws502
java.rmi.server.codebase® For UNIX:

‘file:/ / /opt/ibm/wsam/1ib3.2 /ppe.zprobe.jar

file:/ / /opt/ibm/wsam/lib/ppe.probe-intf jar

file:/ / /opt/ibm/wsam/1ib3.2/ppe.zws502.jar 2

For Windows:

file:/C:\Progra~1\IBM\wsam\lib3.2\ ppe.zprobe jar
file:/C:\Progra~1\IBM\wsam\lib\ ppe.probe-intf jar
file:/C:\Progra~1\IBM\wsam\lib3.2\ppe.zws502.jar"2
Note: Where /opt/ibm/wsam and
C:\Progra~1\IBM\wsam is your Managing Server
installation directory.

com.ibm.websphere.
classloader.plugin

com.cyanea.bcm.websphere.BemPlugin

c. For Data Collector upgrade:
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1) Update am.home property to reference the current Application Monitor
Data Collector server path. Delete the cyanea.home and create one
called am.home.

2) Select <New> to create the new properties if they don’t already exist.

3) In the configuration panel, enter the following name/value pair. Select
<OK> after each add operation:

Name Value

appserver.platform3 ws502

java.rmi.server.codebase® | For UNIX:

"file:/ / / <msinstallation_directory>/lib3.2 /ppe.zprobe.jar
file:/ / / <msinstallation_directory>/lib/ppe.probe-intf jar
file:/ / / <msinstallation_directory>/1ib3.2 /ppe.zws502.jar"2
For Windows:
file:/C:\\Progra~I\\IBM\wsam\lib3.2\\ppe.zprobe jar
file:/C:\\Progra~I1\\IBM\\wsam\\lib\ \ppe.probe-intf jar
file:/C:\\Progra~I\\IBM\\wsam\\1ib3.2\ \ppe.zws502 jar"2

com.ibm.websphere. com.cyanea.bcm.websphere.BemPlugin
classloader.plugin

11.

1 <libversion> is the Application Monitor version information, for example,
1ib3.2 refers to lib directory of the Application Monitor 3.2.

2 For z/0OS WebSphere 5.1, use ppe.zws510.jar instead of ppe.zws502 jar.

3 For z/OS WebSphere 5.1, enter value as ‘ws51".

“Two single quotes are used to wrap the entire string. There is a space
between every two ‘file” URLs. Since there are 3 file URLs in the string, there
are 2 spaces inside the single-quoted strings. If this string has incorrect syntax,
the JVM will not be attached by WebSphere correctly and will result in a CEE
DUMP.

In the Messages dialog box, select ‘Save’.

In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.

You may re-verify your configuration data in <WebSphere

directory>/<server>/servant.jvm.options by searching the property name (e.g.,

runam, am.home).

Configuring Protocol Timeout Properties
If you have a transaction that is hung or too slow, you need to do this to avoid an
abend. This option is required only for new Data Collector installations.

1.

Login to the WebSphere Administration Console.

2. Navigate as follows:
a. Select the Server > Application Servers option and select the <ServerName>.
b. Navigate to the Additional Properties: Process Definition > Control >
Additional Properties: Environment Entries.
c. Add the following properties, as name/value pairs. Select <OK> after each
add operation:
Name Suggested
Minimum Value
protocol_http_timeout_input 3600
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protocol_http_timeout_output 3600

protocol_http_timeout_output_recovery 3600

protocol_http_timeout_persistentSession 3600

3. In the Messages dialog box, select ‘Save’.
4. In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.

5. You may re-verify your configuration data in <WebSphere
directory>/<server>/was.env.

Configuring Administrative Services

If your WebSphere Configuration Services is not enabled, you must configure
administrative services in WebSphere in order to use the Application Monitor Data
Collector.

1. Login to the WebSphere Administration Console.

2. Navigate as follows:
a. Select the Server > Application Servers option and select the <ServerName>.
b. Navigate to the Additional Properties: Administration Services
C. Select ‘Custom Properties’.

3. Make sure the following property is set to "true”, or create it if it does not yet

exist:
Name Value
com.ibm.websphere.management.enableConfigMBean true

4. Select "Apply’.
5. In the Messages dialog box, select ‘Save’.
6. In the Save to Master Configuration dialog box,

¢ If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.

Configuring the Servant Region Libpath
You must configure the servant region libpath in order to run the Application
Monitor Data Collector. This adds the Data Collector libpath information to the
LIBPATH property of WebSphere Servant Environment so that the Data Collector
native library can be invoked at the server startup time.
1. Login to the WebSphere Administration Console.
2. Navigate as follows:
a. Select the Servers > Application Servers option, select the <ServerName>.
b. Navigate to Additional Properties: Process Definition > Servant >
Additional Properties: Environment Entries.
c. Select New button for creating new entry LIBPATH or select the LIBPATH
entry for an update.

d. Insert the following properties as name/value pair to the beginning (for
Data Collector upgrade update the following LIBPATH value just to be
compliant):

68  Application Monitor: Installation and Customization




Name Value

LIBPATH usr/lpp/wsam/<server>/lib

e. Select <Apply>.

Note: A colon "’ must be used to separate two property values.
3. In the Messages dialog box, select ‘Save’.
4. In the Save to Master Configuration dialog box,

¢ If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

¢ If you are NOT under ND environment, simply select <Save>.

5. You may confirm your changes in was.env and server.xml under <WebSphere
directory>/servers/<ServerName> directory via key word
‘server_region_libpath” and ‘LIBPATH’, respectively.

Note: The server.xml is ASCII encoded. To view it, you need to either use an
editor which support ASCII encoding (e.g. viascii) or export it to a computer
(UNIX or Windows) which supports the ASCII character set by default.

6. If you are upgrading z/OS Data Collector from release 2.1.4 or earlier, you may
already have an existing server with the old configuration. If so, we
recommend removing the old configuration.

a. Go to the mainframe USS window.

b. Go to the WebSphere Server directory. For example,
/WebSphere/ .../servers/<ServerName>.

c. Open the file "variables.xml” and remove the following values under
variable "'WAS_SERVER_ONLY _server_region_libpath’ if they exist:

/usr/lpp/wsam/<server>/lib
/ust/lpp/cicsts/gateway/ctg/deployable

d. If you are under ND (Network Deployment) environment, go to the
<WebSphere Deployment Manager Directory>/.../servers/<ServerName>.
For example,
cd /WebSphere/V5RIMO/DeploymentManager/config/cells/ADCDPLNetwork/
nodes/nodeA/servers/serverl

e. Perform the same operation as step 3 above (delete the
"WAS_SERVER_ONLY_server_region_libpath” property from 'variable.xml’).

Supporting Global and Java Security

* Whether Global security is enabled or not, no change is required by the
Application Monitor Data Collector in
<WebSphere>/ AppServer/properties/server.policy.

* If Java 2 security is enabled, the following properties are required by the
Application Monitor Data Collector to be added to
<WebSphere>/ AppServer /properties/server.policy.
// Added the following for the Application Monitor Data Collector
grant codeBase "file:/usr/lpp/wsam/-" {permission
java.security.AlTPermission;
}sgrant codeBase "file:/<db2 install path>/db2710/classes/
-" {permission java.security.Al1Permission;};
For example, add the following for the Application Monitor Data Collector grant
codeBase "file:/usr/lpp/wsam/-" {
permission java.security. AllPermission; };
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grant codeBase "file:/usr/lpp/db2/db2710/classes/-" { permission
java.security. AllPermission; };

* If Java 2 security is disabled, the following properties, if they exist, can be
removed from the <WebSphere>/AppServer/properties/server.policy.

grant codeBase "file:/usr/1pp/wsam/-" {
permission java.security.AlTlPermission;

1
grant codeBase "file:/<db2 install path>/db2710/classes/-" {
permission java.security.AT1Permission;

s

Note: Although the install is complete, you need to continue with customization
in Chapter 9.

Starting the Data Collector (Quick Start Guide)

Here is a quick start guide for the Data Collector. We recommend you review the

Custom options in [Chapter 9, “Customization,” on page 79 and continue the Data
Collector installation process if the options apply to you. In addition, it is strongly
recommended that you read the Operator’s Guide and the User’s Guide for more
detailed information on using this product.

Note: Suggest verifying the Application Server without the Application Monitor
configuration is functional before continuing the following instructions.

Start the Managing Server (see |“Starting the Application Monitor (UNIX-only)” on|
page 32| in [Chapter 5, “Troubleshooting,” on page 41})

1. Start the CYN1PROC procedure.
2. Start WebSphere with the Application Monitor Data Collector configuration.

3. Using TSO and SDSF (or another suitable program),

¢ Check the WebSphere JESMSGLG job log for the configured Server Region.
You are looking for the “open for e-business” message that indicates the
Server Instance has completed initialization.

¢ Check the WebSphere SYSPRINT job log for the configured Server Region.
You are looking for the following messages:

CYNKOOO1I <PPECONTROLLER, ... Successfully joined Kernel
<IP-of-managing-server>
CYNKOOO2I <PPEPROBE, ... Successfully joined Kernel <IP-of-managing-server>

+Server "<your-server-name>" open for business
The CYNKO0001I message indicates the Data Collector has successfully
connected to the Managing Server.

The CYNKO0002I message indicates the Data Collector has been configured by
the Managing Server.

Configuring Distinct WebSphere Application Server Instances

You may have multiple distinct server instances under a common Control Region.
In this case, you may want to monitor all server instances concurrently. To monitor
two or more distinct WebSphere instances, you will need to create an additional
USS directory structure for each WebSphere instance.

General

The following are general instructions for configuring a distinct WebSphere
Application Server instance.
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Setting up the Data Collector Directories

Duplicate the /usr/lpp/wsam/<server> structure for each additional distinct
server instance. Follow and repeat the instructions below increasing the directory
name structure for each duplicate (i.e. create <server2> for the second distinct
server instance, <server3> for the third and so on).

Log onto the z/OS uss environment, create a copy of the
/usr/lpp/wsam/<server> directory structure and files with the following
commands:

cd /usr/1pp/
mkdir wsam/<server2>

To use share library files approach:

* Duplicate the Application Monitor Data Collector configuration file structures
(e.g., <etc directory>).

cp —pR /usr/lpp/wsam/<server>/etc /usr/lpp/wsam/<server2>
* Make <logs> directory for <server2>.
mkdir /usr/lpp/wsam/<server2>/logs

* Make a <shared> directory for other Application server instances to share the
same version of libraries.

mkdir /usr/lpp/wsam/shared

* Copy the Data Collector libraries from the 1st server instance library directory to
the <shared> directory.

cp -R/usr/lpp/wsam/<server>/lib/* /usr/lpp/wsam/shared

* Change the file permission for the <shared> directory and files beneath it.
chmod -R 755 /usr/lpp/wsam/shared

* Reference the other server instance <lib> directory to the <shared> directory
cd /usr/lpp/wsam/<server2>/
In -s /usr/lpp/wsam/shared lib

Note: This approach can be used if the distinct Application Server instances are of
the same version. For example, you can not use this shared libraries approach for
different versions (2.1.4, 3.1 and 3.2) of the Application Monitor Data Collector .
To use the copied library files approach:

* Simply copy ALL the Application Monitor Data Collector files structures.

cp —pR /usr/1pp/wsam/<server>/* /usr/1pp
/wsam/<server2>

* Remove the log files that were created by the originating server instance.
rm /usr/1pp/wsam/<server2>/logs/*

* Change files/directories permission.

cd /usr/1pp/wsam/<server2>

chmod -R 777 etc

chmod -R 777 Togs

chmod -R 755 Tib

z/OS WebSphere 5
Update Data Collector Control Files

You will need to update the files containing specific pointers to the
/usr/lpp/wsam/<server> directory and any of its subdirectories.
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Edit the following file and replace all occurrences of the “old string” with the
“new string”.

OLD NEW
FILE STRING STRING
/usr/lpp/wsam/<server2>/etc/datacollector.env <server> <server2>

Follow and repeat the instructions, increase the directory name structure created in
the step above (i.e. update <server2> for the second server instance, <server3> for
the third and so on).

Cloning a WebSphere Server with the Application Monitor Data
Collector Configuration

The cloning mechanism is a quick way to create another WebSphere Server. If the
WebSphere Server that was cloned from consists of the Application Monitor Data
Collector configuration, all of the Data Collector configurations will be propagated
to the new cloned WebSphere Server. However, you need to tailor the new server
to be in compliance with your own Application Monitor Data Collector
configuration in order to work well (e.g., the classpath, libpath, jdbc provider, etc.).

Note: Recommend to review and perform (only if you choose to) the optional
support configuration on the Application Monitor server before cloning it. This will
allow the optional support configuration to be cloned as well. See
[“Customization,” on page 79)

To clone a server in WebSphere 5:

1. Login to the WebSphere Administration Console.

2. Navigate to the Server > Application Servers option and select the server
"New”:

3. Enter the server name.

4. In "select template,” select the "Existing Application Server” button and the
server you want to clone.

5. Click 'Next'.
6. Click 'Finish’.

Follow the instructions from the following references to replace <server> with
<server2>:

« |"Configuring Probe Services” on page 65

* |"Configuring the z/OS Data Collector Home Runtime” on page 66}

» |“Configuring the Servant Region Libpath” on page 68|

Chapter 9, “Customization,” on page 79,

Data Collector Property References

z/OS WebSphere 5

The following examples show the default datacollector.properties and
datacollector.env file settings.
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datacollector.properties (for z/0S WebSphere 5)

DEFAULT datacollector.properties

kernel.codebase'=http://9.30.134.134:9122 / kernel.core jar

http://9.30.134.134:9123 /kernel.core.jar http://9.30.134.134:9122 / ppe.publish.jar
http://9.30.134.134:9123 /ppe.publish.jar http://9.30.134.134.:9122 /ppe.publish-intf jar
http://9.30.134.134:9123 / ppe.publish-intf jar kernel.rfs.address'=9.30.134.134:9120
9.30.134.134:9121 probe.rmi.port=8200-8299 probe.controller.rmi.port=8300-8399
am.usecustomrmi=true am.rmisocket.timeout=360000 appmonitor.url.limit=1000
appmonitor.sql.limit=5000

The property value should be entered as one continuous line in the
datacollector.properties file.

appmonitor.sql.limit

This property specifies the maximum length for the SQL strings. The
default value is 5000 characters. If the SQL strings exceed this defined
length, the data collector will truncate it and thus only the SQL string up
to the defined length will be displayed in the Managing Server VE.

Value
Length, in integer.

Example
appmonitor.sql.Timit=5000

appmonitor.url.limit

This property specifies the maximum length for the URL strings. The URL
strings may consist of requestName, applicationName, and URL. The
default value is 1000 characters. If the URL strings exceed this defined
length, the data collector will truncate it and thus only the URL string up
to the defined length will be displayed in the Managing Server VE.

Value
Length, in integer.

Example
appmonitor.url.Timit=1000

am.installedapps.dir

For a Network Deployment environment, this property is optional and is
used by the Software Consistency Check function. This allows you to

specify additional application directories for comparison purpose should
they do not reside in the directories of standard cell/naming convention.

Value
Sub-strings of directoryy names where application code resides.

Example

am.installedapps.dir=/WebSphere/V5ROM1/AppServer/installedApps/cellA:
/WebSphere/V5ROM1/AppServer/installedApps/cel1B:/WebSphere
/V5ROM1/AppServer/installedApps/cellC

am.jmx.host
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To be used when localhost is not resolved correctly in a non-ND
environment. In order for the Application Monitor data collector to work,
localhost should be resolved to the host name of the TCP/IP stack that
WebSphere binds to.

Note: When this property is needed, recommend to specify as an IP
address to eliminate further resolution.
Value

IP Address

Example
am.jmx.host=9.30.134.134

am.rmisocket.timeout

If the am.usecustomrmi property is set to true, this property specifies the
duration of the timeout used for rmi calls.

Value
A duration, in milliseconds.

Example
am.rmisocket.timeout=360000

am.usecustomrmi

Enables use of custom RMI socket factories that enforce timeout, which
prevents hanging the Kernel. Set to false to use standard RMI.

Value
true or false

Example
am.usecustomrmi=true

gpsCushion

Specifies how frequently the counter, which is used to create unique tokens
used to correlate Composite Requests, is written to a file. The default value
is 200. Increase this value if there is too much I/O as a result of monitoring
systems that process many Composite Requests.

Value
an integer

Example
gpsCushion=200

java.rmi.server.codebase

This parameter provides the locations of Data Collector code/library which
can be downloaded from the Kernel.

Note: The java.rmi.server.codebase property is optional in
datacollector.properties, if it has already been defined in the Process
Definition of the Servant process. However, if it has not been able to define
this property in the Process Definition of the Servant process for whatever
reason, you *MUST* specify this property in the datacollector.properties.

Value
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z/0OS WebSphere 5.0.2:

file:///opt/ibm/wsam/<1ibversion>1/ppe.zprobe.jar
file:///opt/ibm/wsam/<libversion>1/ppe.probe-intf.jar
file:///opt/ibm/wsam/<1ibversion>1/ppe.zws502.jar

z/0OS WebSphere 5.1:

file:///opt/ibm/wsam/<1ibversion>1/ppe.zprobe.jar
file:///opt/ibm/wsam/<1ibversion>1/ppe.probe-intf.jar
file:///opt/ibm/wsam/<libversion>1/ppe.zws510.jar

1<libversion> is the Application Monitor version information, for example,
1ib3.2 refers to libs of the Application Monitor 3.2.

Example

z/0OS WebSphere 5.0.2:

java.rmi.server.codebase=file:///opt/ibm/wsam/1ib3.2/ppe.zprobe.jar
file:///opt/ibm/wsam/1ib/ppe.probe-intf.jar
file:///opt/ibm/wsam/1ib3.2/ppe.zws502. jar

z/0OS WebSphere 5.1:

java.rmi.server.codebase=file:///opt/ibm/wsam/1ib3.2/ppe.zprobe.jar
file:///opt/ibm/wsam/1ib/ppe.probe-intf.jar
file:///opt/ibm/wsam/1ib3.2/ppe.zws510. jar

kernel.codebase

This parameter provides the locations of the code/library which can be
downloaded from the Kernel of the Application Monitor.

Value

There are always two copies of the Kernel running. The hostname (or IP
address) of the Kernel and the port number of its HTTP server must be
provided. The two values are separated by a space.

http://hostname:port number/kernel.core.jar
http://hostname:port number/kernel.core.jar

Example

Assuming both copies of the Kernel run on the same IP:

kernel.codebase=http://204.146.177.123:9122/kernel.core. jar
http://204.146.177.123:9123/kernel.core. jar

kernel.rfs.address

This parameter provides the locations where the stub code can be
downloaded from the Kernel of the Application Monitor.

Value

There are always two copies of the Kernel running. The hostname (or IP
address) of the Kernel and the port number of its RFS (Request for Stub)
server must be provided. The two values are separated by a space.

hostname:port number hostname:port number
Example

Assuming both copies of the Kernel run on the same IP:
kernel.rfs.address=204.146.177.123:9120 204.146.177.123:9121
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probe.controller.rmi.port

This parameter specifies a range of port numbers available for the
controller of the data collector to communicate to the Visualization Engine.
The range should be at least equal to the number of possible server regions
that can be started on a single z/OS or OS/390 image and preferably not
overlap with that of probe.rmi.port.

Value

nnnn-nnnn

Example
probe.controller.rmi.port=8300-8399

probe.rmi.port

This parameter specifies a range of port numbers available for the
Command Agent of the Data Collector to communicate with the
Visualization Engine of the Application Monitor. The range should be at
least equal to the number of possible server regions that can be started on
a single z/OS or OS/390 image.

Value

nnnn-nnnn

Example
probe.rmi.port=8200-8299

probe.send.thread.dump

The value "yes” means that Thread Dumps are sent back to the Application
Monitor when one is requested. The default value is "yes.’

The value 'no” means that the dump is stored locally, and instead of
sending the dump contents, the Data Collector sends the fully-qualified
path of the file where the dump is stored.

Value
yes or no.
Example

probe.send.thread.dump=yes

datacollector.env

DEFAULT datacollector.env

am_modfile=/usr/lpp/wsam/was_server/etc/am.mod wsam_intent_trace=yes
classes_not_to_trace! =java/*javax/*;sun/*,oracle/*,org/apache
/*org/omg/*,org/w3c/*,0rg/xml/*,com/ibm/*,com/cyanea/*;com/sun/*;COM/rsa
/*utils/version/*,com/adobe/*

classes_to_trace'=

The property value above should be entered as one continuous line in the
datacollector.properties file.

am_modfile

This parameter points to a file that contains information on the monitoring
level of the Application Monitor.

Value
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usr/1pp/wsam/<server>/etc/am.mod

Example
am_modfile=/usr/1pp/wsam/serverA/etc/am.mod

classes_not_to_trace

This environment variable specifies a list of classes which are not to be
method traced. The environment variable only applies:

* if wsam_intent_trace=yes, method tracing will take place at level 3
regardless of the initial monitoring level.

¢ if wsam_intent_trace=no, method tracing will take place only if the
initial monitoring level is 3.

Note: classes_not_to_trace is not related to the “Exclude(classname)” in the
Data Collector configuration in the Visualization Engine.

Value

A class list consists of class specifiers and uses “;” as separators between
the class specifiers. A class specifier consists of the package name plus its
class name and allows use of * as wildcard to describe matching packages
or classes.

Example

classes_not_to_trace=java/*;javax/*;sun/+;oracle/*;org/apache/*;org/
omg/*;org/w3c/*;0rg/xml/*;com/cyanea/*;com/sun/;COM/rsa/*;com/ibm/*;
utils/version/*;com/adobe/*

classes_to_trace

This parameter specifies an additional list of classes to be method traced.
These classes are in addition to those in the user’s application set. This
variable only applies:

* if wsam_intent_trace=yes, method tracing will take place at level 3
regardless of the initial monitoring level.

¢ if wsam_intent_trace=no, method tracing will take place only if the
initial monitoring level is 3.

Note: classes_to_trace is not related to the “Exclude Overwrite(classname)”
in the Data Collector configuration of Managing Server Visualization
Engine.

Value

A class list consists of class specifiers and uses “;” as separators between
the class specifiers. A class specifier consists of the package name plus its
class name and allows use of * as wildcard to describe matching packages
or classes.

Example
classes_to_trace=trade/*;simplejspserviet/

wsam_intent_trace

This parameter when set to yes will facilitate dynamic changing of the
monitoring level from level 1 to level 3. See more information on this
parameter and its impact in the WebSphere Studio Application Monitoring
User’s Guide. The default value is yes.
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Value
<yes> or <no>

Example

wsam_intent_trace=yes
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Chapter 9. Customization

Optional zZ/OS WebSphere 5 Support

Optional support includes capturing and reporting data such as, PMI, J2EE APIs
(JDBC, JNDI/JMS, MQI), CICS L2 Trace and SME. If you are not sure whether you
need to configure these options, consult with your WebSphere Admin and/or the
Application Support person who knows about the applications that will be used
with the Application Monitor product.

PMI = Performance Monitoring Services
JDBC = Java Database Connectivity
JNDI = Java and Naming Directory Interface

JMS = Java Message Service

Adding SMF Support

You must add SMF support if you want SMF data in the Application Monitor. This
step is required for new Data Collector installations or for first time using SMF
feature from a Data Collector upgrade.

1. Login to the WebSphere Administration Console.
2. Navigate as follows:
a. Select the Server > Application Servers option and select the <ServerName>.

b. Navigate to the Additional Properties: Process Definition > Control >
Additional Properties: Environment Entries.

c. Add the following properties, as name/value pairs. Select <OK> after each
add operation:

Name Suggested Value
server_SMF_container_interval_enabled 1
server_SMF_interval_lengthl 120
server_SMF_server_interval_enabled 1
server_SMF_web_container_interval_enabled 1

3. In the Messages dialog box, select ‘Save’.
4. In the Save to Master Configuration dialog box,

 If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.

5. You may re-verify your configuration data in /<WebSphere
directory>/<server>/was.env.

1 The server_SMF_interval_length property is the time interval length (in seconds)

for getting SMF data. For example, if value=120, SMF data will be retrieved every
120 seconds.
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Adding PMI Support

1. Login to the WebSphere Administration Console.
2. Select the Server > Application Servers option and select the <ServerName>.
3. Navigate to the Additional Properties: Performance Monitoring Service.
4. For the new installation:
a. Select the options "startup’.

b. To fully utilize the Application Monitor features, we recommend the
‘custom’ options.

C. Select the ‘custom’ checkbox with the following configuration:
* beanModule=X
e cacheModule=H
e connectionPoolModule=X
* j2cModule=H
* jvmRuntimeModule=H
e orbPerfModule=H
e servletSessionsModule=H
* systemModule=H
¢ threadPoolModule=H
e transactionModule=H
* webAppModule=H
* webServicesModule=H
* wimModule=H
* wsgwModule=H
d. Select "Apply’.
e. In the messages Dialog box, select ‘Save’.
f. In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.
5. For Data Collector upgrade, simply verify:
a. The ’startup’ checkbox is checked.

b. All PMI modules are compliant with what are listed under new installation
section.

Adding JDBC Support

You must configure WSAM JDBC provider in WebSphere in order to monitor SQL
and EJB/Entity Bean with DB2 requests. This involves defining a JDBC provider
and data source.

Note: If you already have a regular or Universal JDBC provider defined for other
application, you may use the same provider for Application Monitor by simply
following thru the steps in ‘Defining the JDBC provider’ or 'Defining the Universal
JDBC provider” and be sure the configuration of the existing provider are indeed
compliance with the Application Monitor requirements.

Enabling the JDBC support configuration:
1. Login to the mainframe USS system.
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2. update the property ‘jdbc.enable’ to "yes’ value in
/usr/lpp/wsam/<server>/etc/bcm.properties file. For example:

jdbc.enable=yes
3. Save the updated bcm.properties file.

Defining the JDBC provider

This configuration is to support DB2 JDBC Driver.

1. Login to the WebSphere Administration Console.
2. Select the Resources > JDBC Providers.

3. Select the <NodeName>.

4. Select the <ServerName> and click <Apply>.

5. For new Data Collector installation:

a. Click <New>.

b. On the configuration tab, select JDBC Providers and set it to "DB2 for zOS
JDBC Providers (RRS)".

c. Select "Apply’

d. Change the Name field to a uniquely identified name. For example:
<server> DB2 z0S Local JDBC Provider (RRS)

e. Select <Apply>.

f. In Additional Properties table, select ‘DataSources (Version 4) or
"DataSources” option.

Note: "DataSource (Version 4)" is for WebSphere V4. "DataSource” is for
WebSphere V5. You may select either or both; this should be determined by
the applications you run on this server and the datasource level they use. If
you are not sure about the data source configuration, contact your
Application Support person.

g. Click <New>.

h. Fill in the appropriate fields that define your DataSource, which is
installation-specific. The following are examples:
For the "DataSources (Version 4)":
Name: DataSourceSample
JNDI Name: jdbc/DataSourceSample
Database Name:YOUR DB _LOCATION_NAME (for example, S390LOC)
Default User ID: ccc (Your database User ID.)
Default User Password: *** (Your database user password.)
For the "DataSource”:
Name: DataSourceSampleV5
JNDI Name: jdbc/DataSourceSampleV5s

DataSource Helper Classname:
com.ibm.websphere.rsadapter.DB2390LocalDataStoreHelper
i. Select the appropriate database in the Component-managed Authentication
Alias for database authentication in runtime for resource authentication
setting to Application.

j. Select the appropriate database in the Container-managed Authentication
Alias for database authentication in runtime for resource authentication
setting to Container.

k. Select "DefaultPrincipalMapping” option in Mapping-Configuration Alias
tield.

Chapter 9. Customization 81



10.

I. Select <Apply>.

m. Navigate to Additional Property: Custom Properties and add the name
value pair.

Name: databaseName

Value: YOUR_DB_LOCATION_NAME (for example, S390LOC)
n. Click <Apply>.
For Data Collector upgrade, we recommend that you

a. Backup the datasource information from your existing Application Monitor
JDBC provider

b. Delete the old/existing Application Monitor JDBC Provider

c. Follow the instructions from the new Data Collector installation to create a
new JDBC provider.

(Optional) You may choose to allocate more Database Connection Pool by

increasing the pool size under Additional Properties > Connection Pools link,

and click <Apply> to save your changes.

In the messages dialog box, select ‘Save’.
In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.

You may re-verify your configuration data in /<WebSphere
directory>/<server>/resources.xml via a search of db2 provider name, for
example, <server> DB2 zOS Local JDBC Provider (RRS).

Note: This file is ASCII encoded. To view it, you need to either use an editor
which support ASCII encoding (e.g. viascii) or export it to a computer (UNIX
or Windows) which supports the ASCII character set by default.

Defining the Universal JDBC Provider

This configuration is to support Universal JDBC Driver.

1.

A

Login to Admin console.

Navigate to Resources > JDBC Provider.

S

elect the <NodeName>.

Then select the <ServerName> and click <Apply>.

Click the <New> button for a new creation or select the Universal JDBC
Provider name for an update.

For new Data Collector installation:

a.
b.

Click <New>.

On the configuration tab, select Universal JDBC Providers and set it to "DB2
Universal JDBC Driver Provider” .

Select "Apply’

Change the Name field to a uniquely identified name. For example:
<server> DB2 z0S Local JDBC Provider (RRS)

Select <Apply>.

In Additional Properties table, select ‘DataSources (Version 4)" or
"DataSources” option.
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Note: "DataSource (Version 4)" is for WebSphere V4. "DataSource” is for
WebSphere V5. You may select either or both; this should be determined by
the applications you run on this server and the datasource level they use. If
you are not sure about the data source configuration, contact your
Application Support person.

g. Click <New>.

h. Fill in the appropriate fields that define your DataSource, which is
installation-specific. The following are examples:
For the "DataSources (Version 4)":
Name: DataSourceSample
JNDI Name: jdbc/DataSourceSample
Database Name:YOUR DB_LOCATION_NAME (for example, S390L0OC)
Default User ID: ccc (Your database User ID.)
Default User Password: *** (Your database user password.)
For the "DataSource”:
Name: DataSourceSampleV5
JNDI Name: jdbc/DataSourceSampleVs

i. If your datasource will be used for CMP EJB (container managed
persistence), mark the checkbox for the Container managed persistence field.

j. Select the appropriate database in the Component-managed Authentication
Alias for database authentication in runtime for resource authentication
setting to Application.

k. Select the appropriate database in the Container-managed Authentication
Alias for database authentication in runtime for resource authentication
setting to Container.

. Select ‘DefaultPrincipalMapping’ option in Mapping-Configuration Alias
field.

m. Select <Apply>.

n. Navigate to Additional Property: Custom Properties and add the name
value pair.

Name: databaseName
Value: YOUR DB_LOCATION_NAME (for example, S390LOC)
0. Click <Apply>.
7. For Data Collector upgrade, we recommend that you

a. Backup the datasource information from your existing Application Monitor
Universal JDBC provider

Delete the old/existing Application Monitor Universal JDBC Provider

c. Follow the instructions from the new Data Collector installation to create a
new Universal JDBC provider.

Adding JNDI Support

To enable JNDI event capture: (If you are not sure of this option, contact your
Application Support person.)

1. The default initial context factory property is provided in the file located at
/usr/lpp/wsam/<server>/etc/jndi.properties. We recommend not to delete
this initial property. However, users may update jndi.properties with additional
context class factory as an option.

2. Login to the WebSphere Admin Console.
3. Navigate to Servers > Application Servers option, select the <ServerName>.
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4. In the Process Definition > Servant > Additional Properties:Java Virtual
Machine link.

5. Insert the following value to the beginning of the Classpath field if it doesn’t
already exist.

/usr/1pp/wsam/<server>/etc
6. Select <Apply>.
7. In the messages Dialog box, select ‘Save’.
8. In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.

9. You may re-verify your configuration data in /<WebSphere
directory>/<server>/was.env by searching the keyword
server_region_classpath.

Adding JMS Support

To enable JMS event capture: (If you are not sure of this option, contact your
Application Support person.)

1. Enable the JMS support configuration:
a. Login to mainframe USS system.

b. Edit the following properties in the /<installation
directory>/wsam/<server>/etc/bcm.properties file.

For JMS Interface Queue, update the property 'jmsqueue.enable’ to "yes’
value. For example:

jmsqueue.enable=yes

For JMS Interface Topic, update the property ‘jmstopic.enable’ to "yes’
value. For example:

jmstopic.enable=yes
C. Save the updated bcm.properties file.

2. Login to the WebSphere Admin Console and navigate to Servers > Application
Servers option, and select the <ServerName>.

3. Navigate to the Additional Properties: Custom Services.
a. Select -’ of the probe service for an update.

b. Insert the following value exactly as written to the beginning of the
Classpath field:

${WAS_LIBS DIR}/messagingImpl.jar:

Note: The "’ is required to separate between 2 classpath values.
c. Click <Apply>.
4. In the messages Dialog box, select ‘Save’.
5. In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.

6. You may re-verify your configuration data in /<WebSphere
directory>/<server>/server.xml by searching the keyword 'messagingImpl’.

7. Need to ensure the existence of messaginglmpljar file under ${WAS_LIBS_DIR}
directory path. To do so, navigate as follows:
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At your z/OS WebSphere Admin console, select the Environment > Manage
WebSphere Variables.

Select the <NodeName> and leave the server option blank and click
<Apply> button.

Look for ${WAS_LIBS_DIR} and its real value (e.g.,
${WAS_INSTALL_ROOQOT]}/lib). Use <next> or <previous> link to scroll to
the next or previous page, respectively, until you find it.

Need to look furthur for ${WAS_INSTALL_ROOT} and its real value from
the previous search. (e.g., /WebSphere/V5R0M1/AppServer).

Then, go to the mainframe USS system and look for the existing of
messagingImpl jar file under the directory of ${WAS_LIBS_DIR}. For
example,

cd /WebSphere/V5ROM1/AppServer/1ib

1s -1 messagingImpl.jar

If you don’t see it, you need to locate this messagingImpljar file (via your
WebSphere administrator) and update the classpath in Custom Services
option.

Adding MQI Capturing Support

This support allows you to monitor the MQI events if you have MQ installed and
configured in your Application Server environment. If you are not sure about this
MQI event, please contact your Application Support person.

Assumption/Prerequisites:

* MQ version 5.3.1 must be installed already.

* WebSphere MQ Queue Connection and Queue Destinations must be configured
under WebSphere MQ JMS Provider option via WebSphere Admin Console.

To enable MQI event capture: (If you are not sure about this option, contact your
Application Support person. )

1. Enable the MQI support configuration:

a.
b.

C.

Login to the mainframe USS system.

Update the property ‘mgqi.enable’ to "yes’ in
/usr/lpp/wsam/<server>/etc/bcm.properties file. For example:
mqi.enable=yes

Save the updated bem.properties file.

2. Login to the WebSphere Admin Console and navigate to Servers > Application
Servers option, and select the <ServerName>.

3. Select the Additional Properties: Message Listener Service > Additional
Properties: Listener Ports.

4. Click <New> for creating a new listener port or select the port name for
updating.

5. Fill in the appropriate fields:

Name: <Listener Port Name> (e.g., TestwareMQListener)
Initial State: Started

Connection factory JNDI name: <JNDI Name for the JMS
connection factory> (e.g., jms/TestwareQCF)

Destination JNDI name: <JNDI Name for the destination to be
used by listener port> (e.g., queue/mdbQueue)

6. Click <Apply> and then <OK>.
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7. Navigate back to your <ServerName> page.
8. Navigate to the Additional Properties: Custom Services. .
a. Select - of the probe service for an update.

b. Insert the following value exactly as written to the beginning of the
Classpath field:

${MQIMS_LIB_ROOT}/com.ibm.mq.jar:

Note: The "’ is required to separate between 2 classpath values.
c. Click <Apply>.
9. In the messages Dialog box, select ‘Save’.
10. In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.
11. From the menu, navigate to the following:

* Go to Administration < Server Management < Data Collector Configuration
and select Configuration Library.

* Use the J2EE Default library to create a Duplicate Entry.

¢ From the Duplicate Configuration page, create a unique name for the new
J2EE configuration.

* Save your configuration.

* Select the Modify button from the Configuration List page on the new J2EE
configuration.

* In the Exclude Text box, add a Queue Name or Queue Names you don’t
want to monitor.

* In the Exclude override box, add a Queue Name you want to monitor.
* Save the configuration.
* Apply the WebSphere to this configuration.

12. You may re-verify your configuration data in /<WebSphere
directory>/<server>/server.xml by searching the keyword 'com.ibm.mq’.
13. Need to ensure the existence of com.ibm.mqjar file under
${MQJMS_LIB_ROOT} directory path. To do so, navigate as follows:
a. At your z/OS WebSphere Admin console, select the Environment >
Manage WebSphere Variables.

b. Select the <NodeName> and leave the server option blank and click
<Apply> button.

c. Look for ${MQJMS_LIB_ROOT]} and its real value (e.g.,
${MQ_INSTALL_ROQOT}/java/lib). Use <next> or <previous> link to scroll
to the next or previous page, respectively, until you find it.

d. Need to look furthur for ${MQ_INSTALL_ROOT} and its real value from
the previous search. (e.g., /usr/lpp/mqm/V5R3M1).

e. Then, go to the mainframe USS system and look for the existing of
com.ibm.mq.jar under the directory ${MQJMS_LIB_ROOT]}. For example,

cd /usr/1pp/mgm/V5R3M1/java/Tib
1s -1 com.ibm.mg.jar

If you don’t see it, you need to locate this messagingImpljar file (via your
WebSphere administrator) and update the classpath in Custom Services.
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Adding Garbage Collection Interval Support

The Data Collector communicates with the Managing Server using TCPIP sockets
and RMI. One effect of using RMI is that garbage collection occurs every minute. If
you don’t want this to happen, you can specify the garbage collection interval
explicitly to a preferred interval by specifying the parameters in the Generic JVM
arguments field. These parameters must be implemented as a pair. If you already
have these parameters configured at the “Chapter 8, Configuring the z/OS Data
Collector Home Runtime’ section, there is no need to do this unless you want to
update the interval values to a different desire values.

1. Login to the WebSphere Admin Console.
2. Navigate as follows:
a. Select the Servers > Application Servers and select the <ServerName>.

b. Navigate to the Additional Properties: Process Definition > Servant >
Additional Properties: Java Virtual machine.

c. In the Generic JVM arguments field, append the following parameters if
such parameters don’t exist or simply update the interval values if they
already exist.

-Dsun.rmi.dgc.client.gcInterval=3600000
-Dsun.rmi.dgc.server.gcInterval=3600000

Note: These values require a dash (-) in front of each parameter, and a
single space between parameters. Also, we recommend the interval value =
or > than 3600000.

Adding Multiple Host Support

java.rmi.server.hostname property is optional and it is to be used if there are
multiple IP stacks on the same system/LPAR. HOST_NAME is the name of your
IP Address/host of your LPAR that you want the Data Collector to use for
communication with the Managing Server.

1. Login to the WebSphere Administration Console.
2. Navigate as follows:

a. Select the Servers > Application Servers option and select the
<ServerName>.

b. Navigate to the Additional Properties: Process Definition > Servant >
Additional Properties: Java Virtual Machine > Additional Properties:
Custom Properties.

c. For new Data Collector installation, select <New>.

d. In the configuration panel, enter the following name/value pair. Select
<OK> after each add operation:

Name Suggested Value
java.rrni.server.hos’cnarne1 HOST_NAME

java.rmi.server.hostname property is optional and it is to be used if there
are multiple IP stacks on the LPAR. HOST_NAME is the name of your IP
Address/host of your LPAR that you want the Data Collector to use for
communication with the Managing Server.

e. For Data Collector upgrade, verify whether the existing host name value is
still valid.

3. In the Messages dialog box, select ‘Save’.
4. In the Save to Master Configuration dialog box,
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5.

¢ If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.

You may re-verify your configuration data in /<WebSphere
directory>/<server>/servant.jvm options by searching the variable name (e.g.,
java.rmi.server.hostname).

Adding Support for Composite Requests using CTG

See CICS document for reference.

Adding Support for Composite Requests using IMS Connect

See IMS document for reference.

Controlling Instrumentation of Application Classes

WSAM uses a technique called Byte Code Instrumentation to collect Level 3
tracing data, Heap Analysis data, and Lock Contention data from your
applications. BCI is controlled by the contents of the

<AM_HOME> /etc/cyn.user.classes.xml file. This file can be modified in order to
increase or decrease the scope of instrumentation for Heap, Lock, and Method
entry and exit analysis.

1.

The definelnstrumentation tag defines two broad categories of instrumentation:
user class instrumentation for your homegrown J2EE applications and system
class instrumentation for Application Server (WAS or WLS) infrastructure
classes.

Multiple selectClass tags can be specified within a userClasses tag or a
systemClass tag.

The enableSignatures tag indicates whether or not the method signature should
be included in the Method Entry and Exit tracing.

The mask tag defines a class mask that identifies the classes that should be
instrumented for Heap, Lock and Method Entry and Exit analysis. The class
mask can contain "*" and "?” wildcard characters. For example, the following
mask can be used to instrument all classes in the my.company package:
<mask>my.company.*</mask>

The methods tag (and the inner methodName tags) determine which methods
should be instrumented for Method Entry and Exit. There may be multiple
methodName tags specified. Each tag specifies a mask optionally containing *’
and "?” wildcard characters. For example, the following masks can be used to
instrument all methods that contain ‘execute” and ‘doTask’ in their names:
<methods>

<methodName>*execute*</methodName>

<methodName>*doTaskx</methodName>
</methods>
The ignoreTrivial tag determines whether or not methods should be
instrumented if they are considered ’trivial’.
The objectAllocations tag and inner allocateClass tags define one or more class
masks that identify the instantiated classes for which heap allocations are to be
instrumented. Each class mask can contain " and "?” wildcard characters. For
example, the following configuration can be used to instrument two collection
classes that are allocated by your application classes:
<objectAllocations>

<allocateClass>java.util.Hashtable</allocateClass>
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<allocateClass>java.util.HashMap</allocateClass>
</objectAllocations>

8. The objectAllocationTimes tag specifies whether or not heap allocations should
be modified so that events representing heap allocations appear in the Level 3
trace, while duration associated with heap allocations can be measured.

9. The lockAnalysis tag indicates whether or not the class should be instrumented
for the Lock Analysis feature.

The default cyn.user.classes.xml file enables instrumentation for method entry and
exit (level 3 tracing) for all application classes, but disables instrumentation for
heap and lock analysis.

Another file is provided, with the name cyn.dev.user.classes.xml, which enables
instrumentation for heap and lock analysis, as well as level 3 method entry and
exit tracing.

The name of the file that is used to control instrumentation is specified by the
"userbcm.xmlfilename’ property, in the appropriate bcm.properties file. By
changing the value of this property, you can indicate that a different XML file be
used.
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Chapter 10. Troubleshooting

The following information will help you in troubleshooting problems with your
installation.

Log Files

The following log files may provide some useful data for troubleshooting, with or
without the assistance of the IBM® Support team. Most logs are not owned by
Application Monitor but are used as a destination to receive diagnostic messages
from its code.

WAS Error Logs
Application Monitor does not use this log. This is the standard WebSphere Error

Log. See [Appendix A, “IBM Tivoli Enterprise Console Integration,” on page 127 for
more information on viewing this log.

Data Collector Log
Application Monitor uses this log.

The managed system uses this log file to record major events. Some of these events
pertain to the connections between the managing appliance and the managed
system as well as other anomalies that might be encountered. The Data Collector
log is located in the directory /usr/lpp/wsam/<server>/logs/filename where the
filename is constructed as:

sysplex.machine_name.lpar_name.server_instance_name.
yyyymmddh hmmss . address-space-id-number.datacollector.log

where yyyy=year, mm=month, dd=day, hh=hour, mm=minutes, ss=seconds,
address-space-id-number is a decimal.

CYN1 Log
Application Monitor uses this log.

The managed system, Common Services Subsystem, uses this log (pointed to by
the CYN1 proc for the CYN1 subsystem) to print information regarding the SMF
records received and processed by the subsystem. It will display both
informational and diagnostic messages as well. For more details on the messages,
check the following manual: WebSphere® Studio Application Monitor Messages
and Codes (SC31-6315-02).

Viewing the WebSphere error log:

While we have supplied a Rexx Exec in CYN.SCYNPROC, this is not a supported
function and is provided on a “use as-is” basis. To view the error log, issue the
TSO command:

EX 'CYN.SCYNPROC(CYN1ELOG)' 'WAS.ERROR.LOG'

If your systems use a log name other than “was.error.log”, simply substitute the
log name used in your installation. If you are unsure of the log name or are
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running multiple servant regions, check the JESMSGLG file for the servant region.
The log file name will be identified on the BBOU(0025I informational message.

Protocol Timeout

If you have a transaction that is hung or too slow, you need to do this to avoid an
abend.
1. Login to the WebSphere Administration Console.
2. Navigate as follows:
a. Select the Server > Application Servers option and select the server you
want to configure for use with the Application Monitor.
b. Navigate to the Additional Properties: Process Definition > Control >
Additional Properties section.
C. Select 'Environment Entries’.
d. Add the following properties, as name/value pairs. Select <OK> after each
add operation:

Name Suggested
Minimum Value
protocol_http_timeout_input 3600
protocol_http_timeout_output 3600
protocol_http_timeout_output_recovery 3600
protocol_http_timeout_persistentSession 3600

3. In the Messages dialog box, select ‘Save’.
4. In the Save to Master Configuration dialog box,

¢ If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.

5. You may re-verify your configuration data in /<WebSphere
directory>/<server>/was.env.

92 Application Monitor: Installation and Customization



Chapter 11. Uninstalling the z/OS Data Collector

The following information will help you to disable, re-enable, or uninstall the z/OS
Data Collector.

Disable the Application Monitor

z/OS Websphere 5

1.
2.

10.
11.
12.

13.

14.

15.

Login to the WebSphere Admin Console.

Select the Servers > Application Servers option > select the <NodeName> and
select the <ServerName>.

Navigate to the Additional Properties: Custom Services section.

Click the "-" of the Probe Service property, and uncheck the "startup”
checkbox.

Click <Apply>.

To disable the Data Collector Home Runtime, go back to your <ServerName>
link page and navigate to Additional Properties:Process Definition > Servant>
Additional Properties :JVM.

Remove the "-Xrunam” argument from the Generic JVM arguments.

Click <Apply>.

To disable the JNDI, remove the following value in the classpath if it exists.
/usr/1pp/wsam/<server>/etc

Click <Apply>.

In the messages Dialog box, select ‘Save’.

In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.
To disable the Application Monitor JDBC driver:
* Login to USS mainframe system.

* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file, and update
the property ‘jdbc.enable’ to 'no” value. For example,

jdbc.enable = no
To disable JMS feature:
* Login to USS mainframe system.
* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file,

— For JMS Interface Queue, update the property ‘jmsqueue.enable’ to 'no’
value. For example,

jmsqueue.enable = no

— For JMS Interface Topic, update the property ‘jmstopic.enable’ to 'no’
value. For example,

jmstopic.enable=no
To disable MQI feature:

* Login to USS mainframe system.
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16.

17.

* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file, and update
the property ‘'mqi.enable’ to 'no” value. For example,

mqi.enable = no

To disable SAM/IMS feature: Please refers to the IMS document for detail
references. To disable SAM /CICS feature: Please refers to the CICS document
for detail references.

Restart your server.

Re-enable the Application Monitor

The following instructions describe the process for re-enabling the z/OS Data
Collector.

z/OS WebSphere 5

1.

Login to the WebSphere Admin Console.

2. Select the Servers > Application Servers option >and the <ServerName>.

ook w

10.
11.
12.

13.

14.

15.

Navigate to the Additional Properties: Custom Services.
Click the "-" of the Probe Service property, and check the "startup” checkbox.
Click <Apply>.

To re-enable the Data Collector Home Runtime, go back to your
<ServerName> link page and navigate to Additional Properties:Process
Definition> Servant> Additional Properties: JVM.

Add "-Xruncyanea” in the Generic JVM arguments section.
Click <Apply>.

To re-enable JNDJ, add the following value in the Classpath field if necessary.
See JNDI under [“Optional z/OS WebSphere 5 Support” on page 79|

/usr/1pp/wsam/<server>/etc

Click <Apply>.
In the messages Dialog box, select ‘Save’.
In the Save to Master Configuration dialog box,

¢ If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.
To re-enable the Application Monitor JDBC provider:
¢ Login to USS mainframe system.

* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file, and update
the property ’jdbc.enable” to “yes’ value. For example,

jdbc.enable = yes
To re-enable JMS feature:
* Login to USS mainframe system.
* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file,

— For JMS Interface Queue, update the property 'jmsqueue.enable’ to "yes’
value. For example,

jmsqueue.enable = yes

— For JMS Interface Topic, update the property ‘jmstopic.enable” to “yes’
value. For example,

jmstopic.enable=yes
To re-enable MQI feature:
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16.

17.

¢ Login to USS mainframe system.

* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file, and update
the property ‘'mgqi.enable’ to “yes’ value. For example,

mqi.enable = yes

To re-enable SAM/IMS feature: Please refers to the IMS document for detail
references. To re-enable SAM /CICS feature: Please refers to the CICS
document for detail references.

Restart your server.

Uninstalling the z/0S Data Collector

The following directions describe the uninstall process for z/OS WebSphere 5.

z/0OS WebSphere 5

1.
2.

Login to the WebSphere Admin Console.

Select Servers > Application Servers option > and the <ServerName> and
select the server you want to unconfigure.

Uninstall Probe Services: Navigate to Additional Properties:Custom Services.
Click on the checkbox of com.cyanea.websphere.ProbeService classname and
select <Delete>.

In the Messages dialog box, select ‘Save’.
In the Save to Master Configuration dialog box,

e If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.
Uninstall the Data Collector Home runtime properties as follows:

a. Go to your <ServerName> link page and navigate to Additional
Properties:Process Definition > Servant > Additional Properties: Java
Virtual Machine

b. Remove the following value from the Classpath field if it exists.
/usr/1pp/wsam/<server>/etc
Remove Generic JVM arguments that reference —Xruncyanea
Click <Apply>.
Go to Additional Properties:Custom Properties.
Click on the checkbox of cyanea.home and click <Delete>.
Click on the checkbox of java.rmi.server.codebase and click <Delete>.

Se "o oo

Click on the checkbox of appserver.platform if it exists and click <Delete>.

i. Click on the checkbox of java.rmi.server.hostname if it exists and click
<Delete>.

j. Click on the checkbox of sam.codepage if it exists, and click <Delete>.
In the Messages dialog box, select ‘Save’.
In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.
Uninstall SMF support and protocol HTTP Timeout option as follows:
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10.
11.

12.

13.
14.

15.

16.

a. Go to your <ServerName link> page and navigate to Additional
Properties:Process Definition > Control > Additional
Properties:Environment Entries.

b. Remove the following properties if they exist, for example:
server_SMF_container_interval_enabled = 1
server_SMF_interval_length = 120
server_SMF_server_interval_enabled = 1
server SMF_web _container_interval_enabled=1

c. Remove the following properties if they exist, for example:
protocol_http_timeout_input=3600
protocol_http_timeout_output=3600
protocol_http_timeout output_recovery=3600
protocol_http_timeout_persistentSession=3600

In the Messages dialog box, select ‘Save’.

In the Save to Master Configuration dialog box,

¢ If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.

Uninstall PMI support: Go to your <ServerName> link page and navigate to
Additional Properties: Performance Monitoring Service. Deselect “Startup”
checkbox and select “none” in the “initial specification level” option.

In the Messages dialog box, select ‘Save’.
In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.
Uninstall the server region libpath as follows:
a. Login to Admin console and navigate as follows:

1) Select the Servers > Application Servers option > select the
<NodeName> and select the <ServerName>.

2) Navigate to Additional Properties: Process Definition > Servant >
Additional Properties: Environment Entries.

3) Select the LIBPATH property entry.
4) Remove the following values if they exist:

usr/1pp/wsam/<server>/1ib:/usr/1pp/cicists/gateway/
ctg/deployable

Note: If LIBPATH property only contains above Data Collector
property, you can simply do the following:

a) Select the checkbox of LIBPATH property.
b) Select the <Delete> button.

5) In the Message dialog box, select ‘Save’.

6) In the Save to Master Configuration dialog box,

¢ If you are under ND environment, be sure the checkbox
‘Synchronize changes with Nodes’ is selected and then select ‘Save’.

* If you are NOT under ND environment, simply select ‘Save’.
Uninstall JDBC Providers
a. Login to WebSphere Admin Console.

96  Application Monitor: Installation and Customization



b. Go to Resources > JDBC Providers.
Select the <NodeName> and the <ServerName> and click <Apply>.

d. Select the checkbox of the Application Monitor JDBC provider and/or
Application Monitor Universal JDBC provider and click <Delete>. For
example, the provider names can be:

"<server>DB2 390 Local JDBC Driver"
"<server>DB2 Universal JDBC Driver"

e. In the Messages dialog box, select ‘Save’.

—h

In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

* If you are NOT under ND environment, simply select <Save>.
g. To unconfigure the Application Monitor JDBC option:
¢ Login to USS mainframe system.

* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file, and update
the property ’jdbc.enable” to no” value. For example,

jdbc.enable = no
17. Unconfigure JNDI support
If previous "Uninstall Probe Services” step is not executed, do the following;:

a. Login to the WebSphere Admin Console and navigate to Servers >
Application Servers option and select your <ServerName>.

b. In the Process Definition > Server > Additional Properties:Java Virtual
Machine link, remove the following value from the Classpath field and
select <Apply>.

/usr/1pp/wsam/<server>/etc
C. In the messages Dialog box, select ‘Save’.
d. In the Save to Master Configuration dialog box,

* If you are under ND environment, be sure the checkbox ‘Synchronize
changes with Nodes’ is selected and then select <Save>.

 If you are NOT under ND environment, simply select <Save>.

e. You may re-verify your configuration data in /<WebSphere
directory>/<server>/was.env by searching the keyword
server_region_classpath.

18. To unconfigure JMS feature:
¢ Login to USS mainframe system.
* Open the /usr/lpp/wsam/<server>/etc/bcm.properties file,

— For JMS Interface Queue, update the property 'jmsqueue.enable’ to 'no’
value. For example,

jmsqueue.enable = no

— For JMS Interface Topic, update the property ‘jmstopic.enable’ to 'no’
value. For example,

jmstopic.enable=no
19. To unconfigure MQI feature:
¢ Login to USS mainframe system.

* In the /usr/lpp/wsam/<server>/etc/bcm.properties file, set the property
‘mgi.enable’ to 'no” value. For example,

mqi.enable = no
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* Navigate to Servers > Application Server Options > Select the
<ServerName>. Select the Additional Properties: Message Listener Service
link.

* Select the Additional Properties: Listener Ports link.

* Select the checkbox of the Application Monitor Listener Port and click
<Delete>. For example, listener port name can be "TestwareMQListener’.
Click <Apply> or <OK>.

* In the messages Dialog box, select ‘Save’.
* In the Save to Master Configuration dialog box:

— If you are under ND environment, be sure the checkbox "Synchronize
changes with Nodes’ is selected and then select ‘Save’.

— If you are NOT under ND environment, simply select ‘Save’.

20. To unconfigure SAM/IMS feature: Please refers to the IMS document for
detail references. To unconfigure SAM/CICS feature: Please refers to the CICS
document for detail references.
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Part 4. The Data Collector for Multiplatforms
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Chapter 12. Preparing to Install

The following are the pre-installation requirements for installing and using the
Data Collector.

Requirements for Installing the Data Collector

The following are the requirements for being able to install and use the Data
Collector.

Note: For manual installation instructions, see Appendix D.

Table 6. Data Collector Requirements

Platform Application Server Additional Requirements

AIX 5.1 WebSphere 5.0.2.6, Check that the following packages are installed.
5.0.2.8, 5.1.1 and 6.0 (The numbers may be these or later file set
WebSphere Portal 5.0.2 | numbers.)

* bos.perf.diag_tool 5.1.0.25 Performance
Diagnostic Tool

* bos.perflibperfstat 5.1.0.35 Performance
Statistics Library

*  bos.perf.perfstat 5.1.0.36 Performance Statistics
Interface

* bos.perf.tools 5.1.0.35 Base Performance Tools

AIX 5.2 WebSphere 5.0.2.6, Check that the following packages are installed.
5.0.2.8,5.1.1 and 6.0 (The numbers may be these or later file set
WebSphere Portal 5.0.2 | numbers.)

* bos.perf.diag_tool 5.2.012 Performance
Diagnostic Tool

* bos.perflibperfstat 5.2.0.10 Performance
Statistics Library

* bos.perf.perfstat 5.2.0.14 Performance Statistics
Interface

*  bos.perf.tools 5.2.0.17 Base Performance Tools

AIX 5.3 WebSphere 5.1.1 and | Check that the following packages are installed.
6.0 (The numbers may be these or later file set
numbers.)

* bos.perf.diag_tool 5.2.012 Performance
Diagnostic Tool

* bos.perflibperfstat 5.2.0.10 Performance
Statistics Library

* bos.perf.perfstat 5.2.0.14 Performance Statistics
Interface

* bos.perf.tools 5.2.0.17 Base Performance Tools

Solaris 8 WebSphere 5.0.2.6,
5.0.2.8,5.1.1 and 6.0
WebSphere Portal
5.0.2, WebLogic 7 sp5,
8.1 sp3
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Table 6. Data Collector Requirements (continued)

Platform Application Server Additional Requirements

Solaris 9 WebSphere 5.0.2.6,
5.0.2.8, 5.1.1 and 6.0
WebSphere Portal
5.0.2, WebLogic 7 sp5,
8.1 sp3

HP-UX 11.ivl | WebSphere 5.0.2.6, In order to generate a Java heap dump, you must
5.0.2.8,5.1.1 and 6.0 rebuild the kernel. See [‘Rebuild the HP-UX|
WebLogic 7 sp5,8.1  |[Kernel” on page 115

sp3
Windows 2000 | WebSphere 5.0.2.6,
sp4 5.0.2.8, 5.1.1 and 6.0

WebSphere Portal 5.0.2

Windows 2003 | WebSphere 5.0.2.6,
5.0.2.8,5.1.1 and 6.0
WebSphere Portal 5.0.2

RHEL WebSphere 5.0.2.6,
2.1(Intel) 5.0.2.8, 5.1.1 WebLogic
7 sp5, 8.1 sp3,
WebSphere Portal 5.0.2

RHEL WebSphere 5.1.1,
3.0(Intel) Portal 5.0.2, and 6.0
WebLogic 8.1 sp3

z/Linux SuSe | WebSphere 5.1.1 and
8.1 6.0

Note: WebLogic Application Server with JRockit JVM is not suuported.

Hardware Requirements

Require 200MB of disk space for most installations.

Increase the Heap Size

We recommend you increase the heap size configuration by 64 MB above the
current configuration. To do this follow the steps below for each server that you
want to configure for the data collector:

Go to WebSphere Admin Console and select Servers > Application Servers >
<server name> > Process Definition > Virtual Machine.

Edit the field Maximum Heap Size. If the default is not specified then it assumes
256 so add 320.

For WebLogic: edit your startup script and change the value of the variable
JAVA_OPTIONS (for example, if the default is -ms256m -mx256m then change it to
-ms256m -mx320m).

The WSAM Data Collector also requires some native memory work. Make sure
that your system has sufficient physical memory and page space.
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Required authorization role

The user who installs the Data Collector must have privileges (read, write and
execute) of accessing J2EE Application Server (WebSphere and WebLogic
Application Server).

Note: Root (UNIX-only) or Administrator (Windows-only) privileges are not
required unless your Application Server is owned by root or administrator user.

Cluster Considerations

To install on a cluster, run the installer on each node that you wish to install upon.
It is recommended that you create a response file and use the silent installer mode
if you have to install across multiple nodes in a cluster.
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Chapter 13. Installation and Configuration

This chapter describes how to install the Data Collector for distributed platforms.

The installation procedure uses a graphical installer. Alternately, it is possible to
install the Data Collector manually.

Installing the Data Collector

The following instructions describe how to install the Data Collector onto your
system. Follow the instructions appropriate for the platform and Application
Server.

General Information

1. Data Collector installation can be performed on single or multiple Application
Servers in Network Deployment (ND) or Non-network Deployment
environments.

2. Data collector installation cannot span over multiple nodes.
3. The installer has an interactive (GUI) mode and a non-interactive (silent) mode.

4. If you select a server which has another JVM (-Xrun profile) running on it then
the installation on that server will be skipped.

Installing Data Collectors that Monitor WebSphere

Gather Configuration Information

* WebSphere instance hostname and SOAP port (Default value is 8880, it may be
different for your environment.)

— If using ND, provide the hostname and SOAP port of the Deployment
Manager.

If Global Security is turned on, provide the WebSphere username and password of
a WebSphere user with administrative rights.:

* WebSphere Username
* WebSphere Password

Installation

This section contains instructions to install a Data Collector that monitors
WebSphere on either a UNIX or Windows system. Follow the instructions
appropriate to the platform on which you are installing the Data Collector.

To install the Data Collector on UNIX with WebSphere:
1. Start your J2EE server.

Note: If you are in an ND environment then you must start the following.
* Deployment Manager

* Node Agent

* WebSphere instances to be monitored

2. Log in as a user who has permissions to create the installation directory, for
example: /opt/ibm/wsam/.
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3. Set up WAS_HOME (should point to your local WebSphere Application Server
home directory), JAVA_HOME, and include the Java bin directory in the PATH:

Recommended: Run setupCmdLine.sh (located in the bin directory of
WebSphere installation directory) to set the following variable.

Solaris, HP-UX, AIX, Intel/Linux and z/Linux
For WebSphere 5.x:
WAS_HOME=/opt/WebSphere/AppServer; export WAS HOME
For WebSphere 6.x:

WAS_HOME=/opt/WebSphere/AppServer/profiles/default;
export WAS_HOME

JAVA_HOME=/opt/WebSphere/AppServer/java; export JAVA_HOME
PATH=${JAVA_HOME}/bin:${PATH}; export PATH

Note: To verify this has completed correctly issue the following commands:
echo $WAS_HOME
echo $JAVA_HOME
echo $PATH

and verify the output from the echo command to your inputs.

4. Locate the file MPDClnstall.tar in the installation media. Extract the contents to
a temporary directory:

mkdir /tmp/wsaminst

cp MPDCInstall.tar /tmp/wsaminst
cd /tmp/wsaminst

tar xf MPDCInstall.tar

5. If you want to perform an Interactive (GUI) install go to Step 5a. If you want to
perform a non-Interactive (silent) install go to step 5b.

Note: Do not re-run installer without restoring your original configuration. The
location of the backup of the configuration performed by the installer can be
found in the log file.

a. If running the installation on a remote server, export the display to your
local workstation using the following command:

DISPLAY=<workstation>:0; export DISPLAY

Run installer (You must be in the bin directory of the installer to work
properly.):
cd /tmp/wsaminst/Installer-DC/bin/
sh instal1-DC.sh
b. Create a copy of the sample response file.
cd /tmp/wsaminst/Installer-DC/etc
cp dcInputs_Sample.txt dcInputs.txt

Edit the response file dcInputs.txt. The parameters required are documented
within the text file.

Run the installer in silent mode.
cd /tmp/wsaminst/installer-DC/bin/
sh install-DC.sh -silent ../etc/dcInputs.txt
6. Restart the Application Server on which you installed the Data Collector.

7. Go to the Application Monitor of the Managing Server and configure the Data
Collector you installed.
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Note: Make sure the Application Server type and version, and the operating
system type and version you are using are supported. (If the installation
environment does not meet the prerequisites, the installer prerequisite check will
fail and you will be unable to continue the installation. If you wish to proceed
with the installation, you can bypass the prerequisite check by passing the
parameter "-force” to install-DC.sh.)

Note: The installer will create log files in /tmp/ibm_am_installer_dc/. After
installation, you can find a copy of the logs in the <am_home>/logs directory.

Note: The installer will save your previous WebSphere configuration before
installation. Refer to the log file for the location of the backup.

To install the Data Collector on Windows with WebSphere:
1. Start your J2EE server.

Note: If you are in an ND environment then you must start the following.
* Deployment Manager

* Node Agent

* WebSphere instances to be monitored

2. Log in as a user who has permissions to create the installation directory, for
example: c:\opt\ibm\wsam\.

3. Set up WAS_HOME (should point to your local WebSphere Application Server
home directory), JAVA_HOME, and include the Java bin directory in the PATH,
for example:

Recommended: Run setupCmdLine.bat (located in the bin directory of
WebSphere installation directory) to set the following variable.

For WebSphere 5.x:
set WAS_HOME=c:\Program Files\WebSphere\Appserver
For WebSphere 6.x:

set WAS_HOME=c:\Program
Files\WebSphere\Appserver\profiles\default

set JAVA_HOME=c:\Program Files\WebSphere\Appserver\java
set PATH=%JAVA_HOME%\bin; %PATH%
4. Locate the file MPDClInstall.tar in the installation media. Extract the contents to
a temporary directory:
mkdir c:\temp\wsaminst

Uncompress MPDClnstall.tar into c:\temp\wsaminst.

5. If you want to perform an Interactive (GUI) install go to Step 5a. If you want to
perform a non-Interactive (silent) install go to step 5b.

Note: Do not re-run installer without restoring your original configuration. The
location of the backup of the configuration performed by the installer can be
found in the log file.

a. Run installer:
cd c:\temp\wsaminst\Installer-DC\bin

Note: If you have a multiple IP addresses then edit the file
IPAddress_List.txt and add all the IP addresses including local host IP
separated line by line.

install-DC.bat
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b. Create a copy of the sample response file.
cd c:\temp\wsaminst\Installer-DC\etc
copy dcInputs_Sample.txt dcInputs.txt
Edit the response file dcInputs.txt in the installer bin directory. The
parameters required are documented within the text file.
Run the installer in silent mode.
cd c:\temp\wsaminst\Installer-DC\bin
install-DC.bat -silent ..\etc\dcInputs.txt

Note: Make sure the Application Server type and version, and the operating
system type and version you are using are supported. (If the installation
environment does not meet the prerequisites, the installer prerequisite check
will fail and you will be unable to continue the installation. If you wish to
proceed with the installation, you can bypass the prerequisite check by passing
the parameter "-force” to install-DC.bat.)

Note: The installer will create log file in the <TEMP>\ibm_am_installer_dc
directory, where TEMP is a Windows environment variable. You can locate the
value of TEMP by typing:

echo %TEMP%

After installation, you can find a copy of the logs in the <AM_HOME>\logs
directory.

Note: The installer will save your previous WebSphere configuration before
installation. Refer to the log file for the location of the backup.

6. Restart the Application Server on which you installed the Data Collector.

7. Go to the Application Monitor of the Managing Server and configure the Data
Collector you installed.

Installing Data Collectors that Monitor WebLogic

This section contains instructions to install a Data Collector that monitors
WebLogic on a UNIX system. Follow the instructions appropriate to the platform
on which you are installing the Data Collector.

Note: Servers in a cluster must be started using a Node Manager process. The
installer does not support an environment where servers in a cluster are started
using scripts similar to startManagedWebLogic.sh.

To install the Data Collector on UNIX with WebLogic:
1. Start your J2EE server.

Note: If you are in a managed server environment then you must start the
following.

* Admin Server
* Node Manager
* WebLogic managed instances to be monitored

2. Log in as a user who has permissions to create the installation directory, for
example: /opt/ibm/wsam/. Throughout this section, the directory you create
will be referred to as <AM_HOME>.
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3. Set up WL_HOME (should point to your local WebLogic Application Server
home directory) and JAVA_HOME, and include the Java bin directory in the
PATH, for example:

Recommended: Run setEnv.sh or setEnv.bat (located in the same directory
with start WebLogic scripts) to set the following variable.
WebLogic 7.0 :
WL_HOME=/opt/bea/weblogic70; export WL_HOME
Point JAVA_HOME to the location of the JDK.
PATH=${JAVA_HOME}/bin:${PATH}; export PATH
WebLogic 8.1 :
WL_HOME=/opt/bea/weblogic81l; export WL_HOME
Point JAVA_HOME to the location of the JDK.
PATH=${JAVA HOME}/bin:${PATH}; export PATH

Note: To verify this has completed correctly issue the following command:
echo $WL_HOME

echo $JAVA_HOME

echo $PATH

and verify the output from the echo command to your inputs.

4. Locate the file MPDClnstall.tar in the installation media. Extract the contents
to a temporary directory:

mkdir /tmp/wsaminst

cp MPDCInstall.tar /tmp/wsaminst
cd /tmp/wsaminst

tar xf MPDCInstall.tar

5. If you want to perform an Interactive (GUI) install go to Step 5a. If you want
to perform a non-Interactive (silent) install go to Step 5b.

Note: Do not re-run installer without restoring your original configuration.
The location of the backup of the configuration performed by the installer can
be found in the log file.

a. If running the installation from a remote workstation, export the display to
your local machine using the following command:

DISPLAY=<workstation>:0; export DISPLAY

Run installer (You must be in the bin directory of the installer to work
properly):
cd /tmp/wsaminst/Installer-DC/bin/
sh install-DC.sh
b. Create a copy of the sample response file.
cd /tmp/wsaminst/Installer-DC/etc
cp dcInputs_Sample.txt dcInputs.txt

Edit the response file dcInputs.txt. The parameters required are
documented within the text file.

Run the installer in silent mode.
cd /tmp/wsaminst/installer-DC/bin/
sh install1-DC.sh -silent ../etc/dcInputs.txt

6. Start your server using the startup script and make sure you redirect the
output of the server to the path that you specified during the installation. For
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example, sh startWeblogic.sh >/opt/bea/weblogic/logs/stdout.log (This is the
path that you gave during the installation.)

7. If Application Server is an unmanaged process (Standalone - Single
installation ) then go to <AM_HOME?> /bin/PostInstallationInstructions.txt file
and follow the instructions.

8. Set the following environment variable in
<WL_HOME>/common/bin/commEnv.sh file:

For HP-UX

SHLIB_PATH=<AM HOME>/1ib:$SHLIB PATH

For Linux or Solaris
LD_LIBRARY_PATH=<AM_HOME>/1ib:$LD_LIBRARY_PATH

9. Restart the node manager (only if it is a managed process) and restart the
Application Server on which you installed the Data Collector.

10. Go to the Application Monitor of the Managing Server and configure the Data
Collector you installed.

Note: Make sure the Application Server type and version, and the operating
system type and version you are using are supported. (If the installation
environment does not meet the prerequisites, the installer prerequisite check
will fail and you will be unable to continue the installation. If you wish to
proceed with the installation, you can bypass the prerequisite check by
passing the parameter "-force” to install-DC.sh.)

Note: The installer will create log files in /tmp/ibm_am_installer_dc/. After
installation, you can find a copy of the logs in the <AM_HOME>/logs
directory.

Note: The installer will save your previous WebLogic configuration before
installation. Refer to the log file for the location of the backup.

Note: In a WebLogic managed environment, when the installer runs remotely
to the location of the Admin server, the installer is unable to create a backup
of the local config.xml file for the server(s) where the Data Collector is going
to be installed.

Node Authentication

In Node Authentication related configuration, the Kernel, Data Collectors or Port
Consolidator operate in secure mode either individually or in combination. But the
configuration changes are common for all the modes except that a particular
component can be made to operate in a different mode by changing the property
security.enabled on that particular component.

Kernel Related Changes
In Kernel properties file (kl1.properties and kI2.properties) do the following;:

Note: All the properties are already documented in the appropriate property file.
Just uncommenting the data and giving the right value is recommended.

To enable Kernel to operate in secure mode:

security.enabled=true Only when this property is true along with the above
property, then the CodeBase server will operate in secure mode:
codebase.security.enabled=true
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Data Collector Related Changes
In the Data Collector properties file (datacollector.properties) do the following:

Note: If the Data Collector has already been configured, you must delete the
server generated datacollector.properties file, and then restart the server after
making the following changes.

To enable Data Collector to operate in secure mode: security.enabled=true Define
AM_HOME accordingly. Path of the certificate to use when the Data Collector is in
secure mode: certificate.path=<AM_HOME?>/etc/dctomgmt.cer:
<AM_HOME>/etc/dctoproxy.cer Keystore location of the Data Collector:
keystore.location=<AM_HOME> /etc/CyaneaDCStore Other properties that you
need NOT change and are set by default or should be changed when a specific
situation arises. Keystore password of Data Collector server:
keystore.storepass=oakland94612 Keystore key password of Data Collector server:
keystore.keypass=oakland94612 User ID passed to other end for authentication:
nodeauth.userid=cyaneadc

Node Authentication Related Properties in Port Consolidator
In the Proxy properties file (proxy.properties) do the following:

To enable port consolidator to operate in secure mode: security.enabled=true Path
of the certificate to use when port consolidator is in secure mode:
certificate.path=<AM_HOME>/etc/proxytomgmt.cer:
<AM_HOME->/etc/proxytodc.cer Keystore location of the port consolidator:
keystore.location=<AM_HOME> /etc/CyaneaProxyStore Keystore password of port
consolidator server:

keystore.storepass=oakland94612 Keystore key password of port consolidator
server:

keystore.keypass=oakland94612 User ID passed to other end for authentication:
nodeauth.userid=cyaneaproxy

Node Authentication Related Properties for the Visualization
Engine
Here <AM_HOME> is /opt/ibm/wsam you need to replace accordingly. All the
following properties need to be set as System Properties using AppServer
AdminConsole for WebSphere or in the startWSAM_Weblogic.sh script for
WebLogic. Path of the certificate to use when security is enabled for the VE:
certificate.path=<AM_HOME> /etc/mgmttomgmt.cer Keystore location of the
Management Server: keystore.location=<AM_HOME>/etc/CyaneaMgmtStore
Keystore password of Management Server:
keystore.storepass=cyanea94612 Keystore key password of Management Server:
keystore.keypass=cyanea94612 User ID passed to other end for authentication:
nodeauth.userid=cyaneamgmt

Keystore Managment and Populating Certificates

You do not have to do the following unless you want to create unique certificates
with a new storepass and keypass. These commands will populate a new store
with those certificates.

For populating all new keystores do the following: There are 3 stores used by
WSAM: MSStore, DCStore, ProxyStore.
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MSStore contains:
mgmttomgmt.cer (cn=cyaneamgmt)
dctomgmt.cer (cn=cyaneadc)
proxytomgmt.cer (cn=cyaneaproxy)

DCStore contains:
proxytodc.cer (cn=cyaneaproxy)
mgmttodc.cer (cyaneamgmt)

ProxyStore contains:
mgmttoproxy.cer (cn=cyaneamgmt)
dctoproxy.cer (cn=cyaneadc)

To execute the ./keytool commands, you must be in the java/bin directory. This is
the script with the necessary parameters:

./keytool -genkey -alias <alias name> -keyalg RSA -keysize 1024 -sigalg
MD5withRSA -validity 2000 -keypass <keypass> -keystore ./<storename>
-storepass <storepass> -dname "cn=cyaneamgmt, OU=CyaneaComp, O=Cyanea,
L=0Oakland, ST=CA, C=US"

The following scripts will create all the necessary stores and certificates:

Note: Replace "oakland1” with your custom keypass and "oakland2” with your
custom storepass. Replace "IBMMSStore”, "IBMDCStore”, and "IBMProxyStore”
with your custom store names.

./keytool -genkey -alias mgmttomgmt -keyalg RSA -keysize 1024 -sigalg
MD5withRSA -validity 2000 -keypass oaklandl -keystore ./IBMMSStore -storepass
oakland?2 -dname "cn=cyaneamgmt, OU=CyaneaComp, O=Cyanea, L=0Oakland,
ST=CA, C=US" ./keytool -genkey -alias dctomgmt -keyalg RSA -keysize 1024
-sigalg MD5withRSA -validity 2000 -keypass oakland1l -keystore ./IBMMSStore
-storepass oakland2 -dname "cn=cyaneadc, OU=CyaneaComp, O=Cyanea,
L=0Oakland, ST=CA, C=US" ./keytool -genkey -alias proxytomgmt -keyalg RSA
-keysize 1024 -sigalg MD5withRSA -validity 2000 -keypass oakland1 -keystore
./IBMMSStore -storepass oakland2 -dname "cn=cyaneaproxy, OU=CyaneaComp,
O=Cyanea, L=0Oakland, ST=CA, C=US" ./keytool -genkey -alias proxytodc -keyalg
RSA -keysize 1024 -sigalg MD5withRSA -validity 2000 -keypass oakland1l -keystore
./IBMDCStore -storepass oakland2 -dname "cn=cyaneaproxy, OU=CyaneaComp,
O=Cyanea, L=0Oakland, ST=CA, C=US" ./keytool -genkey -alias mgmttodc -keyalg
RSA -keysize 1024 -sigalg MD5withRSA -validity 2000 -keypass oakland1l -keystore
./IBMDCStore -storepass oakland2 -dname "cn=cyaneamgmt, OU=CyaneaComp,
O=Cyanea, L=0Oakland, ST=CA, C=US" ./keytool -genkey -alias mgmttoproxy
-keyalg RSA -keysize 1024 -sigalg MD5withRSA -validity 2000 -keypass oakland1
-keystore ./IBMProxyStore -storepass oakland2 -dname "cn=cyaneamgmt,
OU=CyaneaComp, O=Cyanea, L=0Oakland, ST=CA, C=US" ./keytool -genkey -alias
dctoproxy -keyalg RSA -keysize 1024 -sigalg MD5withRSA -validity 2000 -keypass
oakland1 -keystore ./IBMProxyStore -storepass oakland2 -dname "cn=cyaneadc,
OU=CyaneaComp, O=Cyanea, L=0Oakland, ST=CA, C=US"

After creating the 3 Stores, extract the certificates with the following command.
This will extract the certificates, thumbprint, and privkey. You are only concerned

with the *.cer files.

Note: You need to be on the Managing Server machine to run this command and
you may also have to export JAVA_HOME and PATH as you did during the
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Managing Server installation.

java -classpath <MS_AM_HOME>/lib/common.jar
com.cyanea.common.security.CynKeyStoreGen <store name> <storepass> <alias
name> <keypass>For example: java -classpath /opt/IBM/wsam/lib/common.jar
com.cyanea.common.security.CynKeyStoreGen ./IBMMSStore oakland2
mgmttomgmt oakland1 After you have extracted your files, copy the certificates
and Stores to the following locations:

<MS_AM_HOME>/etc
MSStore
mgmttoproxy.cer
mgmttomgmt.cer
mgmttodc.cer <DC_HOME>/etc
DCStore

ProxyStore
proxytomgmt.cer
proxytodc.cer
dctoproxy.cer
dctomgmt.cer

Configure components to use new keystores and certificates:

1. Modify <MS_AM_HOME> /bin/setenv.sh. At the end of the script you will
need to modify the following lines with the new keystore name, storepass and
keypass:

KEYSTR_LOC=<AM_HOME_0S>/etc/IBMMSStore
KEYSTR_PASS=oakland2
KEYSTR_KEYPASS=o0aklandl

2. Modfy the VE with the new keystore name, storepass and keypass according to
the steps listed above.

3. Modify <Data Collector Installation Directory>/etc/datacollector.properties file
with the new storename, storepass and keypass.

4. Restart all newly secured components.

Adding MQ Support

To enable MQ monitoring on WebSphere: set the following system property:
am.ext.dirs=<MQ_INSTALL ROOT>/java/1ib
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Chapter 14. Customization

The following provide instructions for customizing your Data Collector.

Rebuild the HP-UX Kernel

The kernel parameters maxdsiz and maxdsiz_64bit limit the data segment size of a
process in HP-UX. In order to generate a Java heap dump, the parameters must be
set to at least 1.6 times the size of the Java heap size in the Application Server.

To configure HP-UX to provide a Java heap dump:

1. Use kmtune to set the parameters maxdsiz and maxdsiz_64bit to at least 1.6
times the size of the Java heap size in the Application Server.

2. Rebuild the kernel.
3. Reboot the node.

Note: Refer to the HP-UX documentation for details on how to configure the
kernel memory parameters.

Configuring Web Servers

In order to monitor Web Servers using the Web Server Overview feature, you must
configure your Web Servers appropriately. This feature is available for Apache and
IBM HTTP servers.

To configure Web Servers to be monitorable by the Web Servers Overview:
1. Edit the httpd.conf file, located in the conf subdirectory of the Web Server
installation directory. For example, in /opt/IBMHTTPServer/conf.
a. Remove comments (#) from the following lines in httpd.conf:

ExtendedStatus On
LoadModule status_module 1ibexec/mod_status.so
AddModule mod_status.c
b. Add the following lines to httpd.conf. Replace <Polling Agent IP Address>
with the domain of the Managing Server:
# configuration for mod_status
<Location /server-status>
SetHandler server-status
Order deny,allow
Deny from all
Allow from all <Polling Agent IP Address>
</Location>

c. Save your changes.

Configuring Your Firewall

Follow the instructions below to configure the firewall between the Data Collector
and the Managing Server.

To configure your firewall:

1. Open the following ports on the firewall from both directions: 9103-9104 9111
9118-9123 9126 9129. (Assuming you used the default settings.)
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2. Update the datacollector.properties file (on the maching running the Data
Collector). This is typically located at /opt/ibm/wsam/etc (the installation

directory):
probe.rmi.port=8300

probe.controller.rmi.port=8200

3. If there is more than one Data Collector installed on a node, you must open a
port for each Data Collector in both ranges starting from 8200 and 8300. Then
assign unique values for each in the respective datacollector.properties files.

Note: You can use the optional component, Port Consolidator, to minimize the

number of ports required.

Parameters Specified with Multiple Network Cards

To install multiple network cards: Make sure that the IP specified for the Data
Collector server are IPs that can be used to communicate with each other (i.e if
there is a network config where one of the IPs does not have a path to the other

box, don’t use that IP).

1. On the Data Collector machines, define an additional Java system property and
set it to the IP address of the Data Collector:

java.rmi.server.hostname

2. On the Data Collector machine, in the
$AM_HOME/etc/datacollector.properties file change the kernel.codebase and
kernel.rfs.address to point to the Managing Server IP. If there are any generated
datacollector property files (these have names like
datacollector.properties.<appservername>... or
<hostname>.<appservername>.datacollector.properties....,) you will need to
remove those. They will be regenerated when the Data Collector starts.

Nested Requests

For WebSphere, we support the following nested requests:

Functions

Servlet was<VERSION>_servlet.xml

EJB was<VERSION>_ejb.xml

JDBC was<VERSION>_jdbc.xml

JCA was<VERSION>_jca.xml

JNDI was<VERSION>_jndi.xml

JMS was<VERSION>_jmst.xml, was<VERSION>_jmsq.xml
MQI was<VERSION>_jbsmgi.xml

To disable a nested requests, rename or remove the corresponding xml files from
<AM_HOME>/etc directory. For example, to disable JMS nested requests for
websphere 511, remove was51_jmst.xml and was51_jmsqg.xml

For WebLogic, we support the following nested requests:

Functions
Servlet wls<VERSION>_servlet.xml
EJB wls<VERSION>_ejb.xml
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Functions

JDBC wls<VERSION>_jdbc.xml
JMS wls<VERSION>_jms.xml

JNDI wls<VERSION>_jndi.xml

To disable a nested requests, rename or remove the corresponding xml files from
<AM_HOME>/etc directory.

For WebSphere portal, we support the following nested requests:

Functions

Portal page wps<VERSION>_page.xml

Portlet wps<VERSION>_portlet.xml
Authentication wps<VERSION>_login.xml
Authorization wps<VERSION>_authorization.xml
Credential Vault wps<VERSION>_credentialvault.xml
Content Access wps<VERSION>_contentaccess.xml

To disable a nested requests, rename or remove the corresponding xml files from
<AM_HOME>/etc directory.

For JDBC Adapter, we support the following nested requests:

Functions

JDBC pool resource whbi_jdbc_pool.xml
JDBC whbi_jdbc_sql.xml
Requests whbi_jdbc_requests.xml
MQI wbi_mgqi.xml
Serialization whbi_serialize.xml

To disable a nested requests, rename or remove the corresponding xml files from
<AM_HOME>/etc directory.

Controlling Instrumentation of Application Classes for Heap, Lock and
L3 Method Analysis

WSAM uses a technique called Byte Code Instrumentation to collect Level 3
tracing data, Heap Analysis data, and Lock Contention data from your
applications. BCI is controlled by the contents of the

<AM_HOME> /etc/cyn.user.classes.xml file. This file can be modified in order to
increase or decrease the scope of instrumentation for Heap, Lock, and Method
entry and exit analysis.

1. The definelnstrumentation tag defines two broad categories of instrumentation:
user class instrumentation for your homegrown J2EE applications and system
class instrumentation for Application Server (WAS or WLS) infrastructure
classes.

2. Multiple selectClass tags can be specified within a userClasses tag or a
systemClass tag.
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3. The enableSignatures tag indicates whether or not the method signature should
be included in the Method Entry and Exit tracing.

4. The mask tag defines a class mask that identifies the classes that should be
instrumented for Heap, Lock and Method Entry and Exit analysis. The class
mask can contain *” and "?” wildcard characters. For example, the following
mask can be used to instrument all classes in the my.company package:
<mask>my.company.*</mask>

5. The methods tag (and the inner methodName tags) determine which methods
should be instrumented for Method Entry and Exit. There may be multiple
methodName tags specified. Each tag specifies a mask optionally containing "*’
and "?” wildcard characters. For example, the following masks can be used to
instrument all methods that contain ‘execute” and 'doTask’ in their names:

<methods>
<methodName>*execute*</methodName>
<methodName>*doTask*</methodName>
</methods>

6. The ignoreTrivial tag determines whether or not methods should be
instrumented if they are considered ‘trivial’.

7. The objectAllocations tag and inner allocateClass tags define one or more class
masks that identify the instantiated classes for which heap allocations are to be
instrumented. Each class mask can contain " and "?” wildcard characters. For
example, the following configuration can be used to instrument two collection
classes that are allocated by your application classes:
<objectAllocations>

<allocateClass>java.util.Hashtable</allocateClass>
<allocateClass>java.util.HashMap</allocateClass>
</objectAllocations>

8. The objectAllocationTimes tag specifies whether or not heap allocations should
be modified so that events representing heap allocations appear in the Level 3
trace, while duration associated with heap allocations can be measured.

9. The lockAnalysis tag indicates whether or not the class should be instrumented
for the Lock Analysis feature.

The default cyn.user.classes.xml file enables instrumentation for method entry and
exit (level 3 tracing) for all application classes, but disables instrumentation for
heap and lock analysis.

Another file is provided, with the name cyn.dev.user.classes.xml, which enables
instrumentation for heap and lock analysis, as well as level 3 method entry and
exit tracing.

The name of the file that is used to control instrumentation is specified by the
‘userbcm.xmlfilename’ property, in the appropriate bcm.properties file. By
changing the value of this property, you can indicate that a different XML file be
used.

Note: If the cyn.user.classes.xml or cyn.dev.user.classes.xml files are modified to
include or exclude some user classes for Heap, Lock or L3 method entry and exit,
WebSphere and WebLogic Application Servers will need to be recycled in order for
the changes to take effect.
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Setting up 3.1 Data Collector with a 3.2 Managing Server

Follow the instructions below:

1. Install 3.2 Managing Server.

2. Copy lib3.1 directory from the old 3.1 Managing Server installation directory to
<AM_HOME>.

3. Restart all the Data Collectors.

Setting up Heap Analysis

The Sun JDKs have this feature disabled by default. To enable it, set
internal.doheapdump=true in the Data Collector properties file. Then restart the

server.

Note: Enabling this feature may have unexpected consequences to your Sun JDK

server.

Adding Garbage Collection Interval Support

The Data Collector communicates with the Managing Server using TCPIP sockets
and RMI. One effect of using RMI is that garbage collection occurs every minute. If
you don’t want this to happen, you can specify the garbage collection interval
explicitly to a preferred interval by specifying the parameters in the Generic JVM
arguments field. These parameters must be implemented as a pair.

1. Login to the WebSphere Admin Console.

2. Navigate as follows:

a.
b.

Select the Servers > Application Servers and select the <ServerName>.

Navigate to the Additional Properties: Process Definition > Servant >
Additional Properties: Java Virtual machine.

In the Generic JVM arguments field, append the following parameters if
such parameters don’t exist or simply update the interval values if they
already exist.

-Dsun.rmi.dgc.client.gcInterval=3600000
-Dsun.rmi.dgc.server.gcInterval=3600000

Note: These values require a dash (-) in front of each parameter, and a

single space between parameters. Also, we recommend the interval value =
or > than 3600000.
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Chapter 15. Troubleshooting

Out of Memory Error

If out of memory errors occur while you are using L3 and hotspot JVM, follow the
instructions below.

The default NewSize and MaxNewSize might be small for some Applications if the
Application is allocating large numbers of short living objects.

Some tuning we recommend for an application that allocates many short living
objects:

-XX:+DisableExplicitGC -XX:NewSize=128m -XX:MaxNewSize=256m -Xconcurrentio

Note: NewSize and MaxNewSize should be changed based on the Maximum and
Minimum heap settings of the JVM.

No/partial list of servers shown during the installation

During the installation, after selecting a node if no servers show on the server
selection panel, then follow the instructions below:

Click the Back button and without any changes click the Next button again. If you

still don’t see the all servers then select one of the servers and add it and then
remove it again.
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Chapter 16. Uninstalling the Distributed Data Collector

These instructions describe how to disable and uninstall the Data Collector. The
instructions vary based on the Application Server and platform.

Disable

The following instructions describe how to disable the Data Collector.

Disabling Data Collectors for WebSphere

Follow the instructions appropriate for the platform on which you would like to
disable the Data Collectors for WebSphere.

To disable the Data Collector for WebSphere on AIX, Solaris, Linux, HP-UX or
Windows:

Prior to starting the disable process, stop the Data Collector.

Open the WebSphere Administrative Console.

Click the + sign until you ungroup the Application Servers directory.
Select the server where the Administrator installed the Data Collector.

o kw0

For WAS 5.x, select Custom Services and highlight AM Custom Services. For
WAS 6.x, go to Server Infrastructure > Administration > Custom Services and
highlight AM Custom Services.

Click Edit.
Uncheck the Enabled box or change the server startup value to False.
Click OK and click Apply.

For WebSphere 5.x, go back to Process Definition > Java Virtual Machine. For
WebSphere 6.x, go back to Server Infrastructure > Process Definition > Java
Virtual Machine.

10. In the Generic JVM Arguments field remove:

© o N

-Xrunam

11. Click OK and click Apply.

To remove associated files:

1. Go to the WebSphere installation directory:
2. Go JVM Advance properties.

3. Remove -xbootclasspath.

4. Start WebSphere.

Disabling Data Collectors for WebLogic

Perform these instructions to disable the Data Collector for WebLogic.

To disable the Data Collector for WebLogic:

1. In the WebLogic startup script (if you are using standalone server) or in server
> remote start > arguments ( if you are using network deployment) remove the
following argument:

-Xrunam
2. In current.env, comment out or remove the JAVA_OPTIONS parameters.
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3. Restart the control region.
4. Restart the WebLogic server.

Uninstalling the Data Collectors

Perform these instructions to uninstall the Data Collector.

To uninstall the Data Collector:

1. Disable the Data Collector, as described in |“Disabling Data Collectors for|
WebSphere” on page 123|or [“Disabling Data Collectors for WebLogic” on page

123

2. Remove the installed files.

3. Undo the WebSphere configuration changes as described in Appendix D.

Note: For WebSphere, run the script restoreConfig.sh/restoreConfig.bat located in
the bin directory and pass backup config file (located in
<AM_HOME>/logs/ibm_am_installer_dc) as an argument. This will restore the
original configuration. For WebLogic, replace config.xml file with a backup config
file (located in <AM_HOME>/logs/ibm_am_installer_dc).

Note: No backup is done for remote network deployment.
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Part 5. Appendixes
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Appendix A. IBM Tivoli Enterprise Console Integration

Overview

The Application Monitor for Tivoli Enterprise Console® is the integration of the
Application Monitor services with Tivoli Enterprise Console 3.8.

Requirements for Integrating with Tivoli Enterprise Console

The Application Monitor supports the following Tivoli® server platforms:
* Microsoft® Windows Server

* Sun Solaris

+ IBM AIX

* HP-UX

The following Tivoli software is required:
* Tivoli Framework 3.7.1 or greater

* Tivoli Enterprise Console Server 3.8

¢ Tivoli Enterprise Console Ul Server 3.8

* Tivoli Enterprise Console Console 3.8

One of the following Tivoli software components are required:
« Tivoli Enterprise Console 3.8 non-TME® SNMP Adapter
¢ Tivoli Enterprise Console 3.8 Adapter Configuration Facility

You should identify one system as the SNMP Adapter host, which accepts SNMP
traps from the Application Monitor, adapts them to Tivoli Enterprise Console
Events and forwards them to a Tivoli Enterprise Console Server. The supported
platforms for the SNMP Adapter host are the same as for the Tivoli server. To
avoid interference, it is recommended that the system running the SNMP Adapter
not run any other SNMP agent on the same UDP port.

Configuring Tivoli Enterprise Console

Summary

The Application Monitor for Tivoli Enterprise Console provides configurations for
Tivoli Enterprise Console Server, Tivoli Enterprise Console, and Tivoli Enterprise
Console SNMP Adapter that allow alerts from the Application Monitor to appear
in the Tivoli Enterprise Console console.

The Application Monitor for Tivoli Enterprise Console is available as a CD-ROM
under the directory Tivolilntegration/tec. Copy the files to location(s) accessible by
the Tivoli Enterprise Console server, one Tivoli Enterprise Console console and
SNMP Adapter host.

Configuring the Tivoli Enterprise Console Server

The Application Monitor events are described for Tivoli Enterprise Console in
am.baroc. To install this file, open a command prompt or shell with Tivoli paths
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and environment set, change directories to the Application Monitor for Tivoli
Enterprise Console media, and type the following:

sh am_setup_tec.sh SourceRuleBaseName NewRuleBaseName NewRuleBasePath

SourceRuleBaseName is the name of your current rule base. For new installations of
Tivoli Enterprise Console, this is named “Default.”

NewRuleBaseName is the name of a new rule base to create. “AM” is recommended.

NewRuleBasePath is the name of a new directory where the rule base will be stored.
An example is “/usr/tec/am.” Windows users: be sure to use forward slashes in
pathnames.

Upon successful completion, the am rulebase will accept the Application Monitor
events.

Configuring the Tivoli Enterprise Console Console

The Application Monitor for Tivoli Enterprise Console includes a configuration file
that can be imported into the Tivoli Enterprise Console console to define the
Application Monitor event group and filter.

1. Open the Tivoli Enterprise Console, login as required.

Tivoh Management Environment 3¢ I

Host Machine: tivoli
Login As: Username
Password: .

oK Cancel

Figure 3. Login

2. Select Windows > Configuration.
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— IBM Tivoli Enterprise Console - Configuration =10 x|

Tivoli

[Conors o commsocontewntin |

Event Groups

Event Groups Consoles

Consoles Operators
£3 Operators

Figure 4. Configuration

3. Select File > Import.

< Import Xl

— 1 |

[

| |

Figure 5. Import

4. Click Browse to select the file am_event_group.cfg.
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Look in: 1 am-tivoli

- o @ o B

E‘| am.haroc
E‘| am.cos
E‘| am.oid
E‘| am.rls

E‘| am_config_tecad_snmp.sh
E‘| am_event_group.cfg
E‘| am_setup_tec.sh

File name: | | | Select |
Files of tyne: | All Files (%) v| | cancel |
Figure 6. Select
5. Click Select.
= Import
File Hame
|Cam-tivaliam_event_group.cfg || Browse.. |
Consoles Event Groups Operators

An

EIlE]

Conflict Strategy

Use Existing -

| oKk | cancel | Hemp |

Figure 7. Import

6. Select AM in the center pane and click OK.

[EC02039I: The TEC Console must be shut down and restarted for
0 he changes to take place.

Figure 8. Notice

7. Click OK and restart the Tivoli Enterprise Console.
8. Click on Event Groups to see the new AM Event Group.
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— ' IB™ Tivoli Enterprise Console - Configuration

File Edit Windows Help

Event Console Configuration Contents of: BEvent Groups

"= Event Consale Configuration || A

@ (= Event Graups Al
@ [ Consales SMMP

Operatars

Ready =

Figure 9. IBM Tivoli Enterprise Console Configuration

9. To use the AM event group, assign it to a console. See Tivoli Enterprise
Console User’s Guide for instructions. The operators for that console will now
see AM in their summary chart view and event viewer.
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Figure 10. IBM Tivoli Enterprise Console

= Ewent ¥iewer: Group AM - Limit to AM SNMP traps
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Figure 11. Event Viewer

10. Tivoli Enterprise Console is now configured.
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Installing and Configuring the Tivoli Enterprise Console SNMP
Adapter

As noted in the Requirements section, there are two choices for Tivoli Enterprise
Console SNMP Adapter: non-TME and Adapter Configuration Facility (ACF)
versions. The non-TME version is a standalone installation, and the ACF version
can be deployed remotely using the Tivoli Desktop. The following sections describe
the steps required for each. Do not install both on the same system, as conflicts can
occur.

Installing and Configuring Tivoli Enterprise Console SNMP
Adapter for non-TME

Instructions for installing the non-TME version are found in the Tivoli Enterprise
Console Adapters Guide, see the following website

http:/ /publib.boulder.ibm.com/infocenter/tiv3help /index.jsp?toc=
/com.ibm.itec.doc_3.9/toc.xml. Follow Tivoli’s instructions to install the non-TME
SNMP Adapter on any of the supported platforms.

To configure, open a command prompt or shell, change the current directory to the
location of the Application Monitor for Tivoli Enterprise Console files, and type the
following:

sh am_config_tecad_snmp.sh pathname

Pathname is optional. It specifies the directory name containing the SNMP Adapter.
The script will look in a few default locations, and exit with a warning message if
the Adapter files and directory cannot be found.

Note this script will only work on UNIX systems and Windows systems with a
Bourne shell prompt (such as Tivoli managed node). If you are configuring a
Windows system without access to a Bourne shell, do the following steps from a
command prompt:

net stop TECSNMPAdapter

copy am.cds c:\tecsnmp\etc
copy am.oid c:\tecsnmp\etc
c:

cd \tecsnmp\etc

copy tecad_snmp.cds+am.cds
copy tecad_snmp.oid+am.oid
net start TECSNMPAdapter

Installing and Configuring the Tivoli Enterprise Console SNMP
Adapter for ACF
Screen by screen instructions for deploying and configuring a new ACF adapter
are shown. These instructions assume that the adapter will only support the

Application Monitor traps and events. Support for other traps requires manually
appending the tecad_snmp.cds and tecad_snmp.oid files (not shown).

How to deploy the Application Monitor SNMP Adapter configuration and Tivoli
Enterprise Console SNMP Adapter using Tivoli Enterprise Console Adapter
Configuration Facility:

Dependencies: Framework 3.7.1 or greater, endpoint, Tivoli Enterprise Console 3.8,
Tivoli Enterprise Console ACF 3.8 installed.

1. Click Create > Region.
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*Z§ Create Policy Region Hi=] B3

Create a new Policy Region

Marne: |Aru1| |

Create & Close Create Close Help
| Y

Figure 12. Create Region

2. Enter a name for the Policy Region, and click Create & Close.

":_ TME Desktop for Administrator Root_gaappwins04-region {QAAPP-WIN-504' Administrato... [l[=] [E3
Desktop  Edit  Miew Create Help

a2 @ ¢

Administrators Motices EventServer A

fir g ao

TEC-Region gaappwins0d-region EndpointManager Scheduler

Find Nest | Find Al | |

Figure 13. TME Desktop for Administrator Root

3. Double-click on the Policy Region to open it.
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Properties  Help

Find Nest | Find Al | |

Figure 14. Policy Region AM

4. Select Properties > Managed Resources.

™ Set Managed Resources

M[=] E3
Faolicy Region: A
Current Resources: Available Resources:
ACP Endpoint [
ProfileManager Managediode
NetlareManaged3ite b
PcHManagedilode ~

BEEl ] BEBHL ]

Set & Close Set

Close Help

Figure 15. Set Managed Resources

5. Move ACP and ProfileManager to the left-hand side and click Set & Close.
6. Select Create > ProfileManager.
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lg Create a Mew Profile Manager
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MHamellcon Label: |Aru1

‘Dataless Endpoint Mode i

Create & Close Create Close Help
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Figure 16. Create Profile Manager

7. Enter a name, and click the Dataless Endpoint Mode checkbox. Click Create &
Close.

* policy Region: AM

Region Edit Wew Create Properties Help

o0

2

A

Find Nest | Find Al | | |

Figure 17. Policy Region AM

8. Double-click to open the Profile.
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+z Profile Manager

Figure 18. Profile Manager

9. Select Profiles > Subscribers.
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Figure 19. Subscribers

10. Move the desired endpoint (to receive the SNMP adapter) to the left-hand side
and click Set Subscriptions & Close.
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Figure 20. Profile Manager

11. Select Create > Profile.
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1
EE in Profile Manager: Al
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Type:
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| V-

Figure 21. Create Profile

12. Enter a name, select ACP, and click Create & Close.
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Figure 22. Profile Manager

13. Double-click to open the profile.
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Figure 23. Adapter Configuration Profile

14. Click Add Entry.

# Add Adapter Configurs =10 x|

Select Type For New Adapter
Profile Cyanea

tecad logfile_sequent -
tecad logfile_solaris2

tecad logfile_solaris2-ixdé
tecad logfile uwZ-ix86
tecad_nt
tecad snm

tecad win

|

Select & Close Cancel Help

( 4

Figure 24. Add Adapter Configuration

15. Scroll down, select tecad_snmp, and click Select & Close.
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Figure 25. Edit Adapter

16. Select Environment.
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¥ Edit Adapter 0, Profile

@

Ef,r_anei___ N ] ‘_Lnlzl
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Figure 26. Edit Adapter
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17. Double-click on ServerPort in the left-hand pane. Enter the desired Tivoli
Enterprise Console port number (usually 5529 for Windows Tivoli Enterprise
Console Server, or 0 for a UNIX Tivoli Enterprise Console Server), and click

the checkmark button to accept the change. The entry will display in the
right-hand pane.
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Figure 27. Edit Adapter

18. Select Distribution.
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@
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Files To Be Distributed
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Figure 28. Edit Adapter

19. The .cds file and .0id file should be changed to include the am traps. There

are two choices:
* Support both the Application Monitor traps and standard traps. You must

manually append the Tivoli supplied files with the Application Monitor
files. They are ASCII, so use your favorite editor and/or command line
tools. Then follow the directions below.

* Replace with the Application Monitor files, to only support the Application

Monitor traps. Follow the directions as listed below.

20. Double-click on the tecad_snmp.cds entry.

146  Application Monitor: Installation and Customization



7 Edit Adapter 0, Profile Cyanea i =101 x|

Edit Adapter Configuration
Type tecad_snmp, Profile Cyanea

Adapter Type: tecad_snmp
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Figure 29. Edit Adapter

21. Click on the Browse button associated with the right-hand pathname.
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Choose Source Host & Pathname

File Name Filter:
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Hosts: Directories: Files:
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Path Name:

[D | [setpan|

Set&CInseI setl [close|] [Help

| 4

Figure 30. Select File

22. Browse to the location of am.cds. Select the file, and click Set & Close.
23. Click the checkmark button to accept the change, as shown in the lower pane.
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Remo es
tecad_snmp.cds || | tivoli:Dicyanea.cds

tecad_snmp.cds=tivoli:D:/cyanea.cds
tecad_snup.err=tivoli:C:/Tivoli/bin/generic_unix/THE/ACF_REP/tecad snmp.err
tecad_snmp.oid=tivoli:C:/Tivoli/bin/generic_unix/TME/ACF_REP/tecad_snmp.oid

Figure 31. Edit Adapter

24. Repeat the steps to change the right-hand value of tecad_snmp.oid to point to
am.oid.
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Figure 32. Edit Adapter

25. Click Save & Close.
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Figure 33. Adapter Configuration Profile

26. Close the profile.

27. Distribute the profile (ex. drag the profile on top of the endpoint.) The main

window of the desktop shows a log of actions.
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Figure 34. TME Desktop for Administrator Root_Tivoli-region

28. The adapter is configured, distributed, and running.

Using the Application Monitor for Tivoli Enterprise Console

Configure the Application Monitor agent to send SNMP traps to the configured
Application Monitor SNMP Adapter host, and the Application Monitor events will
show up in the Tivoli Enterprise Console.

- Event Viewer: Group Cyanea - . "lm Xl

File Edit Options Selected Automated Tasks Help

Working Queus
B am S%vE = Toat: 4 Selcto:
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May 8, 2003 6:48:31 PMPOT bncasla:lbs fivoli [Critical  [SLE4]
May 9, 2003 6:48:31 PMPOT ksl ail ke fivoli Crifical  [olg
May 9, 2003 6:48:31 PMPDT bvaslacl e K tivoli HammlEss " Open "ET WG u zm3le.
May 9, 2003 6:48:31 PMPDT In=smsmn: al'g thwoli Kemzlz 212 s=tont Sl za g,
May 9, 2003 6:48:31 PMPDT Inv®zmomarn: €0 ca gl K tivali Kemzlz 21z Se o £l zal..
May 9, 2003 6:48:31 PMPOT knwcssla:l eZmermng tivoli wriaRzeclGra.
May 9, 2003 6:48:31 PMPOT krwcsslacl bsZTermng 0 tivoli SET WG~ iu =m3le.
Way 9, 2003 6:48:31 PMPDT BRSe: s T tivoli
May 9, 2003 6:48:31 PMPDT FnSu-ImcFolu - tivoli E=T e uolm: S cnMoszaie i
May 9, 2003 6:48:31 PMPDT ezl tivali Warmning Open Tz 20k ezl
May 9, 2003 6:48:31 PMPDT bnclznl tivoli Critical Open Teedgdzisul SET WG Seizne Dhomgss13
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| . Acknowledge

| Close || Details |

Information

Figure 35. Event Viewer

Click on an event and choose Details for more information.
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Appendix B. BMC Patrol Integration

Overview
The Application Monitor for Patrol Enterprise Manager is the integration of the
Application Monitor services with BMC'’s Patrol Enterprise Manager (Patrol EM).
The Application Monitor for Patrol EM consists of two components: a customized
Patrol EM filter (AM.afltr) and an application that receives AM SNMP traps
(AMSNMPAdapter).

Requirements

The following BMC server platforms are supported by the Application Monitor:
* Sun Solaris

« IBM AIX

s HP-UX

The following BMC Patrol EM software is required:
* Patrol Enterprise Manager 4.2 or later

The following Patrol EM software is required:
e Multi-Listener - PEM TCP/IP multi-listener daemon

One system should be identified as the AM SNMP Adapter host, to accept the
Application Monitor SNMP traps, adapt them to Patrol EM Events and forward
them to a Patrol EM Server. The supported platforms for this system are:

* Windows 2000

* Sun Solaris

+ IBM AIX

* HP-UX
For the recommended configuration, this system should no be running any other
SNMP agent on UDP port 162 that would interfere with running the AM SNMP

Adapter. This system should also have the Java™ runtime version 1.3 (JRE 1.3) or
later installed.

Configuring BMC Patrol

The Application Monitor for Patrol Enterprise Manager provides a customized
filter for Patrol EM and the AM SNMP Adapter to have alerts from the Application
Monitor appear in the Patrol EM Active Alert Display.

The Application Monitor for Patrol Enterprise Manager is available from IBM on
CD-ROM, or as am.tar, or am.zip. The Application Monitor for Patrol EM consists
of the following files:

* amfilter.tar

* AMTrapReceiver.jar

¢ am.conf

¢ amSnmpAdapter.sh (for Unix systems)

* amSnmpAdapter.bat (for Windows systems)
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Once these files have been extracted from the CD, tar file, or zip file, copy the files
to location(s) accessible by the Patrol EM server and the AM SNMP Adapter host.

Configuring Patrol EM Server

The AM events are described for Patrol EM in the filter file AM.afltr. Installing and
configuring this filter consists of the following steps:

* Generating the AM filter engine
* Defining the AM filter path

The Multi-Listener - PEM TCP/IP multi-listener daemon must be installed and
configured before executing the following steps. Follow the instructions provided
in the Multi-Listener documentation to specify a socket number that the filter path
will be monitoring.

Generatin
1.
2.

g the AM Filter Engine

Login to the Patrol EM server as user NetCmmnd.

Extract the contents of the file amfilter.tar:

tar xvf amfilter.tar

Using the Patrol M Console, generate the AM filter engine.
Select Customization > ALFE.

||~ NetCnnnd (supervisors) PATROL EM 4.2|
I Applications  Wtilities  Customization | AdminJ

ALFE

pfinfes

I£Path
AAD Chart Log o

Definition J

of custamizatio

o

. . : A0 EXEC Installer “_
|l TSR g Trigger Builder
I DEI Control J
Extraction Builder
Map Builder

One-to- One
Report Builder
Threshold Builder

Control

Figure 36. Path Definition

5. Select NetCmmnd.fltr.

NetCnnnd {zupervizors} PATROL EH 4.2
I Applications  Utilities  Customization | Admin “

7]

o) I By &5 ]

AAD  Chart Log Query M
This option displays a
[|. ption display

of customization options.

HetCmmnd.flitr

Figure 37. Select Filter

6. The ALFE dialog window displays with the NetCmmnd filter loaded.
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Figure 38. ALFE Netcmmnd

7. Select File > Load Text Filter, then select AM.afltr.
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Figure 39. Select Load Text Filter

8. The ALFE dialog window displays with the AM filter loaded.
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Figure 40. AM Filter

9. Select Generate > Generate Production Filter.
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Figure 41. Generate Production Filter

displays in the Prompter box.

10.
Prompter
Status Message: S
Filter engine generated
Figure 42. Prompter box
11.

Select File > Save.
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Figure 43. Save Filter

12. After the system saves the filter the message "/home/u/NetCmmnd/AM fltr

saved” displays in the Prompter box. Close the ALFE window.

Defining the AM Filter Path
1. Using the Patrol M Console, define the AM filter path.
2. Select Customization > Path Definition.
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||~ NetCnnnd (supervisors) PATROL EN d.2| -
I Applications  Wilities  Customization | AdminJ

@ ﬂ/ Iﬁ I‘:::: Definition

S Chigen 1og & AO EXEC Installer |

- This option disg 4 ;
|. of custamizatio i AR
DBI Control
Extraction Builder

=

L

Map Builder
OV Control
One-to- One
Report Builder
Threshold Builder

Figure 44. Path Definition

3. The Path Definition dialog window opens.

Path Definition B
Path  Ulilities
aget
I L—bi
Hone
Access Port l .—pi
Connection Mar, Filter
Path Hame Transformers Path Type
[ | Add Transfonmer | Copy Transfonmer Filter Emulator APIEmulator
h—
Path Prototype © ._i_'. \/‘_’D v‘—l—r’%
I Cut Transformer | Paste Transformer | — —]
Available Attributes Altribute Descriplion efined Atthibutes

=1 =

Attribute Details

[ -

AddfReplace == |

Delete

) ﬂ kdove cursor over an item for help infarmation

Figure 45. Path Definition Dialog box

4. To create the AM path, select Path > New.
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Path Definition
th | Utilities
Hew | S——
Get from DB ... I‘ ;
save to DB . EHD
Delete from DB fetion Mgr, Filter
Restore Path Hame
- Path Type
‘ Exit
= Add Transformer | Copy Transformer Filter Emulator APIEmulator
h—
Path Prototyp S o —]
| ‘ cut | Paste | — =

Figure 46. Create AM Path

5. Enter "AM" for the path name.

Path Definition

Path  Ulilities
aget
" | 5
one
Access Port i ) Ly |
Gonnection Mgr. Fiter
Path Name Path Type
( i) X | Add Transformer | Copy Transformer Filler Emulator APIEmulator
h—
Path Prototype e 1] v(—)D i
( I | Cut Transformer | Paste Tl—ansl'ﬂmlex'| — =

Figure 47. Enter AM Path Name

Path  Utilities

6. Left-click on the Filter icon and select multi_lstn for the Path Prototype.

Path Definition

=

aget
I -—Iu i
Hone o
Access Port m—, multi_lstn
Gonnection Myr. Filer  pemsdk_listen
| ST b 1" .
Path Hame Path Type s2p_Istn
{ r‘w ‘ Add Transformer | Copy Transformer | Filter Emulator
h—
Path yp e * v«—D vt—._r‘%
I ‘ cut | Fasle fi | — =

Figure 48. Path Prototype

7. The multi-Istn path prototype defines the path attributes.
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Path Definition
Path  Utilities
multiListener nulti_Isti
I L—bi
I
1 n—i |
Connection Mgr. Filter
Path Name Transformers r Path Type
I CYANES fAudd Transformer | Copy Transformer | Filter Emulator APIEmMulator
—
Path Prototype < ._§_" \/‘_’|[ v‘—l—r’%
I EITRET Cut Transformer | Paste Transformer | — ==
Availahle Attributes Atiribute Description efined Atthbutes
™ A A
URM file size
URM filename |
' |
Attribute Details
Add/Replace ==|
Delete |
S T . 1

r This area lists the attributes associated with the icon selected at the top. The color red is used for attributes that are required and are still undefined.
ﬂ You cannot save a path that contains undefined required attributes. Yalues of attributes can be modified with inputs in the Attributes Details pane.

Figure 49. Path Attributes

Set the required path attributes to the following values: Autostart = true; Filter
= AM; Host ID = name of your Patrol EM server; The attributes "URM files
size” and "URM filename” are optional.

Attribute values are set by selecting the attribute in the Available Attributes
box, typing in or selecting the desired value in the Attribute Details box, then
selecting the Add/Replace button. The completed path definition displays in
the Path Definition dialog window.
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Autostart K Autostart: E
Filter
t
Host Id - .rue
URM file size i
URM filename
Host Id:
syrah
URM file size:
10000
Attribute Details .
AddMeplace —-| | URM filename:
arn.urm

-1,

rH|

Figure 50. Path Definition

10. Select Path > Save to DB.

Path Definition 0

Path | Utiiities

News — o

Gett o8 jstener AM

et from DB ... .

Save to DB EHD
4 i

Delete from DB tion Mar, Filter

Restore Path Name

Path Type

| Enit )
|—r autd Transtormor | copy transtonmer ||| | Filter Emulator APIEmulator

Figure 51. Save to database

[E—

| Update Configuration NOW?

Ell_l

11.

Figure 52. Update Configuration

Select Yes to update the configuration.

The text field displays the values of the attributes defined for the icon selected at the fop. This area cannot e edited. Select attributes under the
Available Attribute region to modify attributes

12. Exit from the Path Definition dialog window.

13. Using the Patrol EM Console, obtain the configuration: Select Admin >

Obtain Configuration.

Appendix B. BMC Patrol Integration

163



I'-Iet[Znnnd {supervisors) PATROL EH 4,2
Applications  Utilities  Customization Admin ||

T & ﬂ’ E | ﬁ Access Port Definition
@ | | | | §+L Alert Suppression
AAD  Chart Log Query Map Rep' gihorization Mgmt
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Permission Mgmt

Time Zone Mgmt
User Mgmt

Configuration Reports
Misc Configuration
Obtain Configuration
Update Configuration
Database Backup

Event Handler Monitor

Update Devices
Update Services

Cave

Figure 53. Obtain Configuration

14. Verify that the AM filter path is running by selecting FIlter Path Mgmt from
the Patrol EM Console’s Admin menu. The Filter Path Management dialog
window displays. The AM path should be listed in the Active Filter Paths

box.
= Filter Path Hanagenent EiE]
[ Inactive Filter Path: rActive Filter Path:
peEe Tk e SRR K Path HostID | Fitter Connection S
| MULTILSTN | syran MULTI_LSTN o syrah  |AM
| s2P_LSTH syrah S2P_LSTH T | NetCmmnd syrah MetCmmnd loghost agce4100
<== Stop
. L N L
Edit Path Stop, Start | Start Trace... Stop Trace
By
Close Path | Host ID | Filter | Connection |
M Select a path or a set of paths and press the Start or Stop button. Only inactive paths can be stated and only active paths can be stopped. To resize a column,
7] grab the left or right edge of the hox containing the column header using the lefl mouse button and resize to the desired width when the double arrow appears

Figure 54. Filter Path Management

Installing and Configuring the AM SNMP Adapter

As noted in the Requirements section, the AM SNMP Adapter can be run on any
system that has connectivity to the Application Monitor agent and the Patrol EM
server. The Java runtime version 1.3 or later must be installed on the system and
be included in the PATH environment variable.

AM SNMP Adapter Installation and Configuration on a Windows platform:
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1.

4.

Copy the following files to a directory on the Windows platform:

Note: These files need to be in the same directory.

e AMTrapReceiver.jar

* am.conf

* amSnmpAdapter.bat (for Windows systems)

Edit the am.conf file to specify the following items:

* Patrol EM server name

¢ Socket number that you configured for the AM filter path

* SNMP port number

AR AR AR am. conf

#

# DESCRIPTION: AM BMC Patrol EM Adapter Configuration

#

# The configuration entries are as follows:

#

# PEM_HOST >Name of Patrol EM server

# PEM_SOCKET >Socket on Patrol EM server to receive AM trap data
# SNMP_PORT >Port number to listen for incoming SNMP trap on

#

# Copyright (c) 2003 by Cyanea Systems Corp. ALL RIGHTS RESERVED.
HHHHHHH AR

Navigate to the directory containing the Application Monitor SNMP Adapter
files.

Start the AM SNMP Adapter by entering the following command at a DOS
prompt:

> amSnmpAdapter.bat

The AM SNMP Adapter will begin listening for SNMP traps on the port specified
in the am.conf file. Error messages will be generated and output to standard out if
any problems occur in receiving and decoding the AM SNMP traps. The error
output can be redirected to a log file if desired by starting the AM SNMP Adapter
with the following command:

> amSnmpAdapter.bat > am.log

The Application Monitor SNMP Adapter Installation and Configuration on a Unix
platform:

1.

On the Unix platform, extract the Application Monitor SNMP Adapter files
from am.tar:

tar xvf am.tar

Extract the files to the /home/u/NetCmmnd directory. If desired, you may
move the files to another directory, but all of the Application Monitor SNMP
Adapter files must be in the same directory.

Edit the am.conf file as described above.
Login as "root”, and execute the following command:
./amSnmpAdapter.sh > am.log &

This will start the Application Monitor SNMP Adapter running in the
background. The system will output any error messages to the file am.log.
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Using Patrol EM with the Application Monitor

Configure the AM agent to send SNMP traps to the configured the Application
Monitor SNMP Adapter hose, and AM events will show up in the Patrol EM
Active Alert Display.

Click on an event and select Actions > About to view more information about the
selected event.

The details for the event display in the Stored Token box of the About window.

About Hindow .
Aertid | 2501 Filter [ AM
Path I Al AleriType I ApplicationOccurrence
AMOccurrence - [trapMame]@[trapDevice] KN
Template %
Text AMOccurence - [trapMame]@[trapDevice] j
rDates
Date Time State | active
Received | 29/May/2003 | 15:54 — I
Assigned I o I o Priority I 7
Accepted == ==
P I I Occurrences |1
Acknowledged == ==
N I I Severity I Warning
Closed = =
I I Category I Software
Comments Add Comment | Description
X | alert has no description A
Stored Tokens [frapFilter. "Request= *, Method=none, SQL=N/A" iy
trapMumberOfOccurences: "1" _

trapCffending: "Value=1.0 occurence, Content=none” 3 7

7|

Stored tokens and associated values for the alert

Figure 55. About window
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Appendix C. Port Consolidator

The port consolidator is used to reduce network resources. Typically, it’s used in
the firewall environment. The following shows one deployment scenario:

Note: All Data Collectors and port consolidators are installed on the same physical
machine.

DataCollector

Port
4 Consolidator
8800

T
¥

DataCollectar =

| Port | FIRE
Consolidator | wWALL
8810

Managing
Server

DataCollectar

DataCollectar

DataCollectar J

DataCollectar

Metwark administrator need
open one port for each proxy
server, two ports for each
independent datacollector, ports

for kernel and publishing server.

Figure 56. Port Consolidator deployment scenario

Manual Installation

In the normal case, the port consolidator is installed at the same physical machine
as the Data Collector.

Here <AM_HOME> is the same as the Data Collector’s <AM_HOME>. There are
four subdirectories under <AM_HOME>. They are lib, bin, etc, logs.
<AM_HOME->/lib contains the required jar files.
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WebSphere:
<AM_HOME>/11ib/ext

ppe.proxy-intf.jar, ppe.probe.jar, ppe.probe-intf.jar, kernel.common.jar,
model.jar, common.jar, cyaneaaux.jar,ppe.proxy.jar, ppe.was_<version>.jar

Note: Replace <version> with the version of WebSphere you are running, either
ppe.was_5.jar or ppe.was_6.jar.

WebLogic:
<AM_HOME>/11ib/ext

common.jar, ppe.proxy.jar, cyaneaaux.jar, ppe.proxy-intf.jar, ppe.probe.jar,
ppe.probe-intf.jar, kernel.common.jar, model.jar, ppe.wls_<version>.jar

Note: Replace <version> with the version of WebLogic you are running, either
ppe.-wls_7 jar, ppe.wls_8.jar or ppe.wls_8130jar.

<AM_HOME>/etc contains the configuration files:
proxy.policy, log.properties, LogMessages.properties

UNIX:
<AM_HOME>bin contains the scripts to start/stop the port consolidator:
proxyserverctrl_ws.sh, proxyserverctrl_wl.sh

Windows:
<AM_HOME>bin contains the scripts to start/stop the port consolidator:
proxyserverctrl_ws.bat, proxyserverctrl wl.bat

Start/Stop Port Consolidator

Usage: ./proxyserverctrl_ws.sh ( start | stop | forcestop | killall | ping | list |
delete )

start - start port consolidator

stop - stop port consolidator

forcestop - kill -9 all port consolidator proccesses
ping - ping port consolidator

list - list all registered Data Collectors

delete - delete all registered Data Collectors

Configuring Data Collector

To enable port consolidator on the Data Collector, add the following properties in
datacollector.properties:

proxy.host
proxy.port (8800)

To set the Java system property java.rmi.server.codebase:
<MS_AM_HOME>=/opt/ibm/wsam
<AM_HOME>=/opt/dc
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WebSphere: Append the following jars to java.rmi.server.codebase:

file://<MS_AM_HOME>/1ib/ppe.proxy-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.proxy.jar

Weblogic: Append the following jars to java.rmi.server.codebase:

file://<MS_AM_HOME>/Tib/ppe.proxy-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.proxy.jar

Append to the classpath:

<AM_HOME>/1ib/ext/ppe.proxy.jar
<AM_HOME>/11ib/ext/ppe.proxy-intf.jar
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Appendix D. Configuration Changes Made During the
Installation of the Data Collector

Application Servers Configuration

The following tables provide the configuration settings that will be done during

the installation.

Configuration for WebSphere 5.0.2 Portal on Intel/Linux

These are the recommended Application Server options for WebSphere 5.0.2 on

Linux.

Table 7. Application Server Options for WebSphere 5.0.2 Portal on Linux

Entity

Settings

Generic JVM
Arguments

Add the following as arguments to the JVM command line:

Note: The order the instructions are performed in is important. Please
follow this order.

-Xoss2M -Xss1M -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:

<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam

Environment
Entries

Set the following environment variables:
LD_LIBRARY PATH =<AM_HOME>/1ib

Custom
Properties (JVM)

Add the following system properties:
java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.nodename=<node name>
e am.appserver=<Application Server name>
* appserver.platform=wps502
* com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin
* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.
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Table 7. Application Server Options for WebSphere 5.0.2 Portal on Linux (continued)

Entity Settings
Shared Library | Modify "WPSlib " Shared Libraries at the node level to include
Settings ppe-wps_5.jar in the classpath. This can be done through administrative

console or by modifying libraries.xml at the node level. To set it through
administrative console go to: Environment-->Shared libraries-->WPSlib
Add <AM_HOME>/lib/ppe.wps_5.jar to the classpath.

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
Service systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wlmModule=M
wsgwModule=N

Configuration for WebSphere 5.0.2 Portal on AIX

These are the recommended Application Server options for WebSphere 5.0.2 on
AIX.

Table 8. Application Server Options for WebSphere 5.0.2 Portal on AIX

Entity Settings
Generic JVM Add the following as arguments to the JVM command line:
Arguments Note: The order the instructions are performed in is important. Please

follow this order.

-Xbootclasspath/p:<AM_HOME>/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam -Xgcthreadsl

Environment Set the following environment variables:
Entries * _JVM_THREAD_DUMP_BUFFER_SIZE=25000000
* AIXTHREAD_SCOPE=S

e AIXTHREAD_MUTEX_DEBUG=0FF

e AIXTHREAD_COND_DEBUG=0FF

e AIXTHREAD_RWLOCK_DEBUG=OFF

* LIBPATH=<AM_HOME>/11ib

In order to view thread CPU times, set the following environment
variable:
e AIXTHREAD_ENRUSG=ON
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Table 8. Application Server Options for WebSphere 5.0.2 Portal on AIX (continued)

Entity

Settings

Custom
Properties (JVM)

Add the following system properties:
java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.nodename=<node name>
* am.appserver=<application server name>
e appserver.platform=wps502
* com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin
e deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Shared Library

Modify "WPSIlib " Shared Libraries at the node level to include

Settings ppe.-wps_5,jar in the classpath. This can be done through administrative
console or by modifying libraries.xml at the node level. To set it through
administrative console go to: Environment-->Shared libraries-->WPSlib
Add <AM_HOME>/lib/ppe.wps_5.jar to the classpath.

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H

Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H

Service systemModule=M threadPoolModule=H transactionModule=M

webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Configuration for WebSphere 5.0.2 Portal on Solaris

These are the recommended Application Server options for WebSphere 5.0.2 on

Solaris.
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Table 9. Application Server Options for WebSphere 5.0.2 Portal on Solaris

Entity

Settings

Generic JVM
Arguments

Run the JVM in server mode.

Add the following as arguments to the JVM command line:
Note: The order the instructions are performed in is important. Please
follow this order.

-server -Xbootclasspath/p:<AM_HOME>

/1ib/bcm-bootstrap.jar:

<AM_HOME>/11ib/ppe.probe-bootstrap.jar -Xrunam

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based on
the Maximum and Minimum heap settings of the JVM.

Custom
Properties (JVM)

Add the following system properties:

java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
am.home=<AM_HOME>

java.security.policy=<AM HOME>/etc/datacollector.policy
am.probe.stdout=<path of Application Server stdout>
am.nodename=<node name>

am.appserver=<application server name>
appserver.platform=wps502
com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin
depToymentmgr.rmi.connection=

<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws5.ProbeService

Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Shared Library
Settings

Modify "WPSIlib " Shared Libraries at the node level to include
ppe-wps_5.jar in the classpath. This can be done through administrative
console or by modifying libraries.xml at the node level. To set it through
administrative console go to: Environment-->Shared libraries-->WPSlib
Add <AM_HOME>/lib/ppe.wps_5.jar to the classpath.
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Table 9. Application Server Options for WebSphere 5.0.2 Portal on Solaris (continued)

Entity Settings

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
Service systemModule=M threadPoolModule=H transactionModule=M

webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Environment Set the following environment variables:
Entries LD_LIBRARY PATH=<AM_HOME>/1ib

Configuration for WebSphere 5.0.2 Portal on Windows

These are the recommended Application Server options for WebSphere 5.0.2 on
Windows.

Table 10. Application Server Options for WebSphere 5.0.2 Portal on Windows

Entity Settings
Generic JVM Add the following as arguments to the JVM command line:
Arguments Note: The order the instructions are performed in is important. Please

follow this order.

-Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar;
<AM_HOME>/11ib/ppe.probe-bootstrap.jar -Xrunam

Environment Set the following environment variables:
Entries _JVM_THREAD_DUMP_BUFFER_SIZE=25000000
PATH=<AM_HOME>\11ib

Custom Add the following system properties:

Properties (JVM) java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the directory where the Managing Server
is installed. For example, C:\Program~1\IBM\wsam
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.nodename=<node name>
* am.appserver=<application server name>
e appserver.platform=wps502
* com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin
* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services | Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.
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Table 10. Application Server Options for WebSphere 5.0.2 Portal on Windows (continued)

Entity Settings
Shared Library | Modify "WPSlib " Shared Libraries at the node level to include
Settings ppe-wps_5.jar in the classpath. This can be done through administrative

console or by modifying libraries.xml at the node level. To set it through
administrative console go to: Environment-->Shared libraries-->WPSlib
Add <AM_HOME>/lib/ppe.wps_5.jar to the classpath.

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
Service systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wlmModule=M
wsgwModule=N

Configuration for WebSphere 5.0.2.6/5.0.2.8 on Intel/Linux and
z/Linux

These are the recommended Application Server options for WebSphere
5.0.2.6/5.0.2.8 on Intel/Linux and z/Linux.

Table 11. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on Intel/Linux and

z/Linux

Entity Settings

Generic JVM Add the following as arguments to the JVM command line:

Arguments Note: The order the instructions are performed in is important. Please
follow this order.
-Xoss2M -Xss1M -Xbootclasspath/p:<AM_HOME>

/1ib/bcm-bootstrap.jar:

<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam

Environment Set the following environment variables:

Entries LD_LIBRARY PATH =<AM_HOME>/Tib

Custom Add the following system properties:

Properties (JVM) java.rmi.server.codebase =

file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

* am.home=<AM_HOME>

e java.security.policy=<AM_HOME>/etc/datacollector.policy

* am.nodename=<node name>

* am.appserver=<application server name>

e appserver.platform=was502

* Optional if you are using MQ:

am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin
e deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.
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Table 11. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on Intel/Linux and
z/Linux (continued)

Entity

Settings

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance
Monitoring
Service

beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Configuration for WebSphere 5.0.2.6/5.0.2.8 on AIX

These are the recommended Application Server options for WebSphere
5.0.2.6/5.0.2.8 on AIX.

Table 12. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on AIX

Entity Settings
Generic JVM Add the following as arguments to the JVM command line:
Arguments Note: The order the instructions are performed in is important. Please

follow this order.

-Xbootclasspath/p:<AM_HOME>

/1ib/bcm-bootstrap.jar:

<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam -Xgcthreadsl
Environment Set the following environment variables:
Entries * _JVM_THREAD_DUMP_BUFFER_SIZE=25000000

e AIXTHREAD_SCOPE=S

e AIXTHREAD_MUTEX_DEBUG=0FF
* AIXTHREAD_COND_DEBUG=0FF

e AIXTHREAD_RWLOCK DEBUG=OFF
e LIBPATH=<AM_HOME>/11ib

In order to view thread CPU times, set the following environment

variable:
* AIXTHREAD_ENRUSG=ON
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Table 12. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on AIX (continued)

Entity Settings

Custom Add the following system properties:

Properties JVM) |* java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.nodename=<node name>
e am.appserver=<application server name>
e appserver.platform=was502
* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services | Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
Service systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Configuration for WebSphere 5.0.2.6/5.0.2.8 on Solaris

These are the recommended Application Server options for WebSphere
5.0.2.6/5.0.2.8 on Solaris.
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Table 13. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on Solaris

Entity

Settings

Generic JVM
Arguments

Run the JVM in server mode.

Add the following as arguments to the JVM command line:
Note: The order the instructions are performed in is important. Please
follow this order.
-server -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/11ib/ppe.probe-bootstrap.jar -Xrunam

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based on
the Maximum and Minimum heap settings of the JVM.

Custom
Properties (JVM)

Add the following system properties:

java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
am.home=<AM_HOME>

Jjava.security.policy=<AM HOME>/etc/datacollector.policy
am.probe.stdout=<path of application server stdout>
am.nodename=<node name>

am.appserver=<application server name>
appserver.platform=was502

Optional if you are using MQ:

am.ext.dirs=<MQ HOME>/1ib

com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

deploymentmgr.rmi.connection=

<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.
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Table 13. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on Solaris (continued)

Entity

Settings

Performance
Monitoring
Service

beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Environment
Entries

Set the following environment variables:
LD_LIBRARY PATH=<AM_HOME>/Tib

Configuration for WebSphere 5.0.2.6/5.0.2.8 on HP-UX

These are the recommended Application Server options for WebSphere
5.0.2.6/5.0.2.8 on HP-UX.

Table 14. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on HP-UX

Entity

Settings

Generic JVM
Arguments

Add the following as arguments to the JVM command line:

Note: The order the instructions are performed in is important. Please
follow this order.

-Xbootclasspath/p:<AM_HOME>

/1ib/bcm-bootstrap.jar:

<AM_HOME>/11ib/ppe.probe-bootstrap.jar -Xrunam

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Some tuning we recommend for an application that allocates many short
living objects:
-XX:+DisableExpTicitGC -XX:NewSize=128m

-XX:MaxNewSize=256m -Xconcurrentio

Note: NewSize and MaxNewsSize should be changed based on the
Maximum and Minimum heap settings of the JVM.
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Table 14. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on HP-UX (continued)

Entity

Settings

Custom
Properties (JVM)

Add the following system properties:
java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.probe.stdout=<path of application server stdout>
* am.home=<AM_HOME>
e am.nodename=<node name>
* am.appserver=<application server name>
* appserver.platform=was502
* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H

Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H

Service systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wlmModule=M
wsgwModule=N

Environment Set the following environment variables:

Entries

SHLIB_PATH=<AM_HOME>/11ib
am.home=<AM_HOME>

am.nodename=<node name>
am.appserver=<application server name>
appserver.platform=was502

Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib

Configuration for WebSphere 5.0.2.6/5.0.2.8 on Windows

These are the recommended Application Server options for WebSphere
5.0.2.6/5.0.2.8 on Windows.
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Table 15. Application Server Options for WebSphere 5.0.2.6/5.0.2.8 on Windows

Entity Settings
Generic JVM Add the following as arguments to the JVM command line:
Arguments Note: The order the instructions are performed in is important. Please

follow this order.

-Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar;
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam

Environment Set the following environment variables:
Entries _JVM_THREAD_DUMP_BUFFER_SIZE=25000000
PATH=<AM_HOME>\T1b

Custom Add the following system properties:

Properties (JVM) java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the directory where the Managing Server
is installed. For example, C:\Program~1\IBM\wsam
* am.home=<AM_HOME>
* java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.nodename=<node name>
* am.appserver=<application server name>
* appserver.platform=was502
* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services | Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
Service systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Configuration for WebSphere 5.1.1 on AIX

These are the recommended Application Server options for WebSphere 5.1.1 on
AIX.
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Table 16. Application Server Options for WebSphere 5.1.1 on AIX

Entity

Settings

Generic JVM
Arguments

Add the following as arguments to the JVM command line:

-Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam

Environment
Entries

Set the following environment variables:

In order to view thread CPU times, set the following environment
variable:

_JVM_THREAD_DUMP_BUFFER_SIZE=25000000
AIXTHREAD_SCOPE=S

AIXTHREAD_MUTEX DEBUG=OFF
AIXTHREAD_COND_DEBUG=0FF
AIXTHREAD_RWLOCK DEBUG=OFF
LIBPATH=<AM_HOME>/1ib

AIXTHREAD_ENRUSG=ON

Custom
Properties (JVM)

Add the following system properties:

java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
am.home=<AM_HOME>

java.security.policy=<AM HOME>/etc/datacollector.policy
am.nodename=<node name>

am.appserver=<application server name>
appserver.platform=was511

Optional if you are using MQ:

am.ext.dirs=<MQ HOME>/1ib

com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

deploymentmgr.rmi.connection=

<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsbh.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.
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Table 16. Application Server Options for WebSphere 5.1.1 on AIX (continued)

Entity Settings

Performance beanModule=X

Monitoring cacheModule=N

Service connectionPoolModule=H
j2cModule=H

jvmRuntimeModule=H
orbPerfModule=H
servletSessionsModule=H
systemModule=M
threadPoolModule=H
transactionModule=M
webAppModule=H
webServicesModule=N
wimModule=M
wsgwModule=N

Configuration for WebSphere 5.1.1 on Intel/Linux and z/Linux

These are the recommended Application Server options for WebSphere 5.1.1 on
Intel/Linux and z/Linux.

Table 17. Application Server Options for WebSphere 5.1.1 on Intel/Linux and z/Linux

Entity Settings
Generic JVM Add the following as arguments to the JVM command line: -Xoss2M
Arguments -Xss1M

-Xbootclasspath/p:<AM_HOME?>/lib /becm-bootstrap.jar:
<AM_HOME-> /lib/ppe.probe-bootstrap.jar -Xrunam

<AM_HOME> = AM installation directory

Environment Set the following environment variables:
Entries « LD_LIBRARY_PATH =<AM HOME>/1ib
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Table 17. Application Server Options for WebSphere 5.1.1 on Intel/Linux and
z/Linux (continued)

Entity Settings

Custom Add the following system properties:

Properties (JVM) java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.nodename=<node name>
* am.appserver=<application server name>
* appserver.platform=was511
* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services | Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb5.ProbeService
Classpath:null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
Service systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Configuration for WebSphere 5.1.1 on Solaris

These are the recommended Application Server options for WebSphere 5.1.1 on
Solaris.
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Table 18. Application Server Options for WebSphere 5.1.1 on Solaris

Entity

Settings

Generic JVM
Arguments

Run the JVM in server mode.

Add the following as arguments to the JVM command line:
Note: The order in which the options are specified is important. Please
follow this order.
-server -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/11ib/ppe.probe-bootstrap.jar -Xrunam

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based on
the Maximum and Minimum heap settings of the JVM.

Custom
Properties (JVM)

Add the following system properties:

e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.probe.stdout=<path of application server stdout>
* am.nodename=<node name>
* am.appserver=<application server name>
e appserver.platform=was511
* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

e deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.
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Table 18. Application Server Options for WebSphere 5.1.1 on Solaris (continued)

Entity Settings

Performance beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H

Monitoring jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H

Service systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wimModule=M
wsgwModule=N

Environment Set the following environment variables:

Entries LD_LIBRARY PATH=<AM_HOME>/1ib

Configuration for WebSphere 5.1.1 on HP-UX

These are the recommended Application Server options for WebSphere 5.1.1 on

HP-UX.

Table 19. Application Server Options for WebSphere 5.1.1 on HP-UX

Entity Settings

Generic JVM Add the following as arguments to the JVM command line:
Arguments -Xbootclasspath/p:<AM_HOME>

/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.
Some tuning we recommend for an application that allocates many short
living objects:
-XX:+DisableExplicitGC -XX:NewSize=128m

-XX:MaxNewSize=256m -Xconcurrentio

Note: NewSize and MaxNewSize should be changed based on the

Maximum and Minimum heap settings of the JVM.
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Table 19. Application Server Options for WebSphere 5.1.1 on HP-UX (continued)

Entity

Settings

Custom
Properties (JVM)

Add the following system properties:

e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.probe.stdout=<path of application server stdout>
e am.home=<AM_HOME>
e am.nodename=<node name>
* am.appserver=<application server name>
* appserver.platform=was511
* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance
Monitoring
Service

beanModule=X cacheModule=N connectionPoolModule=H j2cModule=H
jvmRuntimeModule=H orbPerfModule=H servletSessionsModule=H
systemModule=M threadPoolModule=H transactionModule=M
webAppModule=H webServicesModule=N wlmModule=M
wsgwModule=N

Environment
Entries

Set the following environment variables:
SHLIB_PATH=<AM_HOME>/11ib

am. home=<AM_HOME>

am.nodename=<node name>
am.appserver=<application server name>
appserver.platform=was511

Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib

Configuration for WebSphere 5.1.1 on Windows

These are the recommended Application Server options for WebSphere 5.1.1 on

Windows.
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Table 20. Application Server Options for WebSphere 5.1.1 on Windows

Entity Settings
Generic JVM Add the following as arguments to the JVM command line:
Arguments -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar;
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam
Environment Set the following environment variables:
Entries _JVM_THREAD_DUMP_BUFFER_SIZE=25000000
PATH=<AM_HOME>\11ib
Custom Add the following system properties:

Properties (JVM)

e java.rmi.server.codebase =
file://<MS_AM HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_5.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the directory where the Managing Server
is installed. For example, C:\Program~1\IBM\wsam
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>\etc\datacollector.policy
* am.nodename=<node name>
* am.appserver=<application server name>
* appserver.platform=was511
* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
e com.ibm.websphere.classloader.plugin=
com.cyanea.bcm.websphere.BcmPlugin

* deploymentmgr.rmi.connection=
<deployment manager host>:<deployment manager rmi port>

Note: The deploymnetmgr.rmi.connection property is only required
when using the deployment manager. Remove the old rmi manager
host and port property.

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.wsb5.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance
Monitoring
Service

beanModule=X
cacheModule=N
connectionPoolModule=H
j2cModule=H
jvmRuntimeModule=H
orbPerfModule=H
servletSessionsModule=H
systemModule=M
threadPoolModule=H
transactionModule=M
webAppModule=H
webServicesModule=N
wimModule=M
wsgwModule=N
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Configuration for WebSphere 6 on AIX

These are the recommended Application Server options for WebSphere 6 on AIX.
Table 21. Application Server Options for WebSphere 6 on AIX

Entity Settings

Generic JVM Add the following as arguments to the JVM command line:

Arguments -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/11ib/ppe.probe-bootstrap.jar -Xrunam

Environment Set the following environment variables:
Entries e _JVM_THREAD_DUMP_BUFFER_SIZE=25000000
* AIXTHREAD_SCOPE=S

e AIXTHREAD_MUTEX_DEBUG=0FF

e AIXTHREAD_COND_DEBUG=0FF

e AIXTHREAD_RWLOCK_ DEBUG=OFF

e LIBPATH=<AM_HOME>/11ib

In order to view thread CPU times, set the following environment
variable:
* AIXTHREAD_ENRUSG=ON

Custom Add the following system properties:

Properties (JVM) |* java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_6.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

* am.home=<AM_HOME>

e java.security.policy=<AM_HOME>/etc/datacollector.policy

* am.nodename=<node name>

e am.appserver=<application server name>

* am.profilename=<profile name>

* For ND (Network Deployment)
deploymentmgr.rmi.connection=<host:port,
hostl:portl,host2:port2>

e appserver.platform=was6

e com.ibm.websphere.classloader.plugin=

com.cyanea.bcm.websphere.BcmPlugin
e am.profilename=<name of application server>

* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib

Custom Services | Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws6.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.
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Table 21. Application Server Options for WebSphere 6 on AIX (continued)

Entity Settings
Performance statisticSet=extended
Monitoring

Service

Configuration for WebSphere 6 on Intel/Linux and z/Linux

These are the recommended Application Server options for WebSphere 6 on
Intel/Linux and z/Linux.

Table 22. Application Server Options for WebSphere 6 on Intel/Linux and z/Linux

Properties (JVM)

Entity Settings
Generic JVM Add the following as arguments to the JVM command line: -Xoss2M
Arguments -Xss1M
-Xbootclasspath/p:<AM_HOME?>/lib /bcm-bootstrap.jar:
<AM_HOME->/lib/ppe.probe-bootstrap.jar -Xrunam
<AM_HOME> = AM installation directory
Environment Set the following environment variables:
Entries « LD_LIBRARY_PATH =<AM_HOME>/1ib
Custom Add the following system properties:

java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_6.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

* am.home=<AM_HOME>

* java.security.policy=<AM_HOME>/etc/datacollector.policy

* am.nodename=<node name>

* am.appserver=<application server name>

e am.profilename=<profile name>

* For ND (Network Deployment)
deploymentmgr.rmi.connection=<host:port,
hostl:portl,host2:port2>

e appserver.platform=was6

* com.ibm.websphere.classloader.plugin=

com.cyanea.bcm.websphere.BcmPlugin

e am.profilename=<name of application server>

* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws6.ProbeService
Classpath:null

Note: There is a defect in the Administrative Console that will not allow

you to type an empty classpath.
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Table 22. Application Server Options for WebSphere 6 on Intel/Linux and
Z/Linux (continued)

Entity

Settings

Performance
Monitoring
Service

statisticSet=extended

Configuration for WebSphere 6 on Solaris

These are the recommended Application Server options for WebSphere 6 on

Solaris.

Table 23. Application Server Options for WebSphere 6 on Solaris

Entity

Settings

Generic JVM
Arguments

Run the JVM in server mode.

Add the following as arguments to the JVM command line:

Note: The order in which the options are specified is important. Please
follow this order.

-server -Xbootclasspath/p:<AM_HOME>

/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based on
the Maximum and Minimum heap settings of the JVM.
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Table 23. Application Server Options for WebSphere 6 on Solaris (continued)

Entity

Settings

Custom
Properties (JVM)

Add the following system properties:
java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_6.jar
file://<MS_AM HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

* am.home=<AM_HOME>

e java.security.policy=<AM_HOME>/etc/datacollector.policy

* am.probe.stdout=<path of application server stdout>

e am.nodename=<node name>

* am.appserver=<application server name>

e am.profilename=<profile name>

* For ND (Network Deployment)
deploymentmgr.rmi.connection=<host:port,
hostl:portl,host2:port2>

e appserver.platform=was6

* com.ibm.websphere.classloader.plugin=

com.cyanea.bcm.websphere.BcmPlugin
e am.profilename=<name of application server>

* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws6.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance statisticSet=extended

Monitoring

Service

Environment Set the following environment variables:
Entries

LD_LIBRARY_PATH=<AM_HOME>/1ib

Configuration for WebSphere 6 on HP-UX

These are the recommended Application Server options for WebSphere 6 on

HP-UX.
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Table 24. Application Server Options for WebSphere 6 on HP-UX

Entity

Settings

Generic JVM
Arguments

Add the following as arguments to the JVM command line:

-Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Some tuning we recommend for an application that allocates many short
living objects:
-XX:+DisableExplicitGC -XX:NewSize=128m

-XX:MaxNewSize=256m -Xconcurrentio

Note: NewSize and MaxNewsSize should be changed based on the
Maximum and Minimum heap settings of the JVM.

Custom
Properties (JVM)

Add the following system properties:

e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_6.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

* java.security.policy=<AM_HOME>/etc/datacollector.policy

* am.probe.stdout=<path of application server stdout>

e am.home=<AM_HOME>

* am.nodename=<node name>

* am.appserver=<application server name>

e am.profilename=<profile name>

* For ND (Network Deployment)
depToymentmgr.rmi.connection=<host:port,
hostl:portl,host2:port2>

* appserver.platform=was6

e com.ibm.websphere.classloader.plugin=

com.cyanea.bcm.websphere.BcmPTugin
* am.profilename=<name of application server>

* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws6.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance
Monitoring
Service

statisticSet=extended
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Table 24. Application Server Options for WebSphere 6 on HP-UX (continued)

Entity Settings
Environment Set the following environment variables:
Entries

SHLIB_PATH=<AM_HOME>/1ib
am.home=<AM_HOME>

am.nodename=<node name>
am.appserver=<application server name>
appserver.platform=was6

Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib

Configuration for WebSphere 6 on Windows

These are the recommended Application Server options for WebSphere 6 on

Windows.

Table 25. Application Server Options for WebSphere 6 on Windows

Properties (JVM)

Entity Settings
Generic JVM Add the following as arguments to the JVM command line:
Arguments -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar;
<AM_HOME>/1ib/ppe.probe-bootstrap.jar -Xrunam
Environment Set the following environment variables:
Entries _JVM_THREAD DUMP_BUFFER SIZE=25000000
PATH=<AM_HOME>\11ib
Custom Add the following system properties:

e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.was_6.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the directory where the Managing Server
is installed. For example, C:\Program~1\IBM\wsam

* am.home=<AM_HOME>

e java.security.policy=<AM_HOME>\etc\datacollector.policy

* am.nodename=<node name>

e am.appserver=<application server name>

* am.profilename=<profile name>

* For ND (Network Deployment)
deploymentmgr.rmi.connection=<host:port,
hostl:portl,host2:port2>

e appserver.platform=was6

e com.ibm.websphere.classloader.plugin=

com.cyanea.bcm.websphere.BcmPlugin
* am.profilename=<name of application server>

* Optional if you are using MQ:
am.ext.dirs=<MQ HOME>/1ib
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Table 25. Application Server Options for WebSphere 6 on Windows (continued)

Entity

Settings

Custom Services

Add a custom service as follows:

Name: AM Custom Service

Classname: com.cyanea.ws6.ProbeService
Classpath: null

Note: There is a defect in the Administrative Console that will not allow
you to type an empty classpath.

Performance
Monitoring
Service

statisticSet=extended

Configuration for WebLogic 7.0 SP5 on Intel/Linux

These are the recommended Application Server options for WebLogic 7.0 SP5 on

Linux.

Table 26. Application Server Options for WebLogic 7.0 SP5 on Linux

Entity

Settings

Java Command
Line Arguments

The following arguments must be first on the Java command line:
-server

-Xrunam

-Xbootclasspath/p:<AM_HOME>/lib/bcm-bootstrap.jar:
<AM_HOME>/lib/ppe.probe-bootstrap.jar

The following is an example of how to redirect the standard output to a
file:
./startWeblLogic.sh > Togs/stdout.Tog

Define the following system properties and modify CLASSPATH in

$WL_HOME/server/bin/startWLS.sh.

e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.wls_7.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

appserver.platform=wls7050

weblogic.Domain=<DOMAIN NAME>
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
e am.probe.stdout=<path of application server stdout>
* weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor
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Table 26. Application Server Options for WebLogic 7.0 SP5 on Linux (continued)

Entity Settings

Java Command | (Continued from the previous table row)

Line Arguments
Modify the CLASSPATH as follows:

CLASSPATH=<AM_HOME>
/1ib/ext/ppe.probe.jar:<AM_HOME>/1ib/ext/ppe.probe-intf.jar:
<AM_HOME>/11ib/ext/common. jar:
<AM_HOME>/1ib/ext/kernel.common. jar:
<AM_HOME>/11ib/cyaneaaux.jar:

<AM_HOME>/1ib/ext/model.jar:

<AM_HOME>/11ib/ext/cdn.jar:

<AM_HOME>/1ib/ext/ppe.wls_7.jar:
<AM_HOME>/1ib/ext/cdnaux.jar$:CLASSPATH

Startup Class Classname: com.cyanea.wl70.WLStartup
Name: AM Startup
Targets: <your application server>

Shutdown Class

Classname: com.cyanea.wl70.WLShutdown
Name: AM Shutdown
Targets: <your application server>

Environment Set the following environment variable:
Variables LD_LIBRARY_PATH=<AM HOME>/1ib:$LD_LIBRARY PATH

Set this variable in $WL_HOME/common/bin/commEnv.sh file.

Configuration for WebLogic 7.0 SP5 on Solaris

These are the recommended Application Server options for WebLogic 7.0 SP5 on
Solaris.

Table 27. Application Server Options for WebLogic 7.0 SP5 on Solaris

Entity Settings

Java Command |The following argument must be first on the Java command line:

Line Arguments | _sepyer -Xrunam -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/11ib/ppe.probe-bootstrap.jar

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based on
the Maximum and Minimum heap settings of the JVM.

The following is an example of how to redirect the standard output to a
file:

./startWeblLogic.sh > Togs/stdout.log

(path of application server stdout)
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Table 27. Application Server Options for WebLogic 7.0 SP5 on Solaris (continued)

Entity

Settings

Java Command
Line Arguments

(Continued from the previous table row)

Define the following system properties in the WebLogic startup script:
e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM _HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.wls_7.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

appserver.platform=wls7050
* am.home=<AM_HOME>
* weblogic.Domain=<domain>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.probe.stdout=<path of application server stdout>
* weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor

Java Command
Line Arguments

(Continued from the previous table row)

Modify the CLASSPATH as follows:

CLASSPATH=<AM_HOME>/1ib/ext/ppe.probe.jar:
<AM_HOME>/1ib/ext/ppe.probeintf.jar:
<AM_HOME>/1ib/ext/common. jar:
<AM_HOME>/1ib/ext/kernel.common.jar:
<AM_HOME>/1ib/cyaneaaux.jar:
<AM_HOME>/1ib/ext/model.jar:
<AM_HOME>/1ib/ext/cdn.jar:
<AM_HOME>/1ib/ext/ppe.wls_7.jar:
<AM_HOME>/11ib/ext/cdnaux.jar$: $CLASSPATH

Startup Class

Shutdown Class

Classname: com.cyanea.wl70.WLStartup
Name: AM Startup

Targets: <your application server>
Classname: com.cyanea.wl70.WLShutdown
Name: AM Shutdown

Targets: <your application server>

Environment
Variables

Set the following environment variable:
LD_LIBRARY_PATH=<AM_HOME>/1ib:$LD_LIBRARY_PATH

Set this variable in <WL_HOME>/common/bin/commEnv.sh file.

Configuration for WebLogic 7.0 SP5 on HP-UX

These are the recommended Application Server options for WebLogic 7.0 SP5 on

HP-UX.
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Table 28. Application Server Options for WebLogic 7.0 SP5 on HP-UX

Entity

Settings

Java Command
Line Arguments

The following argument must be first on the Java command line:

-server -Xrunam -Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based on
the Maximum and Minimum heap settings of the JVM.

The following is an example of how to redirect the standard output to a
file:
./startWebLogic.sh > Togs/stdout.log

(path of application server stdout)

Java Command
Line Arguments

(Continued from previous table row)

Define the following system properties in the WebLogic startup script:
e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.wls_7.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

appserver.platform=wls7050 Where <MS_AM_HOME-> is the
am_home where the Managing Server was installed. For example,
/opt/ibm/wsam.

* am.home=<AM_HOME>

* weblogic.Domain=<domain>

e java.security.policy=<AM_HOME>/etc/datacollector.policy

e am.probe.stdout=<path of application server stdout>

e weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor

Java Command
Line Arguments

(Continued from previous table row)

Modify the CLASSPATH as follows:

CLASSPATH=<AM_HOME>/1ib/ext/ppe.probe.jar:
<AM_HOME>/1ib/ext/ppe.probe-intf.jar:
<AM_HOME>/11ib/ext/common. jar:
<AM_HOME>/1ib/ext/kernel.common.jar:
<AM_HOME>/1ib/cyaneaaux.jar:
<AM_HOME>/1ib/ext/model.jar:
<AM_HOME>/1ib/ext/cdn.jar:
<AM_HOME>/1ib/ext/ppe.wls_7.jar:
<AM_HOME>/11ib/ext/cdnaux.jar$: $CLASSPATH
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Table 28. Application Server Options for WebLogic 7.0 SP5 on HP-UX (continued)

Entity

Settings

Startup Class

Shutdown Class

Classname: com.cyanea.wl70.WLStartup
Name: AM Startup

Targets: <your application server>
Classname: com.cyanea.wl70.WLShutdown
Name: AM Shutdown

Targets: <your application server>

Environment
Variables

Set the following environment variable:
SHLIB_PATH=<AM_HOME>/11ib: $SHLI B_PATH

Set this variable in $WL_HOME/common/bin/commEnv.sh file.

Configuration for WebLogic 7.0 SP5 on Windows

These are the recommended Application Server options for WebLogic 7.0 SP5 on

Windows.

Table 29. Application Server Options for WebLogic 7.0 SP5 on Windows

Entity

Settings

Java Command
Line Arguments

The following arguments must be first on the Java command line:
-server
-Xrunam

-Xbootclasspath\p:<AM_HOME>\Tib\bcm-bootstrap.jar;
<AM_HOME>\T1ib\ppe.probe-bootstrap.jar

The following is an example of how to redirect the standard output to a
file:
startWebLogic.bat > c:\temp\stdout.log

Define the following system properties and modify CLASSPATH in

$WL_HOMEN\server\bin\startWLS.sh.

e java.rmi.server.codebase =
file:\\<MS_AM_HOME>\1ib3.2\ppe.probe.jar
file:\\<MS_AM HOME>\1ib\ppe.probe-intf.jar
file:\\<MS_AM_HOME>\1ib3.2\ppe.wls_7.jar
file:\\<MS_AM_HOME>\1ib3.2\ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, C:\Program~1\IBM\wsam.

appserver.platform=wls7050

weblogic.Domain=<DOMAIN NAME>
* am.home=<AM_HOME>
* java.security.policy=<AM_HOME>\etc\datacollector.policy
e am.probe.stdout=<path of application server stdout>
* weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor
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Table 29. Application Server Options for WebLogic 7.0 SP5 on Windows (continued)

Entity

Settings

Java Command
Line Arguments

(Continued from the previous table row)

Modify the CLASSPATH as follows:

CLASSPATH=<AM_HOME>\11ib\ext\ppe.probe.jar;
<AM_HOME>\Tib\ext\ppe.probe-intf.jar;
<AM_HOME>\Tib\ext\common.jar;
<AM_HOME>\Tib\ext\kernel.common.jar;
<AM_HOME>\1ib\ext\cyaneaaux.jar;
<AM_HOME>\Tib\ext\model.jar;
<AM_HOME>\Tib\ext\cdn.jar;
<AM_HOME>\Tib\ext\ppe.wls_7.jar;
<AM_HOME>/11ib/ext/cdnaux.jar$;%CLASSPATH%

Startup Class

Shutdown Class

Classname: com.cyanea.wl70.WLStartup
Name: AM Startup

Targets: <your application server>
Classname: com.cyanea.wl70.WLShutdown
Name: AM Shutdown

Targets: <your application server>

Environment
Variables

Set the following environment variable:
LD_LIBRARY_PATH=<AM_HOME>\1ib;%LD_LIBRARY_PATH

Set this variable in <WL_HOME>\common\bin\commEnv.sh file.

Configuration for WebLogic 8.1 SP3 on Intel/Linux

These are the recommended Application Server options for WebLogic 8.1 SP8.3 on

Linux.

Table 30. Application Server Options for WebLogic 8.1 SP3 on Linux

Entity

Settings

Java Command
Line Arguments

The following arguments must be first on the Java command line:
-Xrunam

-Xbootclasspath/p:<AM_HOME>/1ib/bcm-bootstrap.jar:
<AM_HOME>/11ib/ppe.probe-bootstrap.jar

The following is an example of how to redirect the standard output to a
file:

./startWeblLogic.sh > Togs/stdout.log
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Table 30. Application Server Options for WebLogic 8.1 SP3 on Linux (continued)

Entity

Settings

Java Command
Line Arguments

(Continued from previous table row)

Define the following system properties in the WebLogic startup script:
e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM _HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.wls_8130.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

appserver.platform=wls8130

weblogic.Domain=<DOMAIN NAME>
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
e am.probe.stdout=<path of application server stdout>
* weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor

Java Command
Line Arguments

(Continued from previous table row)

Modify the CLASSPATH as follows:
CLASSPATH=<AM_HOME>/lib/ext/ppe.probe jar:
<AM_HOME->/lib/ext/ppe.probe-intf jar:
<AM_HOME>/lib/ext/common jar:
<AM_HOME->/lib/ext/kernel.common.jar:
<AM_HOME>/lib/cyaneaaux jar:
<AM_HOME>/lib/ext/model jar:
<AM_HOME>/lib/ext/cdn jar:
<AM_HOME>/lib/ext/ppe.wls_8130.jar:
<AM_HOME>/lib/ext/cdnaux.jar$:3CLASSPATH

Startup Class

Shutdown Class

Classname: com.cyanea.wl8l.WLStartup
Name: AM Startup

Targets: <your application server>
Classname: com.cyanea.wl81.WLShutdown
Name: AM Shutdown

Targets: <your application server>

Environment
Variables

Set the following environment variable:
LD_LIBRARY_PATH=<AM_HOME>/1ib:$LD_LIBRARY_PATH

Set this variable in <WL_HOME>/common/bin/commEnv.sh file.

Configuration for WebLogic 8.1 SP3 on Solaris

These are the recommended Application Server options for WebLogic 8.1 SP3 on

Solaris.
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Table 31. Application Server Options for WebLogic 8.1 SP3 on Solaris

Entity

Settings

Java Command
Line Arguments

The following argument must be first on the Java command line:

-Xrunam-Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar

Note: The default NewSize and MaxNewSize might be small for some

Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based
the Maximum and Minimum heap settings of the JVM.

The following is an example of how to redirect the standard output to a

file:
./startWebLogic.sh > Togs/stdout.log

(path of application server stdout)

on

Java Command
Line Arguments

(Continued from previous table row)

Define the following system properties in the WebLogic startup script:

e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.wls_8130.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

appserver.platform=w1s8130
* am.home=<AM_HOME>
* weblogic.Domain=<domain>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
e am.probe.stdout=<path of application server stdout>
* weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor

Java Command
Line Arguments

(Continued from previous table row)

Modify the CLASSPATH as follows:
CLASSPATH=<AM_HOME>/lib/ext/ppe.probe jar:
<AM_HOME>/lib/ext/ppe.probe-intf jar:
<AM_HOME>/lib/ext/common jar:
<AM_HOME->/lib/ext/kernel.common.jar:
<AM_HOME>/lib/cyaneaaux jar:
<AM_HOME>/lib/ext/model jar:
<AM_HOME>/lib/ext/cdn jar:
<AM_HOME>/lib/ext/ppe.wls_8130.jar:
<AM_HOME>/lib/ext/cdnaux.jar$:3CLASSPATH
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Table 31. Application Server Options for WebLogic 8.1 SP3 on Solaris (continued)

Entity

Settings

Startup Class

Shutdown Class

Classname: com.cyanea.wl81l.WLStartup
Name: AM Startup

Targets: <your application server>
Classname: com.cyanea.wl81.WLShutdown
Name: AM Shutdown

Targets: <your application server>

Environment
Variables

Set the following environment variable:
LD_LIBRARY_PATH=<AM HOME>/1ib :$LD_LIBRARY_P/-\TH

Set this variable in <WL_HOME>/common/bin/commEnv.sh file.

Configuration for WebLogic 8.1 SP3 on HP-UX

These are the recommended Application Server options for WebLogic 8.1 SP3 on

HP-UX.

Table 32. Application Server Options for WebLogic 8.1 SP3 on HP-UX

Entity

Settings

Java Command
Line Arguments

The following argument must be first on the Java command line:

-Xrunam-Xbootclasspath/p:<AM_HOME>
/1ib/bcm-bootstrap.jar:
<AM_HOME>/1ib/ppe.probe-bootstrap.jar

Note: The default NewSize and MaxNewSize might be small for some
Applications if the Application is allocating large numbers of short
living objects.

Here are the settings we recommend for an application that allocates
many short living objects:

-XX:+DisableExplicitGC -XX:NewSize=128m
-XX:MaxNewSize=256m -Xconcurrentio

Note: The arguments NewSize and MaxNewSize should be set based on
the Maximum and Minimum heap settings of the JVM.

The following is an example of how to redirect the standard output to a
file:
./startWebLogic.sh > Togs/stdout.log

(path of application server stdout)
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Table 32. Application Server Options for WebLogic 8.1 SP3 on HP-UX (continued)

Entity

Settings

Java Command
Line Arguments

(Continued from the previous table row)

Define the following system properties in the WebLogic startup script:

e java.rmi.server.codebase =
file://<MS_AM_HOME>/1ib3.2/ppe.probe.jar
file://<MS_AM_HOME>/1ib/ppe.probe-intf.jar
file://<MS_AM_HOME>/1ib3.2/ppe.wls_8130.jar
file://<MS_AM_HOME>/1ib3.2/ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am_home where the Managing
Server was installed. For example, /opt/ibm/wsam.

appserver.platform=wls8130
e am.home=<AM_HOME>
* weblogic.Domain=<domain>
e java.security.policy=<AM_HOME>/etc/datacollector.policy
* am.probe.stdout=<path of application server stdout>
* weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor

Java Command
Line Arguments

(Continued from the previous table row)

Modify the CLASSPATH as follows:
CLASSPATH=<AM_HOME>/lib/ext/ppe.probe jar:
<AM_HOME>/lib/ext/ppe.probe-intf jar:
<AM_HOME>/lib/ext/common.jar:
<AM_HOME->/lib/ext/kernel.common. jar:
<AM_HOME->/lib/cyaneaaux jar:
<AM_HOME>/lib/ext/model jar:
<AM_HOME>/lib/ext/cdn.jar:
<AM_HOME->/lib/ext/ppe.wls_8130.jar:
<AM_HOME>/lib/ext/cdnaux.jar$:$CLASSPATH

Startup Class

Shutdown Class

Classname: com.cyanea.wl181.WLStartup
Name: AM Startup

Targets: <your application server>
Classname: com.cyanea.wl81.WLShutdown
Name: AM Shutdown

Targets: <your application server>

Environment
Variables

Set the following environment variable:
SHLIB_PATH=<AM_HOME>/1ib:$SHLIB_PATH

Set this variable in <WL_HOME>/common/bin/commEnv.sh file.
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Configuration for WebLogic 8.1 SP3 on Windows

These are the recommended Application Server options for WebLogic 8.1 SP3 on

Windows.

Table 33. Application Server Options for WebLogic 8.1 SP3 on Windows

Entity

Settings

Java Command
Line Arguments

The following arguments must be first on the Java command line:

-Xrunam

-Xbootclasspath\p:<AM_HOME>\lib\bcm-bootstrap jar;
<AM_HOME>\Ilib\ ppe.probe-bootstrap.jar

The following is an example of how to redirect the standard output to a
file:

startWebLogic.bat > c:\1ogs\stdout.log

Java Command
Line Arguments

(Continued from previous table row)

Define the following system properties in the WebLogic startup script:

e java.rmi.server.codebase =
file:\\<MS_AM_HOME>\1ib3.2\ppe.probe.jar
file:\\<MS_AM_HOME>\1ib\ppe.probe-intf.jar
file:\\<MS_AM_HOME>\1ib3.2\ppe.wls_8130.jar
file:\\<MS_AM_HOME>\1ib3.2\ppe.probe-bootstrap.jar

Where <MS_AM_HOME> is the am home where the Managing
Server was installed. For example, C:\Program~1\IBM\wsam.

appserver.platform=wls8130

weblogic.Domain=<DOMAIN NAME>
* am.home=<AM_HOME>
e java.security.policy=<AM_HOME>\etc\datacollector.policy
e am.probe.stdout=<path of application server stdout>
e weblogic.classloader.preprocessor=com.cyanea.bcm.
weblogic.BcmPreProcessor

Java Command
Line Arguments

(Continued from previous table row)

Modify the CLASSPATH as follows:
CLASSPATH=<AM_HOME>\lib\ext\ppe.probe jar;
<AM_HOME>\lib\ext\ppe.probe-intf jar;
<AM_HOME>\Iib\ext\common jar;
<AM_HOME>\lib\ext\kernel.common.jar;
<AM_HOME>\lib\ext\cyaneaaux.jar;
<AM_HOME>\lib\ext\model jar;
<AM_HOME>\lib\ext\cdn jar;
<AM_HOME>\lib\ext\ppe.wls_8130.jar;
<AM_HOME>\lib\ext\cdnauxjar$;%CLASSPATH%

Startup Class

Shutdown Class

Classname: com.cyanea.wl8l.WLStartup
Name: AM Startup

Targets: <your application server>
Classname: com.cyanea.wl81.WLShutdown
Name: AM Shutdown

Targets: <your application server>
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Table 33. Application Server Options for WebLogic 8.1 SP3 on Windows (continued)

Entity Settings
Environment Set the following environment variable:
Variables LD_LIBRARY_PATH=<AM_HOME>\1ib;%LD_LIBRARY_PATH%

Set this variable in $WL_HOME\common\bin\commEnv.sh file.
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Appendix E. Setting up an HTTP Server with your Managing

Server

It is recommended that you use an HTTP Web server to access the Managing
Server front end running on WebSphere Application Server. If you choose to use
IBM HTTP Server (IHS) version 1.3, verify the following:

1.

Please make sure that the IHS installation program has appended the following
two lines to the Web server configuration file httpd.conf
LoadModuTe ibm_app_server_http_module

\ <WAS_HOME>/bin/mod_ibm_app_server_http.so
WebSpherePluginConfig <WAS_HOME>/config/cells/plugin-cfg.xmldd

where <WAS_HOME?> is your WebSphere 5.1 installation directory. The
configuration file httpd.conf usually gets installed in directory
/usr/HTTPServer/conf or /opt/IBMHTTPServer/conf, but that varies
depending on the conventions used at your site.

If the Web server is not configured to listen to the default port (80), you will
need to specify the appropriate port number in the Managing Server front end
access URL (e.g. http://<hostname>:90/am/home for port 90). If you wish to
access the front end at the default port (80), you need to verify that the Web
server is listening at the default port. The ports are defined by two IHS runtime
directives

Port 80
Listen 80

in the httpd.conf file. Once the plug-in and port configurations for IHS are
correct, you may access the front end without any port specification in the URL
(e.g. http:/ /<hostname/am/home).

Go to your WebSphere admin console and click the Environment >Update Web
Server Plugin link, and click OK to update the Web Server Plugin file.

For further information on configuring IHS, please refer to IBM documentation
at http://publib.boulder.ibm.com/infocenter /wasinfo/index.jsp?topic=
/com.ibm.websphere.base.doc/info/aes/ae/tins_webserver.html.
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Appendix F. iText and PDF support

To enable PDF support, do the following;:

1.

Download iText package, in particular, we need iText.jar
(http:/ /www.lowagie.com/iText/download.html) and iTextAsian jar files
(http:/ /itext.sourceforge.net/downloads/iTextAsian jar).

Place iTextjar and iTextAsian.jar in $AM_HOME/lib.

Note: You will need to rename the file to iText.jar if it is not named that
already.

If Visualization Engine (VE) is installed on WebSphere, then bring up the
WebSphere Admin Console; select the server where the VE is installed. Select
Process Definition < Java Virtual Machine. In the classpath, add
$AM_HOME/lib/iText.jar:$AM_HOME/lib/iTextAsian jar.

Note: $AM_HOME needs to be replaced by the real path where the WSAM
Managing Server is installed.

Note: If VE is installed on WebLogic, then instead of using the admin console,
modify the startup script of the VE WebLogic Server. Both

$AM_HOME/lib/iText.jar:$AM_HOME/lib/iTextAsian.jar need to be added to
the classpath. The rest of the steps are the same for WebLogic and WebSphere.

4. Modify $AM_HOME/etc/ve.properties and set ve.framework.pdf=yes.

5. Restart the Application Server.
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Appendix G. Support Information

http:/ /www.ibm.com/software/support
http:/ /techsupport.services.ibm.com/guides/handbook.html
http:/ /techsupport.services.ibm.com/guides/contacts.html

http:/ /www.lotus.com/services/passport.nsf/
WebDocs/Passport_Advantage_Home

https:/ /techsupport.services.ibm.com/ssr/login

http:/ /www.ibm.com/software/support/probsub.html

http:/ /www.ibm.com/servers/eserver/techsupport.html

http:/ /www.ibm.com/services/us/index.wss/so/its/a1000030/dt006

If you have a problem with your IBM software, you want to resolve it quickly. This

section describes the following options for obtaining support for IBM software
products:

+ |“Searching knowledge bases’]

+ [“Obtaining fixes” on page 214

+ |“Receiving weekly support updates” on page 214

+ |“Contacting IBM Software Support” on page 215|

Searching knowledge bases

You can search the available knowledge bases to determine whether your problem
was already encountered and is already documented.

Searching the information center

IBM provides extensive documentation that can be installed on your local
computer or on an intranet server. You can use the search function of this
information center to query conceptual information, instructions for completing
tasks, and reference information.

Searching the Internet

If you cannot find an answer to your question in the information center, search the
Internet for the latest, most complete information that might help you resolve your
problem.

To search multiple Internet resources for your product, use the Web search topic in
your information center. In the navigation frame, click Troubleshooting and
support » Searching knowledge bases and select Web search. From this topic, you
can search a variety of resources, including the following:

e IBM technotes
¢ IBM downloads
e IBM Redbooks
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* IBM developerWorks
* Forums and newsgroups

* Google

Obtaining fixes

A product fix might be available to resolve your problem. To determine what fixes
are available for your IBM software product, follow these steps:

1.

A

N o

Go to the IBM Software Support Web site at
http:/ /www.ibm.com/software/support.

Click Downloads and drivers in the Support topics section.
Select the Software category.
Select a product in the Sub-category list.

In the Find downloads and drivers by product section, select one software
category from the Category list.

Select one product from the Sub-category list.

Type more search terms in the Search within results if you want to refine your
search.

Click Search.

From the list of downloads returned by your search, click the name of a fix to
read the description of the fix and to optionally download the fix.

For more information about the types of fixes that are available, see the IBM
Software Support Handbook at
http:/ /techsupport.services.ibm.com/guides/handbook.html.

Receiving weekly support updates

To receive weekly e-mail notifications about fixes and other software support news,
follow these steps:

1.

9.
10.

11.
12.
13.

Go to the IBM Software Support Web site at
http:/ /www.ibm.com/software/support.

Click My support in the upper right corner of the page.

If you have already registered for My support, sign in and skip to the next
step. If you have not registered, click register now. Complete the registration
form using your e-mail address as your IBM ID and click Submit.

Click Edit profile.
In the Products list, select Software. A second list is displayed.

In the second list, select a product segment, for example, Application servers.
A third list is displayed.

In the third list, select a product sub-segment, for example, Distributed
Application & Web Servers. A list of applicable products is displayed.

Select the products for which you want to receive updates, for example, IBM
HTTP Server and WebSphere Application Server.

Click Add products.

After selecting all products that are of interest to you, click Subscribe to email
on the Edit profile tab.

Select Please send these documents by weekly email.
Update your e-mail address as needed.
In the Documents list, select Software.
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14. Select the types of documents that you want to receive information about.
15. Click Update.

If you experience problems with the My support feature, you can obtain help in
one of the following ways:

Online
Send an e-mail message to erchelp@ca.ibm.com, describing your problem.

By phone
Call 1-800-IBM-4You (1-800-426-4968).

Contacting IBM Software Support

IBM Software Support provides assistance with product defects.

Before contacting IBM Software Support, your company must have an active IBM
software maintenance contract, and you must be authorized to submit problems to
IBM. The type of software maintenance contract that you need depends on the
type of product you have:

* For IBM distributed software products (including, but not limited to, Tivoli,
Lotus, and Rational products, as well as DB2 and WebSphere products that run
on Windows, or UNIX operating systems), enroll in Passport Advantage in one
of the following ways:

Online
Go to the Passport Advantage Web site at
http:/ /www.lotus.com/services/passport.nsf/
WebDocs/Passport_Advantage_Home and click How to Enroll.

By phone
For the phone number to call in your country, go to the IBM Software
Support Web site at
http:/ /techsupport.services.ibm.com/guides/contacts.html and click the
name of your geographic region.

* For customers with Subscription and Support (S & S) contracts, go to the
Software Service Request Web site at
https:/ /techsupport.services.ibm.com/ssr/login.

* For customers with IBMLink, CATIA, Linux, S/390, iSeries, pSeries, zSeries, and
other support agreements, go to the IBM Support Line Web site at
http:/ /www.ibm.com/services/us/index.wss/so/its/a1000030/dt006.

* For IBM eServer software products (including, but not limited to, DB2 and
WebSphere products that run in zSeries, pSeries, and iSeries environments), you
can purchase a software maintenance agreement by working directly with an
IBM sales representative or an IBM Business Partner. For more information
about support for eServer software products, go to the IBM Technical Support
Advantage Web site at http:/ /www.ibm.com/servers/eserver/techsupport.html.

If you are not sure what type of software maintenance contract you need, call
1-800-IBMSERYV (1-800-426-7378) in the United States. From other countries, go to
the contacts page of the IBM Software Support Handbook on the Web at

http:/ /techsupport.services.ibm.com/guides/contacts.html and click the name of
your geographic region for phone numbers of people who provide support for
your location.

To contact IBM Software support, follow these steps:

Appendix G. Support Information 215



1. |"Determining the business impact”|

2. [“Describing problems and gathering information”|

3. |“Submitting problems”]

Determining the business impact

When you report a problem to IBM, you are asked to supply a severity level.
Therefore, you need to understand and assess the business impact of the problem
that you are reporting. Use the following criteria:

Severity 1
The problem has a critical business impact. You are unable to use the
program, resulting in a critical impact on operations. This condition
requires an immediate solution.

Severity 2
The problem has a significant business impact. The program is usable, but
it is severely limited.

Severity 3
The problem has some business impact. The program is usable, but less
significant features (not critical to operations) are unavailable.

Severity 4
The problem has minimal business impact. The problem causes little impact
on operations, or a reasonable circumvention to the problem was
implemented.

Describing problems and gathering information

When describing a problem to IBM, be as specific as possible. Include all relevant
background information so that IBM Software Support specialists can help you
solve the problem efficiently. To save time, know the answers to these questions:

* What software versions were you running when the problem occurred?

* Do you have logs, traces, and messages that are related to the problem
symptoms? IBM Software Support is likely to ask for this information.

* Can you re-create the problem? If so, what steps were performed to re-create the
problem?

* Did you make any changes to the system? For example, did you make changes
to the hardware, operating system, networking software, and so on.

* Are you currently using a workaround for the problem? If so, be prepared to
explain the workaround when you report the problem.

Submitting problems

You can submit your problem to IBM Software Support in one of two ways:

Online
Click Submit and track problems on the IBM Software Support site at
http:/ /www.ibm.com/software/support/probsub.html. Type your
information into the appropriate problem submission form.

By phone
For the phone number to call in your country, go to the contacts page of
the IBM Software Support Handbook at
http:/ /techsupport.services.ibm.com/guides/contacts.html and click the
name of your geographic region.
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If the problem you submit is for a software defect or for missing or inaccurate
documentation, IBM Software Support creates an Authorized Program Analysis
Report (APAR). The APAR describes the problem in detail. Whenever possible,
IBM Software Support provides a workaround that you can implement until the
APAR is resolved and a fix is delivered. IBM publishes resolved APARs on the
Software Support Web site daily, so that other users who experience the same
problem can benefit from the same resolution.
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Appendix H. Accessibility

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use software products successfully. These are the
major accessibility features you can use with WebSphere Studio Application Monitor
when accessing it via the IBM Personal Communications terminal emulator:

* You can operate all features using the keyboard instead of the mouse.
* You can read text text through interaction with assistive technology.

* You can use system settings for font, size, and color for all user interface
controls.

* You can magnify what is displayed on your screen.
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Appendix I. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive

Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain
transactions, therefore, this statement might not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation

274A /101

11400 Burnet Road

Austin, TX 78758 US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:
This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,

modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

If you are viewing this information in softcopy form, the photographs and color
illustrations might not display.

Trademarks

IBM, the IBM logo, AIX, DB2, IBMLink, Informix, OS/2, OS/400, Tivoli, the Tivoli
logo, Tivoli Enterprise Console, and TME are trademarks or registered trademarks
of International Business Machines Corporation in the United States, other
countries, or both.

Intel, the Intel Inside logos, MMX, and Pentium are trademarks of Intel
Corporation in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Microsoft and Windows NT are registered trademarks of Microsoft Corporation in
the United States, other countries, or both.

< Java and all Java-based trademarks and logos are trademarks or
e registered trademarks of Sun Microsystems, Inc. in the United States,
other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

SET and the SET Logo are trademarks owned by SET Secure Electronic Transaction
LLC.

Other company, product, and service names may be trademarks or service marks
of others.
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